Contents

Chapter 1 Library......................................................................................................................... 6
  1.1 Introduction.............................................................................................................................. 6
    1.1.1 Overview........................................................................................................................... 6
    1.1.2 Data types......................................................................................................................... 6
    1.1.3 API definition..................................................................................................................... 6
    1.1.4 Supported compilers......................................................................................................... 7
    1.1.5 Library configuration......................................................................................................... 7
    1.1.6 Special issues.................................................................................................................... 7
  1.2 Library integration into project (MCUXpresso IDE) ............................................................... 8
  1.3 Library integration into project (Keil µVision) ....................................................................... 11
  1.4 Library integration into project (IAR Embedded Workbench) ............................................. 18

Chapter 2 Algorithms in detail..................................................................................................... 25
  2.1 GFLIB_Sin.............................................................................................................................. 25
    2.1.1 Available versions............................................................................................................... 25
    2.1.2 Declaration....................................................................................................................... 26
    2.1.3 Function use....................................................................................................................... 26
  2.2 GFLIB_Cos.............................................................................................................................. 27
    2.2.1 Available versions............................................................................................................... 27
    2.2.2 Declaration....................................................................................................................... 27
    2.2.3 Function use....................................................................................................................... 27
  2.3 GFLIB_Tan.............................................................................................................................. 28
    2.3.1 Available versions............................................................................................................... 29
    2.3.2 Declaration....................................................................................................................... 29
    2.3.3 Function use....................................................................................................................... 30
  2.4 GFLIB_Asin............................................................................................................................ 30
    2.4.1 Available versions............................................................................................................... 31
    2.4.2 Declaration....................................................................................................................... 31
    2.4.3 Function use....................................................................................................................... 31
  2.5 GFLIB_Acos............................................................................................................................ 32
    2.5.1 Available versions............................................................................................................... 32
    2.5.2 Declaration....................................................................................................................... 33
    2.5.3 Function use....................................................................................................................... 33
  2.6 GFLIB_Atan............................................................................................................................ 34
    2.6.1 Available versions............................................................................................................... 34
    2.6.2 Declaration....................................................................................................................... 35
    2.6.3 Function use....................................................................................................................... 35
  2.7 GFLIB_AtanYX....................................................................................................................... 36
    2.7.1 Available versions............................................................................................................... 37
    2.7.2 Declaration....................................................................................................................... 37
    2.7.3 Function use....................................................................................................................... 38
  2.8 GFLIB_Sqrt............................................................................................................................ 38
    2.8.1 Available versions............................................................................................................... 38
    2.8.2 Declaration....................................................................................................................... 39
    2.8.3 Function use....................................................................................................................... 39
  2.9 GFLIB_Limit........................................................................................................................... 40
    2.9.1 Available versions............................................................................................................... 40
    2.9.2 Declaration....................................................................................................................... 40
    2.9.3 Function use....................................................................................................................... 40
  2.10 GFLIB_LowerLimit.............................................................................................................. 41
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.10.1 Available versions..................................................................</td>
<td>41</td>
</tr>
<tr>
<td>2.10.2 Declaration...........................................................................</td>
<td>42</td>
</tr>
<tr>
<td>2.10.3 Function use...........................................................................</td>
<td>42</td>
</tr>
<tr>
<td>2.11 GFLIB_UpperLimit....................................................................</td>
<td>43</td>
</tr>
<tr>
<td>2.11.1 Available versions.................................................................</td>
<td>43</td>
</tr>
<tr>
<td>2.11.2 Declaration..........................................................................</td>
<td>43</td>
</tr>
<tr>
<td>2.11.3 Function use.........................................................................</td>
<td>43</td>
</tr>
<tr>
<td>2.12 GFLIB_VectorLimit...................................................................</td>
<td>44</td>
</tr>
<tr>
<td>2.12.1 Available versions.................................................................</td>
<td>45</td>
</tr>
<tr>
<td>2.12.2 GFLIB_VECTORLIMIT_T_F16 type description..........................</td>
<td>45</td>
</tr>
<tr>
<td>2.12.3 GFLIB_VECTORLIMIT_T_FLT type description...........................</td>
<td>46</td>
</tr>
<tr>
<td>2.12.4 Declaration..........................................................................</td>
<td>46</td>
</tr>
<tr>
<td>2.12.5 Function use.........................................................................</td>
<td>46</td>
</tr>
<tr>
<td>2.13 GFLIB_VectorLimit1..................................................................</td>
<td>47</td>
</tr>
<tr>
<td>2.13.1 Available versions.................................................................</td>
<td>48</td>
</tr>
<tr>
<td>2.13.2 GFLIB_VECTORLIMIT1_T_F16 type description..........................</td>
<td>48</td>
</tr>
<tr>
<td>2.13.3 GFLIB_VECTORLIMIT1_T_FLT type description..........................</td>
<td>48</td>
</tr>
<tr>
<td>2.13.4 Declaration..........................................................................</td>
<td>48</td>
</tr>
<tr>
<td>2.13.5 Function use.........................................................................</td>
<td>49</td>
</tr>
<tr>
<td>2.14 GFLIB_Hyst.............................................................................</td>
<td>49</td>
</tr>
<tr>
<td>2.14.1 Available versions.................................................................</td>
<td>50</td>
</tr>
<tr>
<td>2.14.2 GFLIB_HYST_T_F16.................................................................</td>
<td>50</td>
</tr>
<tr>
<td>2.14.3 GFLIB_HYST_T_FLT.................................................................</td>
<td>51</td>
</tr>
<tr>
<td>2.14.4 Declaration..........................................................................</td>
<td>51</td>
</tr>
<tr>
<td>2.14.5 Function use.........................................................................</td>
<td>51</td>
</tr>
<tr>
<td>2.15 GFLIB_Lut1D...........................................................................</td>
<td>52</td>
</tr>
<tr>
<td>2.15.1 Available versions.................................................................</td>
<td>53</td>
</tr>
<tr>
<td>2.15.2 GFLIB_LUT1D_T_FLT type description....................................</td>
<td>54</td>
</tr>
<tr>
<td>2.15.3 Declaration..........................................................................</td>
<td>54</td>
</tr>
<tr>
<td>2.15.4 Function use.........................................................................</td>
<td>55</td>
</tr>
<tr>
<td>2.16 GFLIB_LutPer1D.......................................................................</td>
<td>55</td>
</tr>
<tr>
<td>2.16.1 Available versions.................................................................</td>
<td>56</td>
</tr>
<tr>
<td>2.16.2 GFLIB_LUTPER1D_T_FLT type description................................</td>
<td>57</td>
</tr>
<tr>
<td>2.16.3 Declaration..........................................................................</td>
<td>58</td>
</tr>
<tr>
<td>2.16.4 Function use.........................................................................</td>
<td>58</td>
</tr>
<tr>
<td>2.17 GFLIB_Ramp............................................................................</td>
<td>59</td>
</tr>
<tr>
<td>2.17.1 Available versions.................................................................</td>
<td>60</td>
</tr>
<tr>
<td>2.17.2 GFLIB_RAMP_T_F16.................................................................</td>
<td>61</td>
</tr>
<tr>
<td>2.17.3 GFLIB_RAMP_T_F32.................................................................</td>
<td>61</td>
</tr>
<tr>
<td>2.17.4 GFLIB_RAMP_T_FLT.................................................................</td>
<td>61</td>
</tr>
<tr>
<td>2.17.5 Declaration..........................................................................</td>
<td>61</td>
</tr>
<tr>
<td>2.17.6 Function use.........................................................................</td>
<td>61</td>
</tr>
<tr>
<td>2.18 GFLIB_DRamp..........................................................................</td>
<td>62</td>
</tr>
<tr>
<td>2.18.1 Available versions.................................................................</td>
<td>63</td>
</tr>
<tr>
<td>2.18.2 GFLIB_DRAMP_T_F16.................................................................</td>
<td>64</td>
</tr>
<tr>
<td>2.18.3 GFLIB_DRAMP_T_F32.................................................................</td>
<td>65</td>
</tr>
<tr>
<td>2.18.4 GFLIB_DRAMP_T_FLT.................................................................</td>
<td>65</td>
</tr>
<tr>
<td>2.18.5 Declaration..........................................................................</td>
<td>66</td>
</tr>
<tr>
<td>2.18.6 Function use.........................................................................</td>
<td>66</td>
</tr>
<tr>
<td>2.19 GFLIB_FlexRamp......................................................................</td>
<td>67</td>
</tr>
<tr>
<td>2.19.1 Available versions.................................................................</td>
<td>68</td>
</tr>
<tr>
<td>2.19.2 GFLIB_FLEXRAMP_T_F32.........................................................</td>
<td>70</td>
</tr>
<tr>
<td>2.19.3 GFLIB_FLEXRAMP_T_FLT...........................................................</td>
<td>70</td>
</tr>
<tr>
<td>2.19.4 Declaration..........................................................................</td>
<td>70</td>
</tr>
<tr>
<td>2.19.5 Function use.........................................................................</td>
<td>71</td>
</tr>
</tbody>
</table>
Appendix A Library types

A.1 bool_t ................................................. 119
A.2 uint8_t ............................................. 119
A.3 uint16_t ............................................ 120
A.4 uint32_t ............................................ 121
A.5 int8_t .............................................. 121
A.6 int16_t ............................................. 122
A.7 int32_t ............................................ 122
A.8 frac8_t ............................................. 123
Chapter 1
Library

1.1 Introduction

1.1.1 Overview

This user's guide describes the General Functions Library (GFLIB) for the family of ARM Cortex M33F core-based microcontrollers. This library contains optimized functions.

1.1.2 Data types

GFLIB supports several data types: (un)signed integer, fractional, and accumulator, and floating point. The integer data types are useful for general-purpose computation; they are familiar to the MPU and MCU programmers. The fractional data types enable powerful numeric and digital-signal-processing algorithms to be implemented. The accumulator data type is a combination of both; that means it has the integer and fractional portions. The floating-point data types are capable of storing real numbers in wide dynamic ranges. The type is represented by binary digits and an exponent. The exponent allows scaling the numbers from extremely small to extremely big numbers. Because the exponent takes part of the type, the overall resolution of the number is reduced when compared to the fixed-point type of the same size.

The following list shows the integer types defined in the libraries:

- **Unsigned 16-bit integer**—<0 ; 65535> with the minimum resolution of 1
- **Signed 16-bit integer**—<-32768 ; 32767> with the minimum resolution of 1
- **Unsigned 32-bit integer**—<0 ; 4294967295> with the minimum resolution of 1
- **Signed 32-bit integer**—<-2147483648 ; 2147483647> with the minimum resolution of 1

The following list shows the fractional types defined in the libraries:

- **Fixed-point 16-bit fractional**—<-1 ; 1 - 2^-15> with the minimum resolution of 2^-15
- **Fixed-point 32-bit fractional**—<-1 ; 1 - 2^-31> with the minimum resolution of 2^-31

The following list shows the accumulator types defined in the libraries:

- **Fixed-point 16-bit accumulator**—<-256.0 ; 256.0 - 2^-7> with the minimum resolution of 2^-7
- **Fixed-point 32-bit accumulator**—<-65536.0 ; 65536.0 - 2^-15> with the minimum resolution of 2^-15

The following list shows the floating-point types defined in the libraries:

- **Floating point 32-bit single precision**—<-3.40282 · 10^38 ; 3.40282 · 10^38> with the minimum resolution of 2^-23

1.1.3 API definition

GFLIB uses the types mentioned in the previous section. To enable simple usage of the algorithms, their names use set prefixes and postfixes to distinguish the functions' versions. See the following example:

```c
f32Result = MLIB_Mac_F32lss(f32Accum, f16Mult1, f16Mult2);
```

where the function is compiled from four parts:

- **MLIB**—this is the library prefix
- **Mac**—the function name—Multiply-Accumulate
- **F32**—the function output type
• Iss—the types of the function inputs; if all the inputs have the same type as the output, the inputs are not marked

The input and output types are described in the following table:

<table>
<thead>
<tr>
<th>Type</th>
<th>Output</th>
<th>Input</th>
</tr>
</thead>
<tbody>
<tr>
<td>frac16_t</td>
<td>F16</td>
<td>s</td>
</tr>
<tr>
<td>frac32_t</td>
<td>F32</td>
<td>l</td>
</tr>
<tr>
<td>acc32_t</td>
<td>A32</td>
<td>a</td>
</tr>
<tr>
<td>float_t</td>
<td>FLT</td>
<td>f</td>
</tr>
</tbody>
</table>

1.1.4 Supported compilers

GFLIB for the ARM Cortex M33F core is written in C language or assembly language with C-callable interface depending on the specific function. The library is built and tested using the following compilers:

- MCUXpresso IDE
- IAR Embedded Workbench
- Keil µVision

For the MCUXpresso IDE, the library is delivered in the glib.a file.

For the Kinetis Design Studio, the library is delivered in the glib.a file.

For the IAR Embedded Workbench, the library is delivered in the glib.a file.

For the Keil µVision, the library is delivered in the glib.lib file.

The interfaces to the algorithms included in this library are combined into a single public interface include file, glib.h. This is done to lower the number of files required to be included in your application.

1.1.5 Library configuration

GFLIB for the ARM Cortex M33F core is written in C language or assembly language with C-callable interface depending on the specific function. Some functions from this library are inline type, which are compiled together with project using this library. The optimization level for inline function is usually defined by the specific compiler setting. It can cause an issue especially when high optimization level is set. Therefore the optimization level for all inline assembly written functions is defined by compiler pragmas using macros. The configuration header file RTCESL_cfg.h is located in: specific library folder/MLIB/Include. The optimization level can be changed by modifying the macro value for specific compiler. In case of any change the library functionality is not guaranteed.

Similarly as optimization level the PowerQuad DSP Coprocessor and Accelerator support can be disable or enable if it has not been done by defined symbol RTCESL_PQ_ON or RTCESL_PQ_OFF in project setting described in the PowerQuad DSP Coprocessor and Accelerator support cheaper for specific compiler.

1.1.6 Special issues

1. The equations describing the algorithms are symbolic. If there is positive 1, the number is the closest number to 1 that the resolution of the used fractional type allows. If there are maximum or minimum values mentioned, check the range allowed by the type of the particular function version.

2. The library functions that round the result (the API contains Rnd) round to nearest (half up).
3. This RTCESL requires the DSP extension for some saturation functions. If the core does not support the DSP extension feature the assembler code of the RTCESL will not be buildable. For example the core1 of the LPC55s69 has no DSP extension.

1.2 Library integration into project (MCUXpresso IDE)

This section provides a step-by-step guide on how to quickly and easily include GFLIB into any MCUXpresso SDK example or new SDK project using MCUXpresso IDE. The SDK based project uses RTCESL from SDK package.

PowerQuad DSP Coprocessor and Accelerator support

Some LPC platforms (LPC55S6x) contain a hardware accelerator dedicated to common calculations in DSP applications. This section shows how to turn the PowerQuad (PQ) support for a function on and off.

1. In the MCUXpresso SDK project name node or in the left-hand part, click Properties or select Project > Properties from the menu. A project properties dialog appears.

2. Expand the C/C++ Build node and select Settings. See Figure 1.

3. On the right-hand side, under the MCU C Compiler node, click the Preprocessor node. See Figure 1.

4. In the right-hand part of the dialog, click the Add... icon located next to the Defined symbols (-D) title.

5. In the dialog that appears (see Figure 2), type the following:
   • RTCESL_PQ_ON—to turn the PowerQuad support on
   • RTCESL_PQ_OFF—to turn the PowerQuad support off

If neither of these two defines is defined, the hardware division and square root support is turned off by default.
6. Click OK in the dialog.

7. Click OK in the main dialog.

8. Ensure the PowerQuad moduel to be clocked by calling function RTCESL_PQ_Init(); prior to the first function using PQ module calling.

See the device reference manual to verify whether the device contains the PowerQuad DSP Coprocessor and Accelerator support.

Adding RTCESL component to project

The MCUXpresso SDK package is necessary to add any example or new project and RTCESL component. In case the package has not been downloaded go to mcuxpresso.nxp.com, build the final MCUXpresso SDK package for required board and download it.

After package is dowloaded, open the MCUXpresso IDE and drag&drop the SDK package in zip format to the Installed SDK window of the MCUXpresso IDE. After SDK package is dropped the mesage accepting window appears as can be show in following figure.
Click OK to confirm the SDK package import. Find the Quickstart panel in left bottom part of the MCUXpresso IDE and click New project... item or Import SDK example(s)... to add rtcesl component to the project.

Figure 4. MCUXpresso IDE - create new project or Import SDK example(s)

Then select your board, and click Next button.

Figure 5. MCUXpresso IDE - selecting the board
Find the Middleware tab in the Components part of the window and click on the checkbox to be the rtcesl component ticked. Last step is to click the Finish button and wait for project creating with all RTCESL libraries and include paths.

![Figure 6. MCUXpresso IDE - selecting rtcesl component](image)

Type the #include syntax into the code where you want to call the library functions. In the left-hand dialog, open the required .c file. After the file opens, include the following lines into the #include section:

```c
#include "mlib_FP.h"
#include "gflib_FP.h"
```

When you click the Build icon (hammer), the project is compiled without errors.

### 1.3 Library integration into project (Keil µVision)

This section provides a step-by-step guide on how to quickly and easily include GFLIB into an empty project or any MCUXpresso SDK example or demo application projects using Keil µVision. This example uses the default installation path (C:\NXP\RTCESL\CM33F_RTCESL_4.7_KEIL). If you have a different installation path, use that path instead. If any MCUXpresso SDK project is intended to use (for example hello_world project) go to [Linking the files into the project](#) chapter otherwise read next chapter.

#### NXP pack installation for new project (without MCUXpresso SDK)

This example uses the NXP LPC55s69 part, and the default installation path (C:\NXP\RTCESL\CM33F_RTCESL_4.7_KEIL) is supposed. If the compiler has never been used to create any NXP MCU-based projects before, check whether the NXP MCU pack for the particular device is installed. Follow these steps:

1. Launch Keil µVision.
2. In the main menu, go to Project > Manage > Pack Installer….
3. In the left-hand dialog (under the Devices tab), expand the All Devices > Freescale (NXP) node.
4. Look for a line called "KVxx Series" and click it.
5. In the right-hand dialog (under the Packs tab), expand the Device Specific node.

6. Look for a node called "Keil::Kinetis_KVxx_DFP." If there are the Install or Update options, click the button to install/update the package. See Figure 7.

7. When installed, the button has the "Up to date" title. Now close the Pack Installer.

![Figure 7. Pack Installer](image)

**New project (without MCUXpresso SDK)**

To start working on an application, create a new project. If the project already exists and is opened, skip to the next section. Follow these steps to create a new project:

1. Launch Keil µVision.

2. In the main menu, select Project > New µVision Project…, and the Create New Project dialog appears.

3. Navigate to the folder where you want to create the project, for example C:\KeilProjects\MyProject01. Type the name of the project, for example MyProject01. Click Save. See Figure 8.

![Figure 8. Create New Project dialog](image)

4. In the next dialog, select the Software Packs in the very first box.

5. Type " into the Search box, so that the device list is reduced to the devices.

6. Expand the node.

7. Click the LPC55s69 node, and then click OK. See Figure 9.
8. In the next dialog, expand the Device node, and tick the box next to the Startup node. See Figure 10.

9. Expand the CMSIS node, and tick the box next to the CORE node.

10. Click OK, and a new project is created. The new project is now visible in the left-hand part of Keil µVision. See Figure 11.

11. In the main menu, go to Project > Options for Target 'Target1'…, and a dialog appears.

12. Select the Target tab.

13. Select Use Single Precision in the Floating Point Hardware option. See Figure 11.
PowerQuad DSP Coprocessor and Accelerator support

Some LPC platforms (LPC55S6x) contain a hardware accelerator dedicated to common calculations in DSP applications. This section shows how to turn the PowerQuad (PQ) support for a function on and off.

1. In the main menu, go to Project > Options for Target 'Target1'…, and a dialog appears.
2. Select the C/C++ tab. See Figure 13.
3. In the Include Preprocessor Symbols text box, type the following:
   - RTCESL_PQ_ON—to turn the hardware division and square root support on.
   - RTCESL_PQ_OFF—to turn the hardware division and square root support off.

If neither of these two defines is defined, the hardware division and square root support is turned off by default.

4. Click OK in the main dialog.
5. Ensure the PowerQuad module to be clocked by calling function RTCESL_PQ_Init(); prior to the first function using PQ module calling.

See the device reference manual to verify whether the device contains the PowerQuad DSP Coprocessor and Accelerator support.
Linking the files into the project

GFLIB requires MLIB to be included too. The following steps show how to include all dependent modules.

To include the library files in the project, create groups and add them.

1. Right-click the Target 1 node in the left-hand part of the Project tree, and select Add Group… from the menu. A new group with the name New Group is added.

2. Click the newly created group, and press F2 to rename it to RTCESL.

3. Right-click the RTCESL node, and select Add Existing Files to Group 'RTCESL'… from the menu.

4. Navigate into the library installation folder C:\NXP\RTCESL\CM33F_RTCESL_4.7 KEIL\MLIB\Include, and select the mlib_FP.h file. If the file does not appear, set the Files of type filter to Text file. Click Add. See Figure 14.

5. Navigate to the parent folder C:\NXP\RTCESL\CM33F_RTCESL_4.7 KEIL\MLIB, and select the mlib.lib file. If the file does not appear, set the Files of type filter to Library file. Click Add. See Figure 15.
6. Navigate into the library installation folder C:\NXP\RTCESL\CM33F_RTCESL_4.7_KEIL\GFLIB\Include, and select the `glib_FP.h` file. If the file does not appear, set the Files of type filter to Text file. Click Add.

7. Navigate to the parent folder C:\NXP\RTCESL\CM33F_RTCESL_4.7_KEIL\GFLIB, and select the `gflib.lib` file. If the file does not appear, set the Files of type filter to Library file. Click Add.

8. Now, all necessary files are in the project tree; see Figure 16. Click Close.

Library path setup

The following steps show the inclusion of all dependent modules.
1. In the main menu, go to Project > Options for Target 'Target1'…, and a dialog appears.

2. Select the C/C++ tab. See Figure 17.

3. In the Include Paths text box, type the following paths (if there are more paths, they must be separated by ‘;‘) or add them by clicking the … button next to the text box:
   - "C:\NXP\RTCESL\CM33F_RTCESL_4.7_KEIL\MLIB\Include"
   - "C:\NXP\RTCESL\CM33F_RTCESL_4.7_KEIL\GFLIB\Include"

4. Click OK.

5. Click OK in the main dialog.

![Figure 17. Library path addition](image)

Type the #include syntax into the code. Include the library into a source file. In the new project, it is necessary to create a source file:

1. Right-click the Source Group 1 node, and Add New Item to Group 'Source Group 1'… from the menu.

2. Select the C File (.c) option, and type a name of the file into the Name box, for example 'main.c'. See Figure 18.
3. Click Add, and a new source file is created and opened up.

4. In the opened source file, include the following lines into the #include section, and create a main function:

```c
#include "mlib_FP.h"
#include "gflib_FP.h"

int main(void)
{
    while(1);
}
```

When you click the Build (F7) icon, the project will be compiled without errors.

### 1.4 Library integration into project (IAR Embedded Workbench)

This section provides a step-by-step guide on how to quickly and easily include the GFLIB into an empty project or any MCUXpresso SDK example or demo application projects using IAR Embedded Workbench. This example uses the default installation path (C:\NXPIRTCESL\CM33F_RTCESL_4.7_IAR). If you have a different installation path, use that path instead. If any MCUXpresso SDK project is intended to use (for example hello_world project) go to Linking the files into the project chapter otherwise read next chapter.

#### New project (without MCUXpresso SDK)

This example uses the NXP LPC55S69 part, and the default installation path (C:\NXPIRTCESL\CM33F_RTCESL_4.7_IAR) is supposed. To start working on an application, create a new project. If the project already exists and is opened, skip to the next section. Perform these steps to create a new project:

1. Launch IAR Embedded Workbench.

2. In the main menu, select Project > Create New Project… so that the "Create New Project" dialog appears. See Figure 19.
3. Expand the C node in the tree, and select the "main" node. Click OK.

4. Navigate to the folder where you want to create the project, for example, C:\IARProjects\MyProject01. Type the name of the project, for example, MyProject01. Click Save, and a new project is created. The new project is now visible in the left-hand part of IAR Embedded Workbench. See Figure 20.

5. In the main menu, go to Project > Options…, and a dialog appears.

6. In the Target tab, select the Device option, and click the button next to the dialog to select the MCU. In this example, select NXP > LPC55S69 > NXP LPC55S69_core0. Select VFPv5 single precision in the FPU option. The DSP instructions group is required please check the DSP Extensions checkbox if not checked. Click OK. See Figure 21.
PowerQuad DSP Coprocessor and Accelerator support

Some LPC platforms (LPC55S6x) contain a hardware accelerator dedicated to common calculations in DSP applications. Only functions running faster through the PowerQuad module than the core itself are supported and targeted to be calculated by the PowerQuad module. This section shows how to turn the PowerQuad (PQ) support for a function on and off.

1. In the main menu, go to Project > Options…, and a dialog appears.
2. In the left-hand column, select C/C++ Compiler.
3. In the right-hand part of the dialog, click the Preprocessor tab (it can be hidden in the right-hand side; use the arrow icons for navigation).
4. In the text box (at the Defined symbols: (one per line)), type the following (See Figure 22):
   • RTCESL_PQ_ON—to turn the PowerQuad support on.
   • RTCESL_PQ_OFF—to turn the PowerQuad support off.

If neither of these two defines is defined, the hardware division and square root support is turned off by default.
5. Click OK in the main dialog.

6. Ensure the PowerQuad module to be clocked by calling function RTCESL_PQ_Init(); prior to the first function using PQ module calling.

See the device reference manual to verify whether the device contains the PowerQuad DSP Coprocessor and Accelerator support.

Library path variable

To make the library integration easier, create a variable that will hold the information about the library path.

1. In the main menu, go to Tools > Configure Custom Argument Variables…, and a dialog appears.

2. Click the New Group button, and another dialog appears. In this dialog, type the name of the group PATH, and click OK. See Figure 23.

![Figure 22. Defined symbols](image)
3. Click on the newly created group, and click the Add Variable button. A dialog appears.

4. Type this name: RTCESL_LOC

5. To set up the value, look for the library by clicking the ‘…” button, or just type the installation path into the box: C:\NXP\RTCESL\CM33F_RTCESL_4.7_IAR. Click OK.

6. In the main dialog, click OK. See Figure 24.

Linking the files into the project

GFLIB requires MLIB to be included too. The following steps show the inclusion of all dependent modules.

To include the library files into the project, create groups and add them.

1. Go to the main menu Project > Add Group…
2. Type RTCESL, and click OK.
3. Click on the newly created node RTCESL, go to Project > Add Group…, and create a MLIB subgroup.
4. Click on the newly created node MLIB, and go to the main menu Project > Add Files… See Figure 26.
5. Navigate into the library installation folder C:\NXP\RTCESL\CM33F_RTCESL_4.7_IAR\MLIB\Include, and select the mllib.h file. (If the file does not appear, set the file-type filter to Source Files.) Click Open. See Figure 25.
6. Navigate into the library installation folder \C:\NXP\RTCESL\CM33F_RTCESL_4.7_IAR\MLIB, and select the \mlib.a file. If the file does not appear, set the file-type filter to Library / Object files. Click Open.

![Add Files dialog](image)

**Figure 25. Add Files dialog**

7. Click on the RTCESL node, go to Project > Add Group…, and create a GFLIB subgroup.

8. Click on the newly created node GFLIB, and go to the main menu Project > Add Files….

9. Navigate into the library installation folder \C:\NXP\RTCESL\CM33F_RTCESL_4.7_IAR\GFLIB\Include, and select the \gflib.h file. (If the file does not appear, set the file-type filter to Source Files.) Click Open.

10. Navigate into the library installation folder \C:\NXP\RTCESL\CM33F_RTCESL_4.7_IAR\GFLIB, and select the \gflib.a file. If the file does not appear, set the file-type filter to Library / Object files. Click Open.

11. Now you will see the files added in the workspace. See **Figure 26**.

![Project workspace](image)

**Figure 26. Project workspace**

**Library path setup**

The following steps show the inclusion of all dependent modules:

1. In the main menu, go to Project > Options…, and a dialog appears.

2. In the left-hand column, select C/C++ Compiler.

3. In the right-hand part of the dialog, click on the Preprocessor tab (it can be hidden in the right; use the arrow icons for navigation).

4. In the text box (at the Additional include directories title), type the following folder (using the created variable):
   - $RTCESL_LOC$\MLIB\Include
   - $RTCESL_LOC$\GFLIB\Include

5. Click OK in the main dialog. See **Figure 27**.
Type the #include syntax into the code. Include the library included into the main.c file. In the workspace tree, double-click the main.c file. After the main.c file opens up, include the following lines into the #include section:

```c
#include "mlib_FP.h"
#include "gflib_FP.h"
```

When you click the Make icon, the project will be compiled without errors.
Chapter 2
Algorithms in detail

2.1 GFLIB_Sin

The GFLIB_Sin function implements the polynomial approximation of the sine function. It provides a computational method for the calculation of a standard trigonometric sine function sin(x), using the 9th order Taylor polynomial approximation. The Taylor polynomial approximation of a sine function is expressed as follows:

\[
\sin(x) = x - \frac{x^3}{3!} + \frac{x^5}{5!} - \frac{x^7}{7!} + \frac{x^9}{9!}
\]

Figure 28.

\[
\sin(x) = x(d_1 + x^2(d_3 + x^2(d_5 + x^2(d_7 + x^2d_9))))
\]

Figure 29.

where the constants are:

\[
\begin{align*}
d_1 &= 1 \\
d_3 &= -\frac{1}{3 !} \\
d_5 &= \frac{1}{5 !} \\
d_7 &= -\frac{1}{7 !} \\
d_9 &= \frac{1}{9 !}
\end{align*}
\]

The fractional arithmetic is limited to the range \((-1 ; 1)\), so the input argument can only be within this range. The input argument is the multiplier of \(\pi\): \(\sin(\pi \cdot x)\), where the user passes the \(x\) argument. Example: if the input is -0.5, it corresponds to -0.5\(\pi\).

The fractional function \(\sin(\pi \cdot x)\) is expressed using the 9th order Taylor polynomial as follows:

\[
\sin(\pi x) = x(c_1 + x^2(c_3 + x^2(c_5 + x^2(c_7 + x^2c_9))))
\]

Figure 30.

where:

\[
\begin{align*}
c_1 &= d_1\pi^1 = \pi \\
c_3 &= d_3\pi^3 = -\frac{\pi^3}{3 !} \\
c_5 &= d_5\pi^5 = \frac{\pi^5}{5 !} \\
c_7 &= d_7\pi^7 = -\frac{\pi^7}{7 !} \\
c_9 &= d_9\pi^9 = \frac{\pi^9}{9 !}
\end{align*}
\]

2.1.1 Available versions

The function is available in the following versions:

- Fractional output - the output is the fractional portion of the result; the result is within the range \((-1 ; 1)\). The result may saturate.
- Floating-point output - the output is the floating-point result within the range \((-1.0 ; 1.0)\).
- Floating-point output with accumulator input - the output is the floating-point result within the range \((-1.0 ; 1.0)\). The input is the accumulator angle in radians divided by \(\pi\).

The available versions of the GFLIB_Sin function are shown in the following table:
### Table 2. Function versions

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Result type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GFLIB_Sin_F16</td>
<td>frac16_t</td>
<td>frac16_t</td>
<td>Calculation of the sin(π · x), where the input argument is a 16-bit fractional value normalized to the range &lt;-1 ; 1) that represents an angle in radians within the range &lt;-π; π). The output is a 16-bit fractional value within the range &lt;-1 ; 1).</td>
</tr>
<tr>
<td>GFLIB_Sin_FLT</td>
<td>float_t</td>
<td>float_t</td>
<td>Calculation of the sin(x), where the input argument is a 32-bit single precision floating-point value in radians within the range &lt;-π; π). The output is a 32-bit single precision floating-point value within the range &lt;-1.0 ; 1.0&gt;.</td>
</tr>
<tr>
<td>GFLIB_Sin_FLTa</td>
<td>acc32_t</td>
<td>float_t</td>
<td>Calculation of the sin(π · x), where the input argument is a 32-bit accumulator value where the fractional part &lt;-1 ; 1) represents the angle within the range &lt;-π; π). The output is a 32-bit single precision floating-point value within the range &lt;-1.0 ; 1.0&gt;.</td>
</tr>
</tbody>
</table>

### 2.1.2 Declaration

The available **GFLIB_Sin** functions have the following declarations:

```c
frac16_t GFLIB_Sin_F16(frac16_t f16Angle)
float_t GFLIB_Sin_FLT(float_t fltAngle)
float_t GFLIB_Sin_FLTa(acc32_t a32Angle)
```

### 2.1.3 Function use

The use of the **GFLIB_Sin** function is shown in the following examples:

#### Fixed-point version:

```c
#include "gflib.h"

static frac16_t f16Result;
static frac16_t f16Angle;

void main(void)
{
    f16Angle = FRAC16(0.333333); /* f16Angle = 0.333333 [60°] */
    /* f16Result = sin(f16Angle); (π · f16Angle[rad]) = deg * (π / 180) */
    f16Result = GFLIB_Sin_F16(f16Angle);
}
```

#### Floating-point version:

```c
#include "gflib.h"

static float_t fltResult;
static float_t fltAngle;

void main(void)
{
    fltAngle = 1.04719F; /* fltAngle = 1.04719 rad [60°] */
    /* fltResult = sin(fltAngle); fltAngle[rad] = deg * (pi / 180) */
    fltResult = GFLIB_Sin_FLT(fltAngle);
}
```
2.2 GFLIB_Cos

The GFLIB_Cos function implements the polynomial approximation of the cosine function. This function computes the cos(x) using the ninth-order Taylor polynomial approximation of the sine function, and its equation is as follows:

\[
\cos(x) = \sin\left(\frac{\pi}{2} + x\right)
\]

Figure 31.

Because the fractional arithmetic is limited to the range <-1 ; 1), the input argument can only be within this range. The input argument is the multiplier of π: cos(π · x), where the user passes the x argument. For example, if the input is -0.5, it corresponds to -0.5π.

2.2.1 Available versions

This function is available in the following versions:

- Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result may saturate.
- Floating-point output - the output is the floating-point result within the range <-1.0 ; 1.0>.
- Floating-point output with accumulator input - the output is the floating-point result within the range <-1.0 ; 1.0>. The input is the accumulator angle in radians divided by π.

The available versions of the GFLIB_Cos function are shown in the following table:

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Result type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GFLIB_Cos_F16</td>
<td>frac16_t</td>
<td>frac16_t</td>
<td>Calculation of cos(π · x), where the input argument is a 16-bit fractional value, normalized to the range &lt;-1 ; 1) that represents an angle in radians within the range &lt;-π; π). The output is a 16-bit fractional value within the range &lt;-1 ; 1).</td>
</tr>
<tr>
<td>GFLIB_Cos_FLT</td>
<td>float_t</td>
<td>float_t</td>
<td>Calculation of cos(x), where the input argument is a 32-bit single precision floating-point value in radians within the range &lt;-π; π). The output is a 32-bit single precision floating-point value within the range &lt;-1.0 ; 1.0&gt;.</td>
</tr>
<tr>
<td>GFLIB_Cos_FLTa</td>
<td>acc32_t</td>
<td>float_t</td>
<td>Calculation of the cos(π · x), where the input argument is a 32-bit accumulator value where the fractional part &lt;-1 ; 1) represents the angle within the range &lt;-π; π). The output is a 32-bit single precision floating-point value within the range &lt;-1.0 ; 1.0&gt;.</td>
</tr>
</tbody>
</table>

2.2.2 Declaration

The available GFLIB_Cos functions have the following declarations:

\[
\begin{align*}
&\text{frac16_tGFLIB_Cos_F16(frac16_t f16Angle)} \\
&\text{float_tGFLIB_Cos_FLT(float_t fltAngle)} \\
&\text{float_tGFLIB_Cos_FLTa(acc32_t a32Angle)}
\end{align*}
\]

2.2.3 Function use

The use of the GFLIB_Cos function is shown in the following examples:
2.3 GFLIB_Tan

The GFLIB_Tan function provides a computational method for calculation of a standard trigonometric tangent function tan(x), using the piece-wise polynomial approximation. Function tan(x) takes an angle and returns the ratio of two sides of a right-angled triangle. The ratio is the length of the side opposite the angle divided by the length of the side adjacent to the angle.

\[
\tan(x) = \frac{\sin(x)}{\cos(x)}
\]

Figure 32.

Because both \( \sin(x) \) and \( \cos(x) \) are defined in interval \((-\pi ; \pi)\), the function tan(x) is equal to zero when \( \sin(x) = 0 \) and is equal to infinity when \( \cos(x) = 0 \). The graph of tan(x) is shown in the following figure:
The fractional arithmetic is limited to the range $< -1 ; 1$) so the input argument can only be within this range. The input argument is the multiplier of $\pi$: $\tan(\pi \cdot x)$ where you pass the $x$ argument. Example: if the input is -0.5, it corresponds to $-0.5\pi$. The output of the function is limited to the range $< -1 ; 1$) for the fractional arithmetic. For the points where the function is not defined, the output is fractional $-1$.

### 2.3.1 Available versions

The function is available in the following versions:

- **Fractional output** - the output is the fractional portion of the result; the result is within the range $< -1 ; 1$). The result may saturate.
- **Floating-point output** - the output is the floating-point result.
- **Floating-point output with accumulator input** - the output is the floating-point result. The input is the accumulator angle in radians divided by $\pi$.

The available versions of the GFLIB_Tan function are shown in the following table:

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Result type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GFLIB_Tan_F16</td>
<td>frac16_t</td>
<td>frac16_t</td>
<td>Calculation of the $\tan(\pi \cdot x)$ where the input argument is a 16-bit fractional value normalized to the range $&lt;-1 ; 1$) that represents an angle in radians within the range $&lt;-\pi ; \pi)$. The output is a 16-bit fractional value within the range $&lt;-1 ; 1$).</td>
</tr>
<tr>
<td>GFLIB_TanFLT</td>
<td>float_t</td>
<td>float_t</td>
<td>Calculation of the $\tan(x)$ where the input argument is a 32-bit single precision floating-point value in radians within the range $&lt;-\pi ; \pi)$. The output is a 32-bit single precision floating-point value within the full range.</td>
</tr>
<tr>
<td>GFLIB_TanFLTa</td>
<td>acc32_t</td>
<td>float_t</td>
<td>Calculation of the $\tan(\pi \cdot x)$, where the input argument is a 32-bit accumulator value where the fractional part $&lt;-1 ; 1$) represents the angle within the range $&lt;-\pi ; \pi)$. The output is a 32-bit single precision floating-point value within the full range.</td>
</tr>
</tbody>
</table>

### 2.3.2 Declaration

The available GFLIB_Tan functions have the following declarations:

```c
frac16_t  GFLIB_Tan_F16(frac16_t f16Angle)
float_t   GFLIB_Tan_FLT(float_t fltAngle)
float_t   GFLIB_Tan_FLTa(acc32_t a32Angle)
```
2.3.3 Function use

The use of the GFLIB_Tan function is shown in the following examples:

**Fixed-point version:**

```c
#include "gflib.h"

static frac16_t f16Result;
static frac16_t f16Angle;

void main(void)
{
    f16Angle = FRAC16(0.1); /* f16Angle = 0.1 [18°] */
    /* f16Result = tan(f16Angle); (π * f16Angle[rad]) = deg * (π / 180) */
    f16Result = GFLIB_Tan_F16(f16Angle);
}
```

**Floating-point version:**

```c
#include "gflib.h"

static float_t fltResult;
static float_t fltAngle;

void main(void)
{
    fltAngle = 0.1F; /* fltAngle = 0.1 [5.72°] */
    /* fltResult = tan(fltAngle); (π * fltAngle[rad]) = deg * (π / 180) */
    fltResult = GFLIB_Tan_FLT(fltAngle);
}
```

2.4 GFLIB_Asin

The GFLIB_Asin function provides a computational method for calculation of a standard inverse trigonometric arcsine function arcsin(x), using the piece-wise polynomial approximation. Function arcsin(x) takes the ratio of the length of the opposite side to the length of the hypotenuse and returns the angle.
The fractional arithmetic is limited by the range <-1;1) so the output can only be within this range. This range corresponds to the angle <-1;1). Example: if the output is -0.5 it corresponds to -0.5π.

2.4.1 Available versions

The function is available in the following versions:

- Fractional output - the output is the fractional portion of the result; the result is within the range <-1;1). The result may saturate.
- Floating point output - the output is the floating point result within the range <-π;π>.

The available versions of the GFLIB_Asin function are shown in the following table:

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Result type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GFLIB_Asin_F16</td>
<td>frac16_t</td>
<td>frac16_t</td>
<td>Calculation of the arcsin(x) / π where the input argument is a 16-bit fractional within the range &lt;-1;1). The output is a 16-bit fractional value within the range &lt;-1;1) that represents an angle in radians within the range &lt;-π;π).</td>
</tr>
<tr>
<td>GFLIB_Asin_FLT</td>
<td>float_t</td>
<td>float_t</td>
<td>Calculation of the arcsin(x) where the input argument is a 32-bit single precision floating point value within the range &lt;-1;1&gt;. The output is a 32-bit single precision floating point value within the range &lt;-π;π&gt;.</td>
</tr>
</tbody>
</table>

2.4.2 Declaration

The available GFLIB_Asin functions have the following declarations:

```
frac16_t GFLIB_Asin_F16(frac16_t f16Val)
float_t GFLIB_AsinFLT(float_t fltVal)
```

2.4.3 Function use

The use of the GFLIB_Asin function is shown in the following examples:

```
#include "gflib.h"

static frac16_t f16Result;
static frac16_t f16Value;
```
void main(void) {
    f16Value = FRAC16(0.5); /* f16Value = 0.5 */
    f16Result = GFLIB_Asin_F16(f16Value);
}

Floating-point version:

#include "gflib.h"

static float_t fltResult;
static float_t fltValue;

void main(void) {
    fltValue = 1.57F; /* fltValue = 1.57 rad */
    fltResult = GFLIB_Asin_FLT(fltValue);
}

2.5 GFLIB_Acos

The GFLIB_Acos function provides a computational method for calculation of a standard inverse trigonometric arccosine function \( \arccos(x) \), using the piece-wise polynomial approximation. Function \( \arccos(x) \) takes the ratio of the length of the adjacent side to the length of the hypotenuse and returns the angle.

![Figure 35. Course of the function GFLIB_Acos](image)

The fractional arithmetic is limited by the range \(-1;1\) so the output can only be within this range. This range corresponds to the angle \(-1;1\). Example: if the output is -0.5 it corresponds to \(-0.5\pi\).

2.5.1 Available versions

The function is available in the following versions:

- Fractional output - the output is the fractional portion of the result; the result is within the range \(-1;1\). The result may saturate.
- Floating point output - the output is the floating point result within the range \(-\pi;\pi\).
The available versions of the GFLIB_Acos function are shown in the following table:

<table>
<thead>
<tr>
<th>Function version</th>
<th>Input type</th>
<th>Result type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GFLIB_Acos_F16</td>
<td>frac16_t</td>
<td>frac16_t</td>
<td>Calculation of the arccos(x) / ( \pi ) where the input argument is a 16-bit fractional within the range (-1;1). The output is a 16-bit fractional value within the range (-1;1) that represents an angle in radians within the range (-\pi;\pi).</td>
</tr>
<tr>
<td>GFLIB_Acos_FLT</td>
<td>float_t</td>
<td>float_t</td>
<td>Calculation of the arccos(x) where the input argument is a 32-bit single precision floating point value within the range (-1;1). The output is a 32-bit single precision floating point value within the range (-\pi;\pi).</td>
</tr>
</tbody>
</table>

2.5.2 Declaration

The available GFLIB_Acos functions have the following declarations:

```c
frac16_t GFLIB_Acos_F16(frac16_t f16Val)
float_t GFLIB_Acos_FLT(float_t fltVal)
```

2.5.3 Function use

The use of the GFLIB_Acos function is shown in the following examples:

**Fixed-point version:**

```c
#include "gflib.h"
static frac16_t f16Result;
static frac16_t f16Value;
void main(void)
{
    f16Value = FRAC16(0.5);         /* f16Value = 0.5 */
    f16Result = GFLIB_Acos_F16(f16Value);
}
```

**Floating-point version:**

```c
#include "gflib.h"
static float_t fltResult;
static float_t fltValue;
void main(void)
{
    fltValue = 1.57F;         /* fltValue = 1.57 rad */
    fltResult = GFLIB_Acos_FLT(fltValue);
}
2.6 GFLIB_Atan

The GFLIB_Atan function implements the polynomial approximation of the arctangent function. It provides a computational method for calculating the standard trigonometric arctangent function \( \arctan(x) \), using the piece-wise minimax polynomial approximation. Function \( \arctan(x) \) takes a ratio, and returns the angle of two sides of a right-angled triangle. The ratio is the length of the side opposite to the angle divided by the length of the side adjacent to the angle. The graph of the \( \arctan(x) \) is shown in the following figure:

![Graph of the GFLIB_Atan function](image_url)

The fractional arithmetic version of the GFLIB_Atan function is limited to a certain range of inputs \((-1 ; 1)\). Because the arctangent values are the same, with just an opposite sign for the input ranges \((-1 ; 0)\) and \((-0 ; 1)\), the approximation of the arctangent function over the entire defined range of input ratios can be simplified to the approximation for a ratio in the range \((-0 ; 1)\). After that, the result will be negated, depending on the input ratio.

### 2.6.1 Available versions

The function is available in the following versions:

- **Fractional output** - the output is the fractional portion of the result; the result is within the range \((-0.25 ; 0.25)\), which corresponds to the angle \((-\pi / 4 ; \pi / 4)\).
- **Floating-point output** - the output is the floating-point result within the range \((-\pi / 2 ; \pi / 2)\).
- **Accumulator output with floating-point input** - the output is the accumulator angle within the range \((-0.5 ; 0.5)\), which corresponds to the angle \((-\pi / 2 ; \pi / 2)\). The input is the floating-point value.

The available versions of the GFLIB_Atan function are shown in the following table:

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Result type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GFLIB_Atan_F16</td>
<td>frac16_t</td>
<td>frac16_t</td>
<td>Input argument is a 16-bit fractional value within the range ((-1 ; 1)). The output is the arctangent of the input as a 16-bit fractional value, normalized within the ((-0.5 ; 0.5)) range.</td>
</tr>
</tbody>
</table>

*Table continues on the next page...*
Table 7. Function versions (continued)

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Result type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GFLIB_Atan_FLT</td>
<td>float_t</td>
<td>float_t</td>
<td>Input argument is a 32-bit single precision floating-point value within the full type's range. The output is the arctangent of the input as a 32-bit single precision floating-point value in radians.</td>
</tr>
<tr>
<td>GFLIB_Atan_A32f</td>
<td>float_t</td>
<td>acc32_t</td>
<td>Input argument is a 32-bit single precision floating-point value within the full type's range. The output is the arctangent of the input as a 32-bit accumulator value, normalized within the range (-0.5 ; 0.5), which represents an angle (in radians) in the range (-π / 2 ; π / 2) (-90° ; 90°).</td>
</tr>
</tbody>
</table>

2.6.2 Declaration

The available GFLIB_Atan functions have the following declarations:

```c
frac16_t GFLIB_Atan_F16(frac16_t f16Val)
float_t GFLIB_Atan_FLT(float_t fltVal)
acc32_t GFLIB_Atan_A32f(float_t fltVal)
```

2.6.3 Function use

The use of the GFLIB_Atan function is shown in the following examples:

**Fixed-point version:**

```c
#include "gflib.h"

static frac16_t f16Result;
static frac16_t f16Val;

void main(void)
{
    f16Val = FRAC16(0.1666666);   /* f16Val = 0.1666666 (30°)  */
    /* f16Result = atan(f16Val); f16Result * 180 => angle[degree] */
    f16Result = GFLIB_Atan_F16(f16Val);
}
```

**Floating-point version:**

```c
#include "gflib.h"

static float_t fltResult;
static float_t fltVal;

void main(void)
{
    fltVal = 0.52359f;   /* fltVal = 0.52359 rad (30°)  */
    /* fltResult = atan(fltVal); fltResult * 180 => angle[degree] */
    fltResult = GFLIB_Atan_FLT(fltVal);
}
2.7 GFLIB_AtanYX

The GFLIB_AtanYX function computes the angle, where its tangent is \( y / x \) (see the figure below). This calculation is based on the input argument division (\( y \) divided by \( x \)), and the piece-wise polynomial approximation.

The first parameter \( Y \) is the ordinate (the \( x \) coordinate), and the second parameter \( X \) is the abscissa (the \( x \) coordinate). The counter-clockwise direction is assumed to be positive, and thus a positive angle is computed if the provided ordinate (\( Y \)) is positive. Similarly, a negative angle is computed for the negative ordinate. The calculations are performed in several steps. In the first step, the angle is positioned within the correct half-quarter of the circumference of a circle by dividing the angle into two parts: the integral multiple of 45° (half-quarter), and the remaining offset within the 45° range. Simple geometric properties of the Cartesian coordinate system are used to calculate the coordinates of the vector with the calculated angle offset. In the second step, the vector ordinate is divided by the vector abscissa (\( y / x \)) to obtain the tangent value of the angle offset. The angle offset is computed by applying the GFLIB_Atan function. The sum of the integral multiple of half-quarters and the angle offset within a single halfquarter form the angle is computed.
The function returns 0 if both input arguments equal 0, and sets the output error flag; in other cases, the output flag is cleared. When compared to the GFLIB_Atan function, the GFLIB_AtanYX function places the calculated angle correctly within the fractional range \(-\pi ; \pi\).

In the fractional arithmetic, both input parameters are assumed to be in the fractional range \(-1 ; 1\). The output is within the range \(-1 ; 1\), which corresponds to the real range \(-\pi ; \pi\).

### 2.7.1 Available versions

This function is available in the following versions:

- **Fractional output** - the output is the fractional portion of the result; the result is within the range \(-1 ; 1\), which corresponds to the angle \(-\pi ; \pi\).
- **Floating-point output** - the output is the floating-point result within the range \(-\pi ; \pi\).
- **Accumulator output with floating-point input** - the output is the accumulator angle within the range \(-1 ; 1\), which corresponds to the angle \(-\pi ; \pi\). The input is the floating-point value.

The available versions of the GFLIB_AtanYX function are shown in the following table:

#### Table 8. Function versions

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Output type</th>
<th>Result type</th>
</tr>
</thead>
<tbody>
<tr>
<td>GFLIB_AtanYX_F16</td>
<td>frac16_t</td>
<td>frac16_t</td>
<td>bool_t *</td>
</tr>
<tr>
<td></td>
<td>Y</td>
<td>X</td>
<td>error flag</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>frac16_t</td>
</tr>
<tr>
<td>GFLIB_AtanYX_FLT</td>
<td>float_t</td>
<td>float_t</td>
<td>bool_t *</td>
</tr>
<tr>
<td></td>
<td>Y</td>
<td>X</td>
<td>error flag</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>float_t</td>
</tr>
<tr>
<td>GFLIB_AtanYX_A32ff</td>
<td>float_t</td>
<td>float_t</td>
<td>bool_t *</td>
</tr>
<tr>
<td></td>
<td>Y</td>
<td>X</td>
<td>error flag</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>acc32_t</td>
</tr>
</tbody>
</table>

The first input argument is a 16-bit fractional value that contains the ordinate of the input vector (y coordinate). The second input argument is a 16-bit fractional value that contains the abscissa of the input vector (x coordinate). The result is the arctangent of the input arguments as a 16-bit fractional value within the range \(-1 ; 1\), which corresponds to the real angle range \(-\pi ; \pi\). The function sets the boolean error flag pointed to by the output parameter if both inputs are zero; in other cases, the output flag is cleared.

The first input argument is a 32-bit single precision floating-point value, which contains the ordinate of the input vector (y coordinate). The second input argument is a 32-bit single precision floating-point value, which contains the abscissa of the input vector (x coordinate). The result is the arctangent of the input arguments as a 32-bit single precision floating-point value within the range \(-\pi ; \pi\). The function sets the boolean error flag pointed to by the output parameter if both inputs are zero; in other cases, the output flag is cleared.

The first input argument is a 32-bit single precision floating-point value, which contains the ordinate of the input vector (y coordinate). The second input argument is a 32-bit single precision floating-point value, which contains the abscissa of the input vector (x coordinate). The result is the arctangent of the input arguments as a 32-bit accumulator value within the range \(-1 ; 1\), which corresponds to the real angle range \(-\pi ; \pi\). The function sets the boolean error flag pointed to by the output parameter if both inputs are zero; in other cases, the output flag is cleared.

### 2.7.2 Declaration

The available GFLIB_AtanYX functions have the following declarations:

```c
frac16_tGFLIB_AtanYX_F16(frac16_t f16Y, frac16_t f16X, bool_t *pbErrFlag)
float_tGFLIB_AtanYXFLT(float_t fltY, float_t fltX, bool_t *pbErrFlag)
acc32_tGFLIB_AtanYX_A32ff(float_t fltY, float_t fltX, bool_t *pbErrFlag)
```
2.7.3 Function use

The use of the GFLIB_AtanYX function is shown in the following examples:

### Fixed-point version:

```c
#include "gflib.h"

static frac16_t f16Result;
static frac16_t f16Y, f16X;
static bool_t bErrFlag;

void main(void)
{
    f16Y = FRAC16(0.9);  /* f16Y = 0.9 */
    f16X = FRAC16(0.3);  /* f16X = 0.3 */
    /* f16Result = atan(f16Y / f16X); f16Result * 180 => angle [degree] */
    f16Result = GFLIB_AtanYX_F16(f16Y, f16X, &bErrFlag);
}
```

### Floating-point version:

```c
#include "gflib.h"

static float_t fltResult;
static float_t fltY, fltX;
static bool_t bErrFlag;

void main(void)
{
    fltY = 0.9F;  /* fltY = 0.9 */
    fltX = 0.3F;  /* fltX = 0.3 */
    /* fltResult = atan(fltY / fltX); fltResult * 180 / 3.14 => angle [degree] */
    fltResult = GFLIB_AtanYX_FLT(fltY, fltX, &bErrFlag);
}
```

2.8 GFLIB_Sqrt

The GFLIB_Sqrt function returns the square root of the input value. The input must be a non-negative number, otherwise the function returns undefined results. See the following equation:

\[
GFLIB\_Sqrt(x) = \begin{cases} 
\sqrt{x}, & x \geq 0 \\
\text{undefined}, & x < 0
\end{cases}
\]

Figure 38. Algorithm formula

2.8.1 Available versions

This function is available in the following versions:

- Fractional output - the output is the fractional portion of the result; the result is within the range <0 ; 1). The function is only defined for non-negative inputs. The function returns undefined results out of this condition.
• Floating-point output - the output is the floating-point non-negative result. The function is only defined for non-negative inputs. The function returns undefined results out of this condition.

The available versions of the GFLIB_Sqrt function are shown in the following table:

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Result type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GFLIB_Sqrt_F16</td>
<td>frac16_t</td>
<td>frac16_t</td>
<td>The input value is a 16-bit fractional value, limited to the range &lt;0 ; 1). The function is not defined out of this range. The output is a 16-bit fractional value within the range &lt;0 ; 1).</td>
</tr>
<tr>
<td>GFLIB_Sqrt_F16l</td>
<td>frac32_t</td>
<td>frac16_t</td>
<td>The input value is a 32-bit fractional value, limited to the range &lt;0 ; 1). The function is not defined out of this range. The output is a 16-bit fractional value within the range &lt;0 ; 1).</td>
</tr>
<tr>
<td>GFLIB_Sqrt_FLT</td>
<td>float_t</td>
<td>float_t</td>
<td>The input value is a 32-bit single precision floating-point non-negative value. The function is not defined for the negative inputs. The output is a 32-bit single precision floating-point non-negative value.</td>
</tr>
</tbody>
</table>

2.8.2 Declaration

The available GFLIB_Sqrt functions have the following declarations:

```c
frac16_t GFLIB_Sqrt_F16(frac16_t f16Val)
frac16_t GFLIB_Sqrt_F16l(frac32_t f32Val)
float_t GFLIB_Sqrt_FLT(float_t fltVal)
```

2.8.3 Function use

The use of the GFLIB_Sqrt function is shown in the following examples:

**Fixed-point version:**

```c
#include "gflib.h"

static frac16_t f16Result;
static frac16_t f16Val;

void main(void)
{
    f16Val = FRAC16(0.5); /* f16Val = 0.5 */

    /* f16Result = sqrt(f16Val) */
    f16Result = GFLIB_Sqrt_F16(f16Val);
}
```

**Floating-point version:**

```c
#include "gflib.h"

static float_t fltResult;
static float_t fltVal;

void main(void)
```
2.9 GFLIB_Limit

The GFLIB_Limit function returns the value limited by the upper and lower limits. See the following equation:

\[
\text{GFLIB\_Limit}(x, \text{min}, \text{max}) = \begin{cases} 
\text{min}, & x < \text{min} \\
\text{max}, & x > \text{max} \\
x, & \text{else}
\end{cases}
\]

Figure 39. Algorithm formula

2.9.1 Available versions

This function is available in the following versions:

- Fractional output - the output is the fractional portion of the result; the result is within the range \(-1 ; 1\). The result may saturate.

- Floating-point output - the output is the floating-point result within the type's full range.

The available versions of the GFLIB_Limit functions are shown in the following table:

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Result type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GFLIB_Limit_F16</td>
<td>frac16_t</td>
<td>frac16_t</td>
<td>frac16_t</td>
</tr>
<tr>
<td>GFLIB_Limit_F32</td>
<td>frac32_t</td>
<td>frac32_t</td>
<td>frac32_t</td>
</tr>
<tr>
<td>GFLIB_Limit_FLT</td>
<td>float_t</td>
<td>float_t</td>
<td>float_t</td>
</tr>
</tbody>
</table>

2.9.2 Declaration

The available GFLIB_Limit functions have the following declarations:

```c
frac16_t GFLIB_Limit_F16(frac16_t fltVal, frac16_t fltLLim, frac16_t fltULim)
frac32_t GFLIB_Limit_F32(frac32_t fltVal, frac32_t fltLLim, frac32_t fltULim)
float_t GFLIB_Limit_FLT(float_t fltVal, float_t fltLLim, float_t fltULim)
```

2.9.3 Function use

The use of the GFLIB_Limit function is shown in the following examples:
Fixed-point version:

```c
#include "gflib.h"

static frac16_t f16Val, f16ULim, f16LLim, f16Result;

void main(void)
{
    f16ULim = FRAC16(0.8);
    f16LLim = FRAC16(-0.3);
    f16Val = FRAC16(0.9);

    f16Result = GFLIB_Limit_F16(f16Val, f16LLim, f16ULim);
}
```

Floating-point version:

```c
#include "gflib.h"

static float_t fltVal, fltULim, fltLLim, fltResult;

void main(void)
{
    fltULim = 0.8F;
    fltLLim = -0.3F;
    fltVal = 0.9F;

    fltResult = GFLIB_LimitFLT(fltVal, fltLLim, fltULim);
}
```

2.10 GFLIB_LowerLimit

The GFLIB_LowerLimit function returns the value limited by the lower limit. See the following equation:

\[
\text{GFLIB\_LowerLimit}(x, \text{min}) = \begin{cases} 
\text{min}, & x < \text{min} \\
 x, & \text{else} 
\end{cases}
\]

Figure 40. Algorithm formula

2.10.1 Available versions

This function is available in the following versions:

- Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result may saturate.
- Floating-point output - the output is the floating-point result within the type's full range.

The available versions of the GFLIB_LowerLimit functions are shown in the following table:
Table 11. Function versions

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Lower limit</th>
<th>Result type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GFLIB_LowerLimit_F16</td>
<td>frac16_t</td>
<td>frac16_t</td>
<td>frac16_t</td>
<td>The inputs are 16-bit fractional values within the range $&lt;-1; 1)$. The function returns a 16-bit fractional value in the range $&lt;f16LLim; 1)$.</td>
</tr>
<tr>
<td>GFLIB_LowerLimit_F32</td>
<td>frac32_t</td>
<td>frac32_t</td>
<td>frac32_t</td>
<td>The inputs are 32-bit fractional values within the range $&lt;-1; 1)$. The function returns a 32-bit fractional value in the range $&lt;f32LLim; 1)$.</td>
</tr>
<tr>
<td>GFLIB_LowerLimit_FLT</td>
<td>float_t</td>
<td>float_t</td>
<td>float_t</td>
<td>The inputs are 32-bit single precision floating-point values within the full range. The function returns a 32-bit single precision floating-point value greater than or equal to fltLLim.</td>
</tr>
</tbody>
</table>

2.10.2 Declaration
The available GFLIB_LowerLimit functions have the following declarations:

```c
frac16_t GFLIB_LowerLimit_F16(frac16_t f16Val, frac16_t f16LLim)
frac32_t GFLIB_LowerLimit_F32(frac32_t f32Val, frac32_t f32LLim)
float_t GFLIB_LowerLimit_FLT(float_t fltVal, float_t fltLLim)
```

2.10.3 Function use
The use of the GFLIB_LowerLimit function is shown in the following examples:

### Fixed-point version:

```c
#include "gflib.h"

static frac16_t f16Val, f16LLim, f16Result;

void main(void)
{
    f16LLim = FRAC16(0.3);
    f16Val = FRAC16(0.1);

    f16Result = GFLIB_LowerLimit_F16(f16Val, f16LLim);
}
```

### Floating-point version:

```c
#include "gflib.h"

static float_t fltVal, fltLLim, fltResult;

void main(void)
{
    fltLLim = 0.3F;
    fltVal = 0.1F;
```
2.11 GFLIB_UpperLimit

The GFLIB_UpperLimit function returns the value limited by the upper limit. See the following equation:

$$GFLIB\_UpperLimit(x, max) = \begin{cases} \max, & x > \max \\ x, & \text{else} \end{cases}$$

**Figure 41. Algorithm formula**

2.11.1 Available versions

This function is available in the following versions:

- Fractional output - the output is the fractional portion of the result; the result is within the range $<-1; 1)$. The result may saturate.
- Floating-point output - the output is the floating-point result within the type's full range.

The available versions of the GFLIB_UpperLimit functions are shown in the following table:

**Table 12. Function versions**

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Result type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Input</td>
<td>Upper limit</td>
<td></td>
</tr>
<tr>
<td>GFLIB_UpperLimit_F16</td>
<td>frac16_t</td>
<td>frac16_t</td>
<td>The inputs are 16-bit fractional values within the range $&lt;-1; 1)$. The function returns a 16-bit fractional value in the range $&lt;-1; f16ULim&gt;$.</td>
</tr>
<tr>
<td>GFLIB_UpperLimit_F32</td>
<td>frac32_t</td>
<td>frac32_t</td>
<td>The inputs are 32-bit fractional values within the range $&lt;-1; 1)$. The function returns a 32-bit fractional value in the range $&lt;-1; f32ULim&gt;$.</td>
</tr>
<tr>
<td>GFLIB_UpperLimit_FLT</td>
<td>float_t</td>
<td>float_t</td>
<td>The inputs are 32-bit single precision floating-point values within the full range. The function returns a 32-bit single precision floating-point value, which is lower or equal to fltULim.</td>
</tr>
</tbody>
</table>

2.11.2 Declaration

The available GFLIB_UpperLimit functions have the following declarations:

- `frac16_t GFLIB_UpperLimit_F16(frac16_t f16Val, frac16_t f16ULim)`
- `frac32_t GFLIB_UpperLimit_F32(frac32_t f32Val, frac32_t f32ULim)`
- `float_t GFLIB_UpperLimit_FLT(float_t fltVal, float_t fltULim)`

2.11.3 Function use

The use of the GFLIB_UpperLimit function is shown in the following examples:

**Fixed-point version:**

```c
#include "gflib.h"
```

```c
fltResult = GFLIB_LowerLimit_FLT(fltVal, fltLLim);
```
2.12 GFLIB_VectorLimit

The GFLIB_VectorLimit function returns the limited vector by an amplitude. This limitation is calculated to achieve the zero angle error.

The GFLIB_VectorLimit function limits the amplitude of the input vector. The input vector $a, b$ components, are passed into the function as the input arguments. The resulting limited vector is transformed back into the $a, b$ components. The limitation is performed according to the following equations:
where:

- \(a, b\) are the vector coordinates
- \(a^*, b^*\) are the vector coordinates after limitation
- \(\text{lim}\) is the maximum amplitude

The relationship between the input and limited output vectors is obvious from Figure 42.

If the amplitude of the input vector is greater than the input Lim value, the function calculates the new coordinates from the Lim value; otherwise the function copies the input values to the output.

### 2.12.1 Available versions

The function is available in the following versions:

- Fractional output - the output is the fractional portion of the result; the result is within the range <-1;1). The result may saturate.
- Floating point output - the output is the floating point result within the type's full range.

The available versions of the GFLIB_VectorLimit functions are shown in the following table:

<table>
<thead>
<tr>
<th>Table 13. Function versions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function name</td>
</tr>
<tr>
<td>GFLIB_VectorLimit_F16</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>GFLIB_VectorLimit_F16</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>GFLIB_VectorLimit_FLT</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>GFLIB_VectorLimit_FLT</td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

### 2.12.2 GFLIB_VECTORLIMIT_T_F16 type description

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Input type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>f16A</td>
<td>frac16_t</td>
<td>A-component; 16-bit fractional type.</td>
</tr>
<tr>
<td>f16B</td>
<td>frac16_t</td>
<td>B-component; 16-bit fractional type</td>
</tr>
</tbody>
</table>
2.12.3 GFLIB_VECTORLIMIT_TFLT type description

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Input type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>fltA</td>
<td>float_t</td>
<td>A-component; 32-bit single precision floating point type.</td>
</tr>
<tr>
<td>fltB</td>
<td>float_t</td>
<td>B-component; 32-bit single precision floating point type.</td>
</tr>
</tbody>
</table>

2.12.4 Declaration

The available GFLIB_VectorLimit functions have the following declarations:

```c
frac16_t GFLIB_VectorLimit_F16(const GFLIB_VECTORLIMIT_T_F16 *psVectorIn, frac16_t f16Lim, GFLIB_VECTORLIMIT_T_F16 *psVectorOut)

float_t GFLIB_VectorLimit_FLT(const GFLIB_VECTORLIMIT_T_FLT *psVectorIn, float_t fltLim, GFLIB_VECTORLIMIT_T_FLT *psVectorOut)
```

2.12.5 Function use

The use of the GFLIB_VectorLimit function is shown in the following examples:

**Fixed-point version:**

```c
#include "gflib.h"

static GFLIB_VECTORLIMIT_T_F16 sVector, sResult;
static frac16_t f16MaxAmpl;

void main(void)
{
  f16MaxAmpl = FRAC16(0.8);
  sVector.f16A = FRAC16(-0.79);
  sVector.f16B = FRAC16(0.86);
  GFLIB_VectorLimit_F16(&sVector, f16MaxAmpl, &sResult);
}
```

**Floating-point version:**

```c
#include "gflib.h"

static GFLIB_VECTORLIMIT_T_FLT sVector, sResult;
static float_t fltMaxAmpl;

void main(void)
{
  fltMaxAmpl = 0.8F;
  sVector.fltA = -0.79F;
  sVector.fltB = 0.86F;
}
```
2.13 GFLIB_VectorLimit1

The GFLIB_VectorLimit1 function returns the limited vector by an amplitude. This limitation is calculated to achieve that the first component remains unchanged (if the limitation factor allows).

\[
\begin{align*}
    a^* &= \begin{cases} 
        a, & |a| \leq \text{lim} \\
        \text{lim} \cdot \text{sgn}(a), & \text{else}
    \end{cases} \\
    b^* &= \begin{cases} 
        b, & |b| \leq \sqrt{\text{lim}^2 - a^{*2}} \\
        \sqrt{\text{lim}^2 - a^{*2}} \cdot \text{sgn}(b), & \text{else}
    \end{cases}
\end{align*}
\]

where:

- \(a\), \(b\) are the vector coordinates
- \(a^*, b^*\) are the vector coordinates after limitation
- \(\text{lim}\) is the maximum amplitude
The relationship between the input and limited output vectors is shown in Figure 44. If the amplitude of the input vector is greater than the input Lim value, the function calculates the new coordinates from the Lim value; otherwise the function copies the input values to the output.

### 2.13.1 Available versions

The function is available in the following versions:

- **Fractional output** - the output is the fractional portion of the result; the result is within the range $<-1 ; 1)$. The result may saturate.
- **Floating-point output** - the output is the floating-point result within the type's full range.

The available versions of the GFLIB_VectorLimit1 function are shown in the following table:

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Output type</th>
<th>Result type</th>
</tr>
</thead>
<tbody>
<tr>
<td>GFLIB_VectorLimit1_F16</td>
<td>GFLIB_VECTORLIMIT_T_F16 *</td>
<td>GFLIB_VECTORLIMIT_T_F16 *</td>
<td>void</td>
</tr>
<tr>
<td></td>
<td>frac16_t</td>
<td>frac16_t</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GFLIB_VectorLimit1_FLT</td>
<td>GFLIB_VECTORLIMIT_T_FLT *</td>
<td>GFLIB_VECTORLIMIT_T_FLT *</td>
<td>void</td>
</tr>
<tr>
<td></td>
<td>float_t</td>
<td>float_t</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Limitation of a two-component 16-bit fractional vector within the range $<-1 ; 1)$ with a 16-bit fractional limitation amplitude. The function returns a two-component 16-bit fractional vector.**

**Limitation of a two-component 32-bit single precision floating-point vector within the full range with a 32-bit single precision floating-point limitation amplitude. The function returns a two-component 32-bit single precision floating-point vector.**

### 2.13.2 GFLIB_VECTORLIMIT_T_F16 type description

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Input type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>f16A</td>
<td>frac16_t</td>
<td>A-component; 16-bit fractional type.</td>
</tr>
<tr>
<td>f16B</td>
<td>frac16_t</td>
<td>B-component; 16-bit fractional type.</td>
</tr>
</tbody>
</table>

### 2.13.3 GFLIB_VECTORLIMIT_T_FLT type description

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Input type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>fltA</td>
<td>float_t</td>
<td>A-component; 32-bit single precision floating-point type.</td>
</tr>
<tr>
<td>fltB</td>
<td>float_t</td>
<td>B-component; 32-bit single precision floating-point type.</td>
</tr>
</tbody>
</table>

### 2.13.4 Declaration

The available GFLIB_VectorLimit1 functions have the following declarations:

```c
frac16_t GFLIB_VectorLimit1_F16(const GFLIB_VECTORLIMIT_T_F16 *psVectorIn, frac16_t f16Lim, GFLIB_VECTORLIMIT_T_F16 *psVectorOut)
```

```c
float_t GFLIB_VectorLimit1_FLT(const GFLIB_VECTORLIMIT_T_FLT *psVectorIn, float_t fltLim, GFLIB_VECTORLIMIT_T_FLT *psVectorOut)
```
2.13.5 Function use

The use of the GFLIB_VectorLimit1 function is shown in the following examples:

### Fixed-point version:

```c
#include "gflib.h"

static GFLIB_VECTORLIMIT_T_F16 sVector, sResult;
static frac16_t f16MaxAmpl;

void main(void)
{
    f16MaxAmpl = FRAC16(0.5);
    sVector.f16A = FRAC16(-0.4);
    sVector.f16B = FRAC16(0.2);
    GFLIB_VectorLimit1_F16(&sVector, f16MaxAmpl, &sResult);
}
```

### Floating-point version:

```c
#include "gflib.h"

static GFLIB_VECTORLIMIT_T_FLT sVector, sResult;
static float_t fltMaxAmpl;

void main(void)
{
    fltMaxAmpl = 0.8F;
    sVector.fltA = -0.79F;
    sVector.fltB = 0.86F;
    GFLIB_VectorLimit1_FLT(&sVector, fltMaxAmpl, &sResult);
}
```

2.14 GFLIB_Hyst

The GFLIB_Hyst function represents a hysteresis (relay) function. The function switches the output between two predefined values. When the input is higher than the upper threshold, the output is high; when the input is lower than the lower threshold, the output is low. When the input is between the two thresholds, the output retains its value. See the following figure:
The four points in the figure are to be set up in the parameters structure of the function. For a proper functionality, the HystOn point must be greater than the HystOff point.

2.14.1 Available versions

This function is available in the following versions:

- Fractional output - the output is the fractional portion of the result, and the result is within the range <-1 ; 1).
- Floating-point output - the output is the floating-point result within the type’s full range.

The available versions of the GFLIB_Hyst function are shown in the following table.

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Parameters</th>
<th>Result type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GFLIB_Hyst_F16</td>
<td>frac16_t</td>
<td>GFLIB_HYST_T_F16 *</td>
<td>frac16_t</td>
<td>The input is a 16-bit fractional value within the range &lt;-1 ; 1). The output is a two-state 16-bit fractional value.</td>
</tr>
<tr>
<td>GFLIB_Hyst_FLT</td>
<td>float_t</td>
<td>GFLIB_HYST_T_FLT *</td>
<td>float_t</td>
<td>The input is a 32-bit single precision floating-point value within its full range. The output is a two-state 32-bit single precision floating-point value.</td>
</tr>
</tbody>
</table>

2.14.2 GFLIB_HYST_T_F16

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Input type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>f16HystOn</td>
<td>frac16_t</td>
<td>The point where the output sets the output to the f16OutValOn value when the input rises. Set by the user.</td>
</tr>
</tbody>
</table>

Table continues on the next page...
### Table continued from the previous page...

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Input type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>f16HystOff</td>
<td>frac16_t</td>
<td>The point where the output sets the output to the f16OutValOff value when the input falls. Set by the user.</td>
</tr>
<tr>
<td>f16OutValOn</td>
<td>frac16_t</td>
<td>The ON value. Set by the user.</td>
</tr>
<tr>
<td>f16OutValOff</td>
<td>frac16_t</td>
<td>The OFF value. Set by the user.</td>
</tr>
<tr>
<td>f16OutState</td>
<td>frac16_t</td>
<td>The output state. Set by the algorithm. Must be initialized by the user.</td>
</tr>
</tbody>
</table>

#### 2.14.3 GFLIB_HYST_T_FLT

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Input type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>fltHystOn</td>
<td>float_t</td>
<td>The point where the output sets the output to the fltOutValOn value when the input rises. Set by the user.</td>
</tr>
<tr>
<td>fltHystOff</td>
<td>float_t</td>
<td>The point where the output sets the output to the fltOutValOff value when the input falls. Set by the user.</td>
</tr>
<tr>
<td>fltOutValOn</td>
<td>float_t</td>
<td>The ON value. Set by the user.</td>
</tr>
<tr>
<td>fltOutValOff</td>
<td>float_t</td>
<td>The OFF value. Set by the user.</td>
</tr>
<tr>
<td>fltOutState</td>
<td>float_t</td>
<td>The output state. Set by the algorithm. Must be initialized by the user.</td>
</tr>
</tbody>
</table>

#### 2.14.4 Declaration

The available **GFLIB_Hyst** functions have the following declarations:

```c
frac16_t GFLIB_Hyst_F16(frac16_t f16Val, GFLIB_HYST_T_F16 *psParam)
float_t GFLIB_Hyst_FLT(float_t fltVal, GFLIB_HYST_T_FLT *psParam)
```

#### 2.14.5 Function use

The use of the **GFLIB_Hyst** function is shown in the following examples:

```c
#include "gflib.h"

static frac16_t f16Result, f16InVal;
static GFLIB_HYST_T_F16 sParam;

void main(void)
{
    f16InVal = FRAC16(-0.11);
    sParam.f16HystOn = FRAC16(0.5);
    sParam.f16HystOff = FRAC16(-0.1);
    sParam.f16OutValOn = FRAC16(0.7);
    sParam.f16OutValOff = FRAC16(0.3);
    sParam.f16OutState = FRAC16(0.0);
```
2.15 GFLIB_Lut1D

The `GFLIB_Lut1D` function implements the one-dimensional look-up table.

\[ y = y_1 + \frac{y_2 - y_1}{x_2 - x_1}(x - x_1) \]

Figure 46.

where:

- \( y \) is the interpolated value
- \( y_1 \) and \( y_2 \) are the ordinate values at the beginning and end of the interpolating interval, respectively
- \( x_1 \) and \( x_2 \) are the abscissa values at the beginning and end of the interpolating interval, respectively
- \( x \) is the input value provided to the function in the X input argument
The **GFLIB_Lut1D** function fuses a table of the precalculated function points. These points are selected with a fixed step.

The fractional version of the algorithm has a defined interval of inputs within the range \(-1 ; 1\). The last table point is intended for the real value of 1, not the value of 1 from the fraction numbers, which is lower than the real value of 1. The calculations are based on the same intervals among the table points. The number of points must be \(2^n + 1\), where \(n\) can range from 1 through to 15.

The floating-point version of the algorithm has a defined interval of inputs within the range \(<\text{min} ; \text{max}\rangle\), where the min and max values are the parameters of the algorithms. The number of points is within the range \(<2 ; 65535\rangle\), where the first point lies at the min position, and the last point lies at the max position.

The function finds two nearest precalculated points of the input argument, and calculates the output value using the linear interpolation between these two points.

### 2.15.1 Available versions

This function is available in the following versions:

- **Fractional output** - the output is the fractional portion of the result; the result is within the range \(-1 ; 1\).
- **Floating-point output** - the output is the floating-point result within the type’s full range. The input values are defined by the minimum and maximum input parameters of the GFLIB_Lut1DInit function.

The available versions of the GFLIB_Lut1DInit function are shown in the following table:

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Parameters</th>
<th>Result type</th>
</tr>
</thead>
<tbody>
<tr>
<td>GFLIB_Lut1DInit_FLT</td>
<td>float_t</td>
<td>uint16_t</td>
<td>GFLIB_LUT1D_T_FLT*</td>
</tr>
</tbody>
</table>

The input arguments are the 32-bit single precision floating-point values that contain the minimum and maximum x-coordinates of the look-up table. The table size parameter can be in the range \(<2 ; 65535\rangle\) and the pointer to the structure that contains the parameters defined in #unique_88/unique_88_Connect_42_TABLE_GFLIB_LUT1D_T_FLT.

The available versions of the **GFLIB_Lut1D** function are shown in the following table:
Table 17. Function versions

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Parameters</th>
<th>Result type</th>
</tr>
</thead>
<tbody>
<tr>
<td>GFLIB_Lut1D_F16</td>
<td>frac16_t</td>
<td>frac16_t*</td>
<td>uint16_t</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| The input arguments are the 16-bit fractional value that contains the abscissa for which the 1-D interpolation is performed, the pointer to a table which contains the 16-bit fractional values of the look-up table, and the size of the look-up table. The table size parameter can be in the range <1 ; 15> (that means the parameter is log₂ of the number of points + 1). The output is the interpolated 16-bit fractional value computed from the look-up table.

| GFLIB_Lut1D_F32  | frac32_t   | frac32_t*  | uint16_t    | frac32_t    |
|                  |            |            |             |             |
| The input arguments are the 32-bit fractional value that contains the abscissa for which the 1-D interpolation is performed, the pointer to a table which contains the 32-bit fractional values of the look-up table, and the size of the look-up table. The table size parameter can be in the range <1 ; 15> (that means the parameter is log₂ of the number of points + 1). The output is the interpolated 32-bit fractional value computed from the look-up table.

| GFLIB_Lut1DFLT   | float_t    | float_t*   | GFLIB_LUT1D_T_FLT* | float_t    |
|                  |            |            |                    |             |
| The input arguments are the 32-bit single precision floating-point value that contains the abscissa for which the 1-D interpolation is performed, the pointer to a table which contains the 32-bit single precision floating-point values of the look-up table, and the pointer to a structure that contains the size of the look-up table together with the minimum and maximum borders of the input interval. The table size parameter can be in the range <2 ; 65535>. The first value of the table is located at the fltMin position, and the last value of the table is located at the fltMax position. The output is the interpolated 32-bit single precision floating-point value computed from the look-up table.

2.15.2 GFLIB_LUT1D_T_FLT type description

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Input type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>fltMin</td>
<td>float_t</td>
<td>The minimum of the look-up table x-coordinate; a 32-bit single precision floating-point type. Set by the user in GFLIB_Lut1DInit_FLT.</td>
</tr>
<tr>
<td>fltMax</td>
<td>float_t</td>
<td>The maximum of the look-up table x-coordinate; a 32-bit single precision floating-point type. Set by the user in GFLIB_Lut1DInit_FLT.</td>
</tr>
<tr>
<td>flttintInv</td>
<td>float_t</td>
<td>Inverse interval of the look-up table; a 32-bit single precision floating-point type. Set by the algorithm in GFLIB_Lut1DInit_FLT.</td>
</tr>
<tr>
<td>u16TableSize</td>
<td>uint16_t</td>
<td>Size of the table; a 16-bit unsigned integer type within the range &lt;2 ; 65535&gt;. Set by the user in GFLIB_Lut1DInit_FLT.</td>
</tr>
</tbody>
</table>

2.15.3 Declaration

The available GFLIB_Lut1D functions have the following declarations:

```
frac16_t GFLIB_Lut1D_F16(frac16_t f16X, const frac16_t *pf16Table, uint16_t u16TableSize)

void GFLIB_Lut1DInit_FLT(float_t fltMin, float_t fltMax, uint16_t u16TableSize, const
                        GFLIB_LUT1D_T_FLT *psParam)

float_t GFLIB_Lut1DFLT(float_t fltX, const float_t *pfltTable, const GFLIB_LUT1D_T_FLT *psParam)
```
2.15.4 Function use

The use of the GFLIB_Lut1D function is shown in the following examples:

**Fixed-point version:**

```c
#include "gflib.h"

static frac16_t f16Result, f16X;
static uint16_t u16TableSize;
static frac16_t f16Table[9] = {FRAC16(0.8), FRAC16(0.1), FRAC16(-0.2), FRAC16(0.7),
                               FRAC16(0.2), FRAC16(-0.3), FRAC16(-0.8), FRAC16(0.91), FRAC16(0.99)};

void main(void)
{
    u16TableSize = 3;                            /* size of table = 2 ^ 3 + 1 */
    f16X = FRAC16(0.625);                        /* f16X = 0.625 */
    /* f16Result = value from look-up table between 7th and 8th position */
    f16Result = GFLIB_Lut1D_F16(f16X, f16Table, u16TableSize);
}
```

**Floating-point version:**

```c
#include "gflib.h"

static float_t fltResult, fltX;
GFLIB_LUT1D_T_FLT sParam;
static float_t fltTable[9] = {0.8F, 0.1F, -0.2F, 0.7F, 0.2F, -0.3F, -0.8F, 0.9F, 0.99F};

void main(void)
{
    fltX = 0.25F;                  /* fltX = 0.25 */
    sParam.fltMin = 0.0F;
    sParam.fltMax = 8.0F;
    sParam.u16TableSize = 9;
    GFLIB_Lut1DInit_FLT(sParam.fltMin, sParam.fltMax, sParam.u16TableSize, &sParam);
}

/* periodically called function */
void isr()
{
    fltResult = GFLIB_Lut1D_FLT(fltX, fltTable, &sParam);
}
```

2.16 GFLIB_LutPer1D

The GFLIB_LutPer1D function approximates the one-dimensional arbitrary user function using the interpolation look-up method. It is periodic.
\[ y = y_1 + \frac{y_2 - y_1}{x_2 - x_1}(x - x_1) \]

Figure 48.

where:
- \( y \) is the interpolated value
- \( y_1 \) and \( y_2 \) are the ordinate values at the beginning and end of the interpolating interval, respectively
- \( x_1 \) and \( x_2 \) are the abscissa values at the beginning and end of the interpolating interval, respectively
- \( x \) is the input value provided to the function in the X input argument

The GFLIB_LutPer1D fuses a table of the pre-calculated function points. These points are selected with a fixed step.

The fractional version of the algorithm has a defined interval of inputs within the range \(-1 ; 1\). The last table point is intended for the real value of 1 not the value of 1 from the fraction numbers, which is lower than the real value of 1. The calculations are based on the same intervals among the table points. The floating-point version of the algorithm has a defined interval of inputs within the range \(<\text{min} ; \text{max}>\), where the min and max values are the parameters of the algorithms. The number of points is within the range \(<2 ; 65535>\), where the first point lies at the min position, and the last point lies at the max position.

The function finds two nearest precalculated points of the input argument, and calculates the output value using the linear interpolation between these two points. This algorithm serves for periodical functions. That means that when the input argument lies behind the last pre-calculated point of the function, the interpolation is calculated between the last and first points of the table.

2.16.1 Available versions

This function is available in the following versions:
- Fractional output - the output is the fractional portion of the result; the result is within the range \(-1 ; 1\).
- Floating-point output - the output is the floating-point result within the type’s full range. The input values are defined by the minimum and maximum input parameter of the GFLIB_LutPer1DInit function.

The available versions of the GFLIB_LutPer1DInit function are shown in the following table:
Table 18. Init function versions

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Parameters</th>
<th>Result type</th>
</tr>
</thead>
<tbody>
<tr>
<td>GFLIB_LutPer1DInit_FLT</td>
<td>float_t</td>
<td>float_t, uint16_t, GFLIB_LUT1D_T_FLT*</td>
<td>void</td>
</tr>
</tbody>
</table>

The input arguments are the 32-bit single precision floating-point values that contain the minimum and maximum x-coordinates of the periodic look-up table. The table size parameter can be in the range <2 ; 65535> and the pointer to the structure that contains the parameters defined in .#unique_93/unique_93_Connect_42_TABLE_GFLIB_LUTPER1D_T_FLT

The available versions of the GFLIB_LutPer1D function are shown in the following table:

Table 19. Function versions

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Parameters</th>
<th>Result type</th>
</tr>
</thead>
<tbody>
<tr>
<td>GFLIB_LutPer1D_F16</td>
<td>frac16_t</td>
<td>frac16_t, uint16_t</td>
<td>frac16_t</td>
</tr>
</tbody>
</table>

The input arguments are the 16-bit fractional value that contains the abscissa for which the 1-D interpolation is performed, the pointer to a structure which contains the 16-bit fractional values of the periodic look-up table, and the size of the look-up table. The table size parameter can be in the range <1 ; 15> (that means the parameter is \( \log_2 \) of the number of points). The output is the interpolated 16-bit fractional value computed from the periodic look-up table.

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Parameters</th>
<th>Result type</th>
</tr>
</thead>
<tbody>
<tr>
<td>GFLIB_LutPer1D_F32</td>
<td>frac32_t</td>
<td>frac32_t, uint16_t</td>
<td>frac32_t</td>
</tr>
</tbody>
</table>

The input arguments are the 32-bit fractional value that contains the abscissa for which the 1-D interpolation is performed, the pointer to a table which contains the 32-bit fractional values of the periodic look-up table, and the size of the periodic look-up table. The table size parameter can be in the range <1 ; 15> (that means the parameter is \( \log_2 \) of the number of points). The output is the interpolated 32-bit fractional value computed from the periodic look-up table.

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Parameters</th>
<th>Result type</th>
</tr>
</thead>
<tbody>
<tr>
<td>GFLIB_LutPer1D_FLT</td>
<td>float_t</td>
<td>float_t, GFLIB_LUT1D_T_FLT*</td>
<td>float_t</td>
</tr>
</tbody>
</table>

The input arguments are the 32-bit single precision floating-point value that contains the abscissa for which the 1-D interpolation is performed, the pointer to a structure which contains the 32-bit single precision floating-point values of the periodic look-up table, and the pointer to a structure that contains the size of the periodic look-up table together with the minimum and maximum borders of the input interval. The table size parameter can be in the range <2 ; 65535>. The first value of the table is located at the fitMin position, and the last value of the table is located at the fitMax position. The output is the interpolated 32-bit single precision floating-point value computed from the periodic look-up table.

2.16.2 GFLIB_LUTPER1D_T_FLT type description

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Input type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>fitMin</td>
<td>float_t</td>
<td>The minimum of the periodic look-up table x-coordinate; a 32-bit single precision floating-point type. Set by the user in GFLIB_LutPer1DInit_FLT.</td>
</tr>
<tr>
<td>fitMax</td>
<td>float_t</td>
<td>The maximum of the periodic look-up table x-coordinate; a 32-bit single precision floating-point type. Set by the user in GFLIB_LutPer1DInit_FLT.</td>
</tr>
</tbody>
</table>

Table continues on the next page...
### Table continued from the previous page...

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Input type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>fltIntInv</td>
<td>float_t</td>
<td>Inverse interval of the periodic look-up table; a 32-bit single precision floating-point type. Set by the algorithm in GFLIB_LutPer1DInit_FLT.</td>
</tr>
<tr>
<td>u16TableSize</td>
<td>uint16_t</td>
<td>Size of the table; a 16-bit unsigned integer type within the range &lt;2 ; 65535&gt;. Set by the user in GFLIB_LutPer1DInit_FLT.</td>
</tr>
</tbody>
</table>

#### 2.16.3 Declaration

The available GFLIB_LutPer1D functions have the following declarations:

```c
frac16_t GFLIB_LutPer1D_F16(frac16_t f16X, const frac16_t *pf16Table, uint16_t u16TableSize)

void GFLIB_LutPer1DInit_FLT(float_t fltMin, float_t fltMax, uint16_t u16TableSize, const GFLIB_LUTPER1D_T_FLT *psParam)

float_t GFLIB_LutPer1D_FLT(float_t fltX, const float_t *pfltTable, const GFLIB_LUTPER1D_T_FLT *psParam)
```

#### 2.16.4 Function use

The use of the GFLIB_LutPer1D function is shown in the following examples:

**Fixed-point version:**

```c
#include "gflib.h"

static frac16_t f16Result, f16X;
static uint16_t u16TableSize;
static frac16_t f16Table[8] = {FRAC16(0.8), FRAC16(0.1), FRAC16(-0.2), FRAC16(0.7), FRAC16(0.2), FRAC16(-0.3), FRAC16(-0.8), FRAC16(0.91)};

void main(void)
{
    u16TableSize = 3; /* size of table = 2 ^ 3 */
    f16X = FRAC16(0.25); /* f16X = 0.25 */

    /* f16Result = value from periodic look-up table at 6th position */
    f16Result = GFLIB_LutPer1D_F16(f16X, f16Table, u16TableSize);
}
```

**Floating-point version:**

```c
#include "gflib.h"

static float_t fltResult, fltX;
static float_t fltTable[8] = {0.8F, 0.1F, -0.2F, 0.7F, 0.2F, -0.3F, -0.8F, 0.9F};
GFLIB_LUTPER1D_T_FLT sParam;

void Isr(void);
```
void main(void) {
    fltX = 0.25F;                  /* fltX = 0.25 */
    sParam.fltMin = 0.0F;
    sParam.fltMax = 7.0F;
    sParam.u16TableSize = 8;

    GFLIB_LutPer1DInit_FLT(sParam.fltMin, sParam.fltMax, sParam.u16TableSize, &sParam);
}

/* periodically called function */
void Isr() {
    fltResult = GFLIB_LutPer1D_FLT(fltX, fltTable, &sParam);
}

2.17 GFLIB_Ramp

The GFLIB_Ramp function calculates the up / down ramp with the defined fixed-step increment / decrement. These two parameters must be set by the user.

For a proper use, it is recommended that the algorithm is initialized by the GFLIB_RampInit function, before using the GFLIB_Ramp function. The GFLIB_RampInit function initializes the internal state variable of the GFLIB_Ramp algorithm with a defined value. You must call the init function when you want the ramp to be initialized.

The use of the GFLIB_Ramp function is as follows: If the target value is greater than the ramp state value, the function adds the ramp-up value to the state output value. The output will not trespass the target value, that means it will stop at the target value. If the target value is lower than the state value, the function subtracts the ramp-down value from the state value. The output is limited to the target value, that means it will stop at the target value. This function returns the actual ramp output value. As time passes, it is approaching the target value by step increments defined in the algorithm parameters' structure. The functionality of the implemented ramp algorithm is explained in the next figure:

![GFLIB_Ramp functionality](image)

**Figure 50. GFLIB_Ramp functionality**
2.17.1 Available versions

This function is available in the following versions:

- Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result may saturate.
- Floating-point output - the output is the floating-point result within the type’s full range.

The available versions of the GFLIB_RampInit functions are shown in the following table:

Table 20. Init function versions

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Parameters</th>
<th>Result type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GFLIB_RampInit_F16</td>
<td>frac16_t</td>
<td>GFLIB_RAMP_T_F16*</td>
<td>void</td>
<td>Input argument is a 16-bit fractional value that represents the initialization value. The parameters' structure is pointed to by a pointer. The input data value is in the range &lt;-1 ; 1).</td>
</tr>
<tr>
<td>GFLIB_RampInit_F32</td>
<td>frac32_t</td>
<td>GFLIB_RAMP_T_F32*</td>
<td>void</td>
<td>Input argument is a 32-bit fractional value that represents the initialization value. The parameters' structure is pointed to by a pointer. The input data value is in the range &lt;-1 ; 1).</td>
</tr>
<tr>
<td>GFLIB_RampInitFLT</td>
<td>float_t</td>
<td>GFLIB_RAMP_TFLT*</td>
<td>void</td>
<td>Input argument is a 32-bit single precision floating-point value that represents the initialization value. The parameters' structure is pointed to by a pointer. The input value is within the full 32-bit single-point floating-point range.</td>
</tr>
</tbody>
</table>

The available versions of the GFLIB_Ramp functions are shown in the following table:

Table 21. Function versions

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Parameters</th>
<th>Result type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GFLIB_Ramp_F16</td>
<td>frac16_t</td>
<td>GFLIB_RAMP_T_F16*</td>
<td>frac16_t</td>
<td>Input argument is a 16-bit fractional value that represents the target output value. The parameters' structure is pointed to by a pointer. The function returns a 16-bit fractional value, which represents the actual ramp output value. The input data value is in the range &lt;-1 ; 1), and the output data value is in the range &lt;-1 ; 1).</td>
</tr>
<tr>
<td>GFLIB_Ramp_F32</td>
<td>frac32_t</td>
<td>GFLIB_RAMP_T_F32*</td>
<td>frac32_t</td>
<td>Input argument is a 32-bit fractional value that represents the target output value. The parameters' structure is pointed to by a pointer. The function returns a 32-bit fractional value, which represents the actual ramp output value. The input data value is in the range &lt;-1 ; 1), and the output data value is in the range &lt;-1 ; 1).</td>
</tr>
<tr>
<td>GFLIB_Ramp_FLT</td>
<td>float_t</td>
<td>GFLIB_RAMP_TFLT*</td>
<td>float_t</td>
<td>Input argument is a 32-bit single precision floating-point value that represents the target output value. The parameters' structure is pointed to by a pointer. The function returns a 32-bit single precision floating-point value, which represents the actual ramp output value. The input and output values are within the full 32-bit single-point floating-point range.</td>
</tr>
</tbody>
</table>
2.17.2 GFLIB_RAMP_T_F16

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>f16State</td>
<td>frac16_t</td>
<td>Actual value - controlled by the algorithm.</td>
</tr>
<tr>
<td>f16RampUp</td>
<td>frac16_t</td>
<td>Value of the ramp-up increment. The data value is in the range &lt;0 ; 1). Set by the user.</td>
</tr>
<tr>
<td>f16RampDown</td>
<td>frac16_t</td>
<td>Value of the ramp-down increment. The data value is in the range &lt;0 ; 1). Set by the user.</td>
</tr>
</tbody>
</table>

2.17.3 GFLIB_RAMP_T_F32

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>f32State</td>
<td>frac32_t</td>
<td>Actual value - controlled by the algorithm.</td>
</tr>
<tr>
<td>f32RampUp</td>
<td>frac32_t</td>
<td>Value of the ramp-up increment. The data value is in the range &lt;0 ; 1). Set by the user.</td>
</tr>
<tr>
<td>f32RampDown</td>
<td>frac32_t</td>
<td>Value of the ramp-down increment. The data value is in the range &lt;0 ; 1). Set by the user.</td>
</tr>
</tbody>
</table>

2.17.4 GFLIB_RAMP_T_FLT

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>fltState</td>
<td>float_t</td>
<td>Actual value - controlled by the algorithm.</td>
</tr>
<tr>
<td>fltRampUp</td>
<td>float_t</td>
<td>Value of the ramp-up increment. The data value is within the full 32-bit single precision floating point. Set by the user as non-negative value.</td>
</tr>
<tr>
<td>fltRampDown</td>
<td>float_t</td>
<td>Value of the ramp-down increment. The data value is within the full 32-bit single precision floating point. Set by the user as non-negative value.</td>
</tr>
</tbody>
</table>

2.17.5 Declaration

The available GFLIB_RampInit functions have the following declarations:

```c
void GFLIB_RampInit_F16(frac16_t f16InitVal, GFLIB_RAMP_T_F16 *psParam)
void GFLIB_RampInit_F32(frac32_t f32InitVal, GFLIB_RAMP_T_F32 *psParam)
void GFLIB_RampInit_FLT(float_t fltInitVal, GFLIB_RAMP_T_FLT *psParam)
```

The available GFLIB_Ramp functions have the following declarations:

```c
frac16_t GFLIB_Ramp_F16(frac16_t f16Target, GFLIB_RAMP_T_F16 *psParam)
frac32_t GFLIB_Ramp_F32(frac32_t f32Target, GFLIB_RAMP_T_F32 *psParam)
float_t GFLIB_Ramp_FLT(float_t fltTarget, GFLIB_RAMP_T_FLT *psParam)
```

2.17.6 Function use

The use of the GFLIB_RampInit and GFLIB_Ramp functions is shown in the following examples:

```c
#include "gflib.h"

static frac16_t f16InitVal;
static frac16_t f16InitVal;
static GFLIB_RAMP_T_F16 sParam;
```
static frac16_t f16Target, f16Result;

void Isr(void);

void main(void)
{
    sParam.f16RampUp = FRAC16(0.1);
    sParam.f16RampDown = FRAC16(0.02);
    f16Target = FRAC16(0.75);
    f16InitVal = FRAC16(0.9);
    GFLIB_RampInit_F16(f16InitVal, &sParam);
}

/* periodically called function */
void Isr()
{
    f16Result = GFLIB_Ramp_F16(f16Target, &sParam);
}

Floating-point version:

#include "gflib.h"

static float_t fltInitVal;
static GFLIB_RAMP_T_FLT psParam;
static float_t fltTarget, fltResult;

void Isr(void);

void main(void)
{
    psParam.fltRampUp = 0.1F;
    psParam.fltRampDown = 0.02F;
    fltTarget = 0.75F;
    fltInitVal = 0.9F;
    GFLIB_RampInit_FLT(fltInitVal, &psParam);
}

/* periodically called function */
void Isr()
{
    fltResult = GFLIB_Ramp_FLT(fltTarget, &psParam);
}

2.18 GFLIB_DRamp

The GFLIB_DRamp function calculates the up / down ramp with the defined step increment / decrement. The algorithm approaches the target value when the stop flag is not set, and/or returns to the instant value when the stop flag is set.
For a proper use, it is recommended that the algorithm is initialized by the GFLIB_DRampInit function, before using the GFLIB_DRamp function. This function initializes the internal state variable of GFLIB_DRamp algorithm with the defined value. You must call this function when you want the ramp to be initialized.

The GFLIB_DRamp function calculates a ramp with a different set of up / down parameters, depending on the state of the stop flag. If the stop flag is cleared, the function calculates the ramp of the actual state value towards the target value, using the up or down increments contained in the parameters' structure. If the stop flag is set, the function calculates the ramp towards the instant value, using the up or down saturation increments.

If the target value is greater than the state value, the function adds the ramp-up value to the state value. The output cannot be greater than the target value (case of the stop flag being cleared), nor lower than the instant value (case of the stop flag being set).

If the target value is lower than the state value, the function subtracts the ramp-down value from the state value. The output cannot be lower than the target value (case of the stop flag being cleared), nor greater than the instant value (case of the stop flag being set).

If the actual internal state reaches the target value, the reach flag is set.

### Available versions

The function is available in the following versions:

- **Fractional output** - the output is the fractional portion of the result; the result is within the range \(-1 ; 1\). The result may saturate.
- **Floating-point output** - the output is the floating-point result within the type's full range.

The available versions of the GFLIB_DRampInit function are shown in the following table:
Table 22. Init function versions

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Parameters</th>
<th>Result type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GFLIB_DRampInit_F16</td>
<td>frac16_t</td>
<td>GFLIB_DRAMP_T_F16*</td>
<td>void</td>
<td>Input argument is a 16-bit fractional value that represents the initialization value. The parameters' structure is pointed to by a pointer. The input data value is in the range &lt;-1 ; 1).</td>
</tr>
<tr>
<td>GFLIB_DRampInit_F32</td>
<td>frac32_t</td>
<td>GFLIB_DRAMP_T_F32*</td>
<td>void</td>
<td>Input argument is a 32-bit fractional value that represents the initialization value. The parameters' structure is pointed to by a pointer. The input data value is in the range &lt;-1 ; 1).</td>
</tr>
<tr>
<td>GFLIB_DRampInit_FLT</td>
<td>float_t</td>
<td>GFLIB_DRAMP_T_FLT*</td>
<td>void</td>
<td>Input argument is a 32-bit single precision floating-point value that represents the initialization value. The parameters' structure is pointed to by a pointer. The input value is within the full 32-bit single-point floating-point range.</td>
</tr>
</tbody>
</table>

The available versions of the GFLIB_DRamp function are shown in the following table:

Table 23. Function versions

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Parameters</th>
<th>Result type</th>
</tr>
</thead>
<tbody>
<tr>
<td>GFLIB_DRamp_F16</td>
<td>frac16_t</td>
<td>frac16_t</td>
<td>void</td>
</tr>
<tr>
<td>GFLIB_DRamp_F32</td>
<td>frac32_t</td>
<td>frac32_t</td>
<td>void</td>
</tr>
<tr>
<td>GFLIB_DRamp_FLT</td>
<td>float_t</td>
<td>float_t</td>
<td>void</td>
</tr>
</tbody>
</table>

The available versions of the GFLIB_DRamp function are shown in the following table:

2.18.2 GFLIB_DRAMP_T_F16

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>f16State</td>
<td>frac16_t</td>
<td>Actual value - controlled by the algorithm.</td>
</tr>
<tr>
<td>f16RampUp</td>
<td>frac16_t</td>
<td>Value of non-saturation ramp-up increment. The data value is in the range &lt;0 ; 1). Set by the user.</td>
</tr>
</tbody>
</table>

Table continues on the next page...
Table continued from the previous page...

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>f16RampDown</td>
<td>frac16_t</td>
<td>Value of non-saturation ramp-down increment. The data value is in the range &lt;0 ; 1). Set by the user.</td>
</tr>
<tr>
<td>f16RampUpSat</td>
<td>frac16_t</td>
<td>Value of saturation ramp-up increment. The data value is in the range &lt;0 ; 1). Set by the user.</td>
</tr>
<tr>
<td>f16RampDownSat</td>
<td>frac16_t</td>
<td>Value of saturation ramp-down increment. The data value is in the range &lt;0 ; 1). Set by the user.</td>
</tr>
<tr>
<td>bReachFlag</td>
<td>bool_t</td>
<td>If the actual state value reaches the target value, this flag is set, otherwise, it is cleared. Set by the algorithm.</td>
</tr>
</tbody>
</table>

2.18.3  GFLIB_DRAMP_T_F32

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>f32State</td>
<td>frac32_t</td>
<td>Actual value - controlled by the algorithm.</td>
</tr>
<tr>
<td>f32RampUp</td>
<td>frac32_t</td>
<td>Value of non-saturation ramp-up increment. The data value is in the range &lt;0 ; 1). Set by the user.</td>
</tr>
<tr>
<td>f32RampDown</td>
<td>frac32_t</td>
<td>Value of non-saturation ramp-down increment. The data value is in the range &lt;0 ; 1). Set by the user.</td>
</tr>
<tr>
<td>f32RampUpSat</td>
<td>frac32_t</td>
<td>Value of saturation ramp-up increment. The data value is in the range &lt;0 ; 1). Set by the user.</td>
</tr>
<tr>
<td>f32RampDownSat</td>
<td>frac32_t</td>
<td>Value of saturation ramp-down increment. The data value is in the range &lt;0 ; 1). Set by the user.</td>
</tr>
<tr>
<td>bReachFlag</td>
<td>bool_t</td>
<td>If the actual state value reaches the target value, this flag is set, otherwise, it is cleared. Set by the algorithm.</td>
</tr>
</tbody>
</table>

2.18.4  GFLIB_DRAMP_T_FLT

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>fltState</td>
<td>float_t</td>
<td>Actual value - controlled by the algorithm.</td>
</tr>
<tr>
<td>fltRampUp</td>
<td>float_t</td>
<td>Value of non-saturation ramp-up increment. The data value is within the full 32-bit single precision floating point. Set by the user as non-negative value.</td>
</tr>
<tr>
<td>fltRampDown</td>
<td>float_t</td>
<td>Value of non-saturation ramp-down increment. The data value is within the full 32-bit single precision floating point. Set by the user as non-negative value.</td>
</tr>
<tr>
<td>fltRampUpSat</td>
<td>float_t</td>
<td>Value of saturation ramp-up increment. The data value is within the full 32-bit single precision floating point. Set by the user as non-negative value.</td>
</tr>
<tr>
<td>fltRampDownSat</td>
<td>float_t</td>
<td>Value of saturation ramp-down increment. The data value is within the full 32-bit single precision floating point. Set by the user as non-negative value.</td>
</tr>
<tr>
<td>bReachFlag</td>
<td>bool_t</td>
<td>If the actual state value reaches the target value, this flag is set, otherwise, it is cleared. Set by the algorithm.</td>
</tr>
</tbody>
</table>
2.18.5 Declaration

The available GFLIB_DRampInit functions have the following declarations:

```c
void GFLIB_DRampInit_F16(frac16_t f16InitVal, GFLIB_DRAMP_T_F16 *psParam)
void GFLIB_DRampInit_F32(frac32_t f32InitVal, GFLIB_DRAMP_T_F32 *psParam)
void GFLIB_DRampInit_FLT(float_t fltInitVal, GFLIB_DRAMP_T_FLT *psParam)
```

The available GFLIB_DRamp functions have the following declarations:

```c
frac16_t GFLIB_DRamp_F16(frac16_t f16Target, frac16_t f16Instant, const bool_t *pbStopFlag, GFLIB_DRAMP_T_F16 *psParam)
frac32_t GFLIB_DRamp_F32(frac32_t f32Target, frac32_t f32Instant, const bool_t *pbStopFlag, GFLIB_DRAMP_T_F32 *psParam)
float_t GFLIB_DRamp_FLT(float_t fltTarget, float_t fltInstant, const bool_t *pbStopFlag, GFLIB_DRAMP_T_FLT *psParam)
```

2.18.6 Function use

The use of the GFLIB_DRampInit and GFLIB_DRamp functions is shown in the following examples:

```c
#include "gflib.h"

static frac16_t f16InitVal, f16Target, f16Instant, f16Result;
static GFLIB_DRAMP_T_F16 sParam;
static bool_t bStopFlag;

void Isr(void);

void main(void)
{
    sParam.f16RampUp = FRAC16(0.05);
    sParam.f16RampDown = FRAC16(0.02);
    sParam.f16RampUpSat = FRAC16(0.025);
    sParam.f16RampDownSat = FRAC16(0.01);
    f16Target = FRAC16(0.7);
    f16InitVal = FRAC16(0.3);
    f16Instant = FRAC16(0.6);
    bStopFlag = FALSE;

    GFLIB_DRampInit_F16(f16InitVal, &sParam);
}

/* periodically called function */
void Isr()
{
    f16Result = GFLIB_DRamp_F16(f16Target, f16Instant, &bStopFlag, &sParam);
}
```
2.19 GFLIB_FlexRamp

The GFLIB_FlexRamp function calculates the up/down ramp with a fixed-step increment that is calculated according to the required speed change per a defined duration. These parameters must be set by the user.

The GFLIB_FlexRamp algorithm consists of three functions that must be used for a proper functionality of the algorithm:

- GFLIB_FlexRampInit - this function initializes the state variable with a defined value and clears the reach flag
- GFLIB_FlexRampCalcIncr - this function calculates the increment and clears the reach flag
- GFLIB_FlexRamp - this function calculates the ramp in the periodically called loop

For a proper use, it is recommended to initialize the algorithm by the GFLIB_FlexRampInit function. The GFLIB_FlexRampInit function initializes the internal state variable of the algorithm with a defined value and clears the reach flag. Call the init function when you want to initialize the ramp.

To calculate the increment, use the GFLIB_FlexRampCalcIncr function. This function is called at the point when you want to change the ramp output value. This function's inputs are the target value and duration. The target value is the destination value that you want to get to. The duration is the time required to change the ramp output from the actual state to the target value. To be able to calculate the ramp increment, fill the control structure with the sample time, that means the period of the loop where the GFLIB_FlexRamp function is called. The structure also contains a variable which determines the maximum value of the increment. It is necessary to set it up too. The equation for the increment calculation is as follows:

\[ I = \frac{V_t - V_i}{T_i \cdot T_s} \]

Figure 52.
where:

- \( I \) is the increment
- \( V_t \) is the target value
- \( V_s \) is the state (actual) value (in the structure)
- \( T \) is the duration of the ramp (to reach the target value starting at the state value)
- \( T_s \) is the sample time, that means the period of the loop where the ramp algorithm is called (set in the structure)

If the increment is greater than the maximum increment (set in the structure), the increment uses the maximum increment value.

As soon as the new increment is calculated, call the GFLIB_FlexRamp algorithm in the periodical control loop. The function works as follows: The function adds the increment to the state value (from the previous step), which results in a new state. The new state is returned by the function. As the time passes, the algorithm is approaching the target value. If the new state trespasses the target value, that new state is limited to the target value and the reach flag is set. The functionality of the implemented algorithm is shown in this figure:

![GFLIB_FlexRamp functionality](image)

**Figure 53. GFLIB_FlexRamp functionality**

### 2.19.1 Available versions

This function is available in the following versions:

- Fractional output - the output is the fractional portion of the result; the result is within the range \((-1; 1)\). The input parameters are the fractional and accumulator types.
- Floating-point output - the output is the floating-point result within the type's full range.

The available versions of the GFLIB_FlexRampInit function are shown in the following table:
Table 24. Init function versions

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Parameters</th>
<th>Result type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GFLIB_FlexRampInit_F16</td>
<td>frac16_t</td>
<td>GFLIB_FLEXRAMP_T_F32*</td>
<td>void</td>
<td>The input argument is a 16-bit fractional value that represents the initialization value. The parameters' structure is pointed to by a pointer. The input data value is in the range &lt;-1 ; 1).</td>
</tr>
<tr>
<td>GFLIB_FlexRampInit_FLT</td>
<td>float_t</td>
<td>GFLIB_FLEXRAMP_T_FLT*</td>
<td>void</td>
<td>The input argument is a 32-bit single precision floating-point value that represents the initialization value. The parameters' structure is pointed to by a pointer. The input value is within the full 32-bit single-point floating-point range.</td>
</tr>
</tbody>
</table>

The available versions of the GFLIB_FlexRamp function are shown in the following table:

Table 25. Increment calculation function versions

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Parameters</th>
<th>Result type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GFLIB_FlexRampCalcIncr_F16</td>
<td>frac16_t</td>
<td>acc32_t, GFLIB_FLEXRAMP_T_F32*</td>
<td>void</td>
<td>The input arguments are a 16-bit fractional value in the range &lt;-1 ; 1) that represents the target output value and a 32-bit accumulator value in the range (0 ; 65536.0) that represents the duration of the ramp (in seconds) to reach the target value. The parameters' structure is pointed to by a pointer.</td>
</tr>
<tr>
<td>GFLIB_FlexRampCalcIncr_FLT</td>
<td>float_t</td>
<td>float_t, GFLIB_FLEXRAMP_T_FLT*</td>
<td>void</td>
<td>The input arguments are 32-bit single precision floating-point values that represent the target output value and the duration of the ramp (in seconds, except zero value) to reach the target value. The parameters' structure is pointed to by a pointer. The target argument is within the full range; the duration argument is a non-negative value.</td>
</tr>
</tbody>
</table>

Table 26. Function versions

<table>
<thead>
<tr>
<th>Function name</th>
<th>Parameters</th>
<th>Result type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GFLIB_FlexRamp_F16</td>
<td>GFLIB_FLEXRAMP_T_F32*</td>
<td>frac16_t</td>
<td>The parameters' structure is pointed to by a pointer. The function returns a 16-bit fractional value, which represents the actual ramp output value. The output data value is in the range &lt;-1 ; 1).</td>
</tr>
<tr>
<td>GFLIB_FlexRamp_FLT</td>
<td>GFLIB_FLEXRAMP_T_FLT*</td>
<td>float_t</td>
<td>The parameters' structure is pointed to by a pointer. The function returns a 32-bit single precision floating-point value, which represents the actual ramp output value. The output value is within the full 32-bit single-point floating-point range.</td>
</tr>
</tbody>
</table>
2.19.2 GFLIB_FLEXRAMP_T_F32

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>f32State</td>
<td>frac32_t</td>
<td>The actual value. Controlled by the GFLIB_FlexRampInit_F16 and GFLIB_FlexRamp_F16 algorithms.</td>
</tr>
<tr>
<td>f32Incr</td>
<td>frac32_t</td>
<td>The value of the flex ramp increment. Controlled by the GFLIB_FlexRampCalcIncr_F16 algorithm.</td>
</tr>
<tr>
<td>f32Target</td>
<td>frac32_t</td>
<td>The target value of the flex ramp algorithm. Controlled by the GFLIB_FlexRampCalcIncr_F16 algorithm.</td>
</tr>
<tr>
<td>f32Ts</td>
<td>frac32_t</td>
<td>The sample time, that means the period of the loop where the GFLIB_FlexRamp_F16 algorithms are periodically called. The data value (in seconds) is in the range (0 ; 1). Set by the user.</td>
</tr>
<tr>
<td>f32IncrMax</td>
<td>frac32_t</td>
<td>The maximum value of the flex ramp increment. The data value is in the range (0 ; 1). Set by the user.</td>
</tr>
<tr>
<td>bReachFlag</td>
<td>bool_t</td>
<td>The reach flag. This flag is controlled by the GFLIB_FlexRamp_F16 algorithm. It is cleared by the GFLIB_FlexRampInit_F16 and GFLIB_FlexRampCalcIncr_F16 algorithms.</td>
</tr>
</tbody>
</table>

2.19.3 GFLIB_FLEXRAMP_T_FLT

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>fltState</td>
<td>float_t</td>
<td>The actual value. Controlled by the GFLIB_FlexRampInit_FLT and GFLIB_FlexRamp_FLT algorithms.</td>
</tr>
<tr>
<td>fltIncr</td>
<td>float_t</td>
<td>The value of the flex ramp increment. Controlled by the GFLIB_FlexRampCalcIncr_FLT algorithm.</td>
</tr>
<tr>
<td>fltTarget</td>
<td>float_t</td>
<td>The target value of the flex ramp algorithm. Controlled by the GFLIB_FlexRampCalcIncr_FLT algorithm.</td>
</tr>
<tr>
<td>fltTs</td>
<td>float_t</td>
<td>The sample time, that means the period of the loop where the GFLIB_FlexRamp_FLT algorithm is periodically called. The data value (in seconds, except zero value) is a non-negative value. Set by the user.</td>
</tr>
<tr>
<td>fltIncrMax</td>
<td>float_t</td>
<td>The maximum value of the flex ramp increment. The data is a positive value. Set by the user.</td>
</tr>
<tr>
<td>bReachFlag</td>
<td>bool_t</td>
<td>The reach flag. This flag is controlled by the GFLIB_FlexRamp_FLT algorithm. It is cleared by the GFLIB_FlexRampInit_FLT and GFLIB_FlexRampCalcIncr_FLT algorithms.</td>
</tr>
</tbody>
</table>

2.19.4 Declaration

The available GFLIB_FlexRampInit functions have the following declarations:

```c
void GFLIB_FlexRampInit_F16(frac16_t f16InitVal, GFLIB_FLEXRAMP_T_F32 *psParam)
void GFLIB_FlexRampInit_FLT(float_t fltInitVal, GFLIB_FLEXRAMP_T_FLT *psParam)
```

The available GFLIB_FlexRampCalcIncr functions have the following declarations:

```c
void GFLIB_FlexRampCalcIncr_F16(frac16_t f16Target, acc32_t a32Duration,
```
The available **GFLIB_FlexRamp** functions have the following declarations:

```c
frac16_t GFLIB_FlexRamp_F16(GFLIB_FLEXRAMP_T_F32 *psParam)
float_t GFLIB_FlexRamp_FLT(GFLIB_FLEXRAMP_T_FLT *psParam)
```

### 2.19.5 Function use

The use of the `GFLIB_FlexRampInit`, `GFLIB_FlexRampCalcIncr`, and `GFLIB_FlexRamp` functions is shown in the following examples:

**Fixed-point version:**

```c
#include "gflib.h"

static frac16_t f16InitVal;
static GFLIB_FLEXRAMP_T_F32 sFlexRamp;
static frac16_t f16Target, f16RampResult;
static acc32_t a32RampDuration;

void Isr(void);

void main(void)
{
    /* Control loop period is 0.002 s; maximum increment value is 0.15 */
    sFlexRamp.f32Ts = FRAC32(0.002);
    sFlexRamp.f32IncrMax = FRAC32(0.15);

    /* Initial value to 0 */
    f16InitVal = FRAC16(0.0);

    /* Flex ramp initialization */
    GFLIB_FlexRampInit_F16(f16InitVal, &sFlexRamp);

    /* Target value is 0.7 in duration of 5.3 s */
    f16Target = FRAC16(0.7);
    a32RampDuration = ACC32(5.3);

    /* Flex ramp increment calculation */
    GFLIB_FlexRampCalcIncr_F16(f16Target, a32RampDuration, &sFlexRamp);
}
/* periodically called control loop with a period of 2 ms */
void Isr()
{
    f16RampResult = GFLIB_FlexRamp_F16(&sFlexRamp);
}
```
Floating-point version:

```c
#include "gflib.h"

static float_t fltInitVal;
static GFLIB_FLEXRAMP_T_FLT sFlexRamp;
static float_t fltTarget, fltRampResult;
static float_t fltRampDuration;

void Isr(void);
void main(void)
{
    /* Control loop period is 0.002 s; maximum increment value is 0.15 */
    sFlexRamp.flTs = 0.002F;
    sFlexRamp.fltIncrMax = 0.15F;

    /* Initial value to 0 */
    fltInitVal = 0.0F;

    /* Flex ramp initialization */
    GFLIB_FlexRampInit_FLT(fltInitVal, &sFlexRamp);

    /* Target value is 0.7 in duration of 5.3 s */
    fltTarget = 0.7F;
    fltRampDuration = 5.3F;

    /* Flex ramp increment calculation */
    GFLIB_FlexRampCalcIncr_FLT(fltTarget, fltRampDuration, &sFlexRamp);
}

/* periodically called control loop */
void Isr()
{
    fltRampResult = GFLIB_FlexRamp_FLT(&sFlexRamp);
}
```

2.20 GFLIB_DFlexRamp

The GFLIB_DFlexRamp function calculates the up/down ramp with a fixed-step increment that is calculated according to the required speed change per a defined duration. These parameters must be set by the user. The algorithm has stop flags. If none of them is set, the ramp behaves normally. If one of them is set, the ramp can run in the opposite direction.

The GFLIB_DFlexRamp algorithm consists of three functions that must be used for a proper functionality of the algorithm:

- GFLIB_DFlexRampInit - this function initializes the state variable with a defined value and clears the reach flag
- GFLIB_DFlexRampCalcIncr - this function calculates the increment and clears the reach flag
- GFLIB_DFlexRamp - this function calculates the ramp in the periodically called loop

For a proper use, initialize the algorithm by the GFLIB_DFlexRampInit function. The GFLIB_DFlexRampInit function initializes the internal state variable of the algorithm with a defined value and clears the reach flag. Call the init function when you want to initialize the ramp.

To calculate the increment, use the GFLIB_DFlexRampCalcIncr function. Call this function when you want to change the ramp output value. This function's inputs are the target value and duration, and the ramp increments for motoring and generating saturation modes. The target value is the destination value that you want to get to. The duration is the time required to change
the ramp output from the actual state to the target value. To calculate the ramp increment, fill the control structure with the sample time, that means the period of the loop where the **GFLIB_DFlexRamp** function is called. The structure also contains a variable which determines the maximum value of the increment. It is necessary to set it up too. The equation for the increment calculation is as follows:

\[ I = \frac{V_t - V_s}{T_s} \cdot T_s \]

where:
- \( I \) is the increment
- \( V_t \) is the target value
- \( V_s \) is the state (actual) value (in the structure)
- \( T \) is the duration of the ramp (to reach the target value starting at the state value)
- \( T_s \) is the sample time, that means the period of the loop where the ramp algorithm is called (set in the structure)

If the increment is greater than the maximum increment (set in the structure), the increment uses the maximum increment value.

The state, target, and instant values must have the same sign, otherwise the saturation modes don’t work properly.

As soon as the new increment is calculated, you can call the **GFLIB_DFlexRamp** algorithm in the periodical control loop. If none of the stop flags is set, the function works as follows: The function adds the increment to the state value (from the previous step), which results in a new state. The new state is returned by the function. As time passes, the algorithm is approaching the target value. If the new state trespasses the target value that new state is limited to, the target value and the reach flag are set. The functionality of the implemented algorithm is shown in the following figure:

If the motoring mode stop flag is set and the absolute value of the target value is greater than the absolute value of the state value, the function uses the increment for the motoring saturation mode to return to the instant value. Use case: when the application is
in the saturation mode and cannot supply more power to increase the speed, then a saturation (motoring mode) flag is generated. To get out of the saturation, the ramp output value is being reduced.

If the generating mode stop flag is set and the absolute value of the target value is lower than the absolute value of the state value, the function uses the increment for the generating saturation mode to return to the instant value. Use case: when the application is braking a motor and voltage increases on the DC-bus capacitor, then a saturation (generating mode) flag is generated. To avoid trespassing the DC-bus safe voltage limit, the speed requirement is increasing to dissipate the energy of the capacitor.

### 2.20.1 Available versions

This function is available in the following versions:

- Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The input parameters are the fractional and accumulator types.

The available versions of the GFLIB_DFlexRampInit functions are shown in the following table:

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Parameters</th>
<th>Result type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GFLIB_FlexRampInit_F16</td>
<td>frac16_t</td>
<td>GFLIB_DFLEXRAMP_T_F32*</td>
<td>void</td>
<td>The input argument is a 16-bit fractional value that represents the initialization value. The parameters' structure is pointed to by a pointer. The input data value is in the range &lt;-1 ; 1).</td>
</tr>
<tr>
<td>GFLIB_FlexRampInitFLT</td>
<td>float_t</td>
<td>GFLIB_DFLEXRAMP_TFLT*</td>
<td>void</td>
<td>The input argument is a 32-bit single precision floating-point value that represents the initialization value. The parameters' structure is pointed to by a pointer. The input value is within the full 32-bit single-point floating-point range.</td>
</tr>
</tbody>
</table>

The available versions of the GFLIB_DFlexRamp functions are shown in the following table:

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Parameters</th>
<th>Result type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GFLIB_DFlexRampCalcIncr_F16</td>
<td>frac16_t</td>
<td>acc32_t frac32_t frac32_t</td>
<td>void</td>
<td>The input arguments are 16-bit fractional values in the range &lt;-1 ; 1) that represent the target output value and a 32-bit accumulator value in the range (0 ; 65536.0) that represents the duration (in seconds) of the ramp to reach the target value. The other two arguments are increments for the saturation mode when in the motoring and generating modes. The parameters' structure is pointed to by a pointer.</td>
</tr>
<tr>
<td>GFLIB_DFlexRampCalcIncrFLT</td>
<td>float_t</td>
<td>float_t float_t float_t</td>
<td>void</td>
<td>The input arguments are 32-bit single precision floating-point values that represent the target output value and the duration of the ramp (in seconds, except zero value) to reach the target value. The other two arguments are increments for the saturation mode when in the motoring and generating modes. The parameters' structure is pointed to by a pointer. The target argument is within the full range; the duration argument is a non-negative value.</td>
</tr>
</tbody>
</table>
Table 29. Function versions

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Parameters</th>
<th>Result type</th>
</tr>
</thead>
<tbody>
<tr>
<td>GFLIB_DFlexRamp_F16</td>
<td>frac16_t bool_t* bool_t*</td>
<td>GFLIB_DFLEXRAMP_T_F32*</td>
<td>frac16_t</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The input argument is a 16-bit fractional value in the range <-1 ; 1) that represents the measured instant value. The stop flags are pointers to the bool_t types. The parameters' structure is pointed to by a pointer. The function returns a 16-bit fractional value, which represents the actual ramp output value. The output data value is in the range <-1 ; 1).

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Parameters</th>
<th>Result type</th>
</tr>
</thead>
<tbody>
<tr>
<td>GFLIB_DFlexRamp_FLT</td>
<td>float_t bool_t* bool_t*</td>
<td>GFLIB_DFLEXRAMP_T_FLT*</td>
<td>float_t</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The input arguments are 32-bit single precision floating-point values that represent the measured instant value. The stop flags are pointers to bool_t types. The parameters' structure is pointed to by a pointer. The function returns a 32-bit single precision floating-point value, which represents the actual ramp output value. The output value is within the full 32-bit single-point floating-point range.

2.20.2 GFLIB_DFLEXRAMP_T_F32

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>f32State</td>
<td>frac32_t</td>
<td>The actual value. Controlled by the GFLIB_FlexRampInit_F16 and GFLIB_FlexRamp_F16 algorithms.</td>
</tr>
<tr>
<td>f32Incr</td>
<td>frac32_t</td>
<td>The value of the dyn. flex ramp increment. Controlled by the GFLIB_FlexRampCalcIncr_F16 algorithm.</td>
</tr>
<tr>
<td>f32IncrSatMot</td>
<td>frac32_t</td>
<td>The value of the dyn. flex ramp increment when in the motoring saturation mode. Controlled by the GFLIB_DFlexRampCalcIncr_F16 algorithm.</td>
</tr>
<tr>
<td>f32IncrSatGen</td>
<td>frac32_t</td>
<td>The value of the dyn. flex ramp increment when in the generating saturation mode. Controlled by the GFLIB_DFlexRampCalcIncr_F16 algorithm.</td>
</tr>
<tr>
<td>f32Target</td>
<td>frac32_t</td>
<td>The target value of the flex ramp algorithm. Controlled by the GFLIB_DFlexRampCalcIncr_F16 algorithm.</td>
</tr>
<tr>
<td>f32Ts</td>
<td>frac32_t</td>
<td>The sample time, that means the period of the loop where the GFLIB_DFlexRamp_F16 algorithm is periodically called. The data value (in seconds) is in the range (0 ; 1). Set by the user.</td>
</tr>
<tr>
<td>f32IncrMax</td>
<td>frac32_t</td>
<td>The maximum value of the flex ramp increment. The data value is in the range (0 ; 1). Set by the user.</td>
</tr>
<tr>
<td>bReachFlag</td>
<td>bool_t</td>
<td>Reach flag. This flag is controlled by the GFLIB_DFlexRamp_F16 algorithm. It is cleared by the GFLIB_DFlexRampInit_F16 and GFLIB_DFlexRampCalcIncr_F16 algorithms.</td>
</tr>
</tbody>
</table>

2.20.3 GFLIB_DFLEXRAMP_T_FLT

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>fltState</td>
<td>float_t</td>
<td>The actual value. Controlled by the GFLIB_DFlexRampInit_FLT and GFLIB_DFlexRamp_FLT algorithms.</td>
</tr>
</tbody>
</table>

*Table continues on the next page...*
Table continued from the previous page...

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>fltIncr</td>
<td>float_t</td>
<td>The value of the flex ramp increment. Controlled by the GFLIB_DFlexRampCalcIncr_FLT algorithm.</td>
</tr>
<tr>
<td>fltIncrSatMot</td>
<td>float_t</td>
<td>The value of the dyn. flex ramp increment when in the motoring saturation mode. Controlled by the GFLIB_DFlexRampCalcIncr_FLT algorithm.</td>
</tr>
<tr>
<td>fltIncrSatGen</td>
<td>float_t</td>
<td>The value of the dyn. flex ramp increment when in the generating saturation mode. Controlled by the GFLIB_DFlexRampCalcIncr_FLT algorithm.</td>
</tr>
<tr>
<td>fltTarget</td>
<td>float_t</td>
<td>The target value of the flex ramp algorithm. Controlled by the GFLIB_DFlexRampCalcIncr_FLT algorithm.</td>
</tr>
<tr>
<td>fltTs</td>
<td>float_t</td>
<td>The sample time, that means the period of the loop where the GFLIB_DFlexRamp_FLT algorithm is periodically called. The data value (in seconds, except zero value) is a non-negative value. Set by the user.</td>
</tr>
<tr>
<td>fltIncrMax</td>
<td>float_t</td>
<td>The maximum value of the flex ramp increment. The data is a positive value. Set by the user.</td>
</tr>
<tr>
<td>bReachFlag</td>
<td>bool_t</td>
<td>The reach flag. This flag is controlled by the GFLIB_DFlexRampCalcIncr_FLT algorithm. It is cleared by the GFLIB_DFlexRampInit_FLT and GFLIB_DFlexRampCalcIncr_FLT algorithms.</td>
</tr>
</tbody>
</table>

### 2.20.4 Declaration

The available GFLIB_DFlexRampInit functions have the following declarations:

```c
void GFLIB_DFlexRampInit_F16(frac16_t f16InitVal, GFLIB_DFLEXRAMP_T_F32 *psParam)
void GFLIB_DFlexRampInit_FLT(float_t fltInitVal, GFLIB_DFLEXRAMP_T_FLT *psParam)
```

The available GFLIB_DFlexRampCalcIncr functions have the following declarations:

```c
void GFLIB_DFlexRampCalcIncr_F16(frac16_t f16Target, acc32_t a32Duration, frac32_t f32IncrSatMot, frac32_t f32IncrSatGen, GFLIB_DFLEXRAMP_T_F32 *psParam)
void GFLIB_DFlexRampCalcIncr_FLT(float_t fltTarget, float_t fltDuration, float_t f32IncrSatMot, float_t f32IncrSatGen, GFLIB_DFLEXRAMP_T_FLT *psParam)
```

The available GFLIB_DFlexRamp functions have the following declarations:

```c
frac16_t GFLIB_DFlexRamp_F16(frac16_t f16Instant, const bool_t *pbStopFlagMot, const bool_t *pbStopFlagGen, GFLIB_DFLEXRAMP_T_F32 *psParam)
float_t GFLIB_DFlexRamp_FLT(float_t fltInstant, const bool_t *pbStopFlagMot, const bool_t *pbStopFlagGen, GFLIB_DFLEXRAMP_T_FLT *psParam)
```

### 2.20.5 Function use

The use of the GFLIB_DFlexRampInit, GFLIB_DFlexRampCalcIncr, and GFLIB_DFlexRamp functions is shown in the following examples:
Fixed-point version:

```c
#include "gflib.h"

static frac16_t f16InitVal;
static GFLIB_DFLEXRAMP_T_F32 sDFlexRamp;
static frac16_t f16Target, f16RampResult, f16Instant;
static acc32_t a32RampDuration;
static frac32_t f32IncrSatMotMode, f32IncrSatGenMode;
static bool_t bSatMot, bSatGen;

void Isr(void);

void main(void)
{
    /* Control loop period is 0.002 s; maximum increment value is 0.15 */
    sDFlexRamp.f32Ts = FRAC32(0.002);
    sDFlexRamp.f32IncrMax = FRAC32(0.15);

    /* Initial value to 0 */
    f16InitVal = FRAC16(0.0);

    /* Dyn. flex ramp initialization */
    GFLIB_FlexRampInit_F16(f16InitVal, &sDFlexRamp);

    /* Target value is 0.7 in duration of 5.3 s */
    f16Target = FRAC16(0.7);
    a32RampDuration = ACC32(5.3);

    /* Saturation increments */
    f32IncrSatMotMode = FRAC32(0.000015);
    f32IncrSatGenMode = FRAC32(0.00002);

    /* Saturation flags init */
    bSatMot = FALSE;
    bSatGen = FALSE;

    /* Dyn. flex ramp increment calculation */
    GFLIB_DFlexRampCalcIncr_F16(f16Target, a32RampDuration, f32IncrSatMotMode, f32IncrSatGenMode, &sDFlexRamp);
}

/* periodically called control loop with a period of 2 ms */
void Isr()
{
    f16RampResult = GFLIB_DFlexRamp_F16(f16Instant, &bSatMot, &bSatGen, &sDFlexRamp);
}
```

Floating-point version:

```c
#include "gflib.h"

static float_t fltInitVal;
static GFLIB_DFLEXRAMP_T_FLT sDFlexRamp;
static float_t fltTarget, fltRampResult, fltInstant;
static float_t fltRampDuration;

void Isr(void);

void main(void)
{
    /* Control loop period is 0.002 s; maximum increment value is 0.15 */
    sDFlexRamp.f32Ts = FRAC32(0.002);
    sDFlexRamp.f32IncrMax = FRAC32(0.15);

    /* Initial value to 0 */
    f16InitVal = FRAC16(0.0);

    /* Dyn. flex ramp initialization */
    GFLIB_FlexRampInit_F16(f16InitVal, &sDFlexRamp);

    /* Target value is 0.7 in duration of 5.3 s */
    f16Target = FRAC16(0.7);
    a32RampDuration = ACC32(5.3);

    /* Saturation increments */
    f32IncrSatMotMode = FRAC32(0.000015);
    f32IncrSatGenMode = FRAC32(0.00002);

    /* Saturation flags init */
    bSatMot = FALSE;
    bSatGen = FALSE;

    /* Dyn. flex ramp increment calculation */
    GFLIB_DFlexRampCalcIncr_F16(f16Target, a32RampDuration, f32IncrSatMotMode, f32IncrSatGenMode, &sDFlexRamp);
}
```

GFLIB User's Guide, Rev. 5, 01 November 2021
static float_t fltIncrSatMotMode, fltIncrSatGenMode;
static bool_t bSatMot, bSatGen;

void Isr(void);
void main(void)
{
    /* Control loop period is 0.002 s; maximum increment value is 0.15 */
    sDFlexRamp.fltTs = 0.002F;
    sDFlexRamp.fltIncrMax = 0.15F;

    /* Initial value to 0 */
    fltInitVal = 0.0F;

    /* Dyn. flex ramp initialization */
    GFLIB_DFlexRampInit_FLT(fltInitVal, &sDFlexRamp);

    /* Target value is 0.7 in duration of 5.3 s */
    fltTarget = 0.7F;
    fltRampDuration = 5.3F;

    /* Saturation increments */
    fltIncrSatMotMode = 0.000015F;
    fltIncrSatGenMode = 0.00002F;

    /* Saturation flags init */
    bSatMot = FALSE;
    bSatGen = FALSE;

    /* Dyn. flex ramp increment calculation */
    GFLIB_DFlexRampCalcIncr_FLT(fltTarget, fltRampDuration, fltIncrSatMotMode,
                               fltIncrSatGenMode, &sDFlexRamp);
}

/* periodically called control loop with a period of 2 ms */
void Isr()
{
    fltRampResult = GFLIB_DFlexRamp_FLT(fltInstant, &bSatMot, &bSatGen, &sDFlexRamp);
}

2.21 GFLIB_FlexSRamp

The GFLIB_FlexSRamp function calculates the up/down ramp with a variable increment that is calculated according to the required speed change per a defined duration. These parameters must be set by the user. The variable increment is profiled to reach the S-profile of the resulting ramp.

The GFLIB_FlexSRamp algorithm consists of three functions that must be used for a proper functionality of the algorithm:

- **GFLIB_FlexSRampInit** - this function initializes the state variable with a defined value, resets the acceleration increment to zero, sets the acceleration state to zero, and clears the reach flag

- **GFLIB_FlexSRampCalcIncr** - this function calculates the desired acceleration, two points of the speed where the acceleration changes from a variable to a constant and vice-versa, acceleration (derivative) increment, resets the increment to zero, sets the acceleration state to zero, and clears the reach flag

- **GFLIB_FlexSRamp** - this function calculates the ramp in the periodically called loop

For a proper use, initialize the algorithm by the GFLIB_FlexSRampInit function. The GFLIB_FlexSRampInit function initializes the internal state variable of the algorithm with a defined value, resets the acceleration increment to zero, sets the acceleration state
to zero, and clears the reach flag. This function does not affect the other parameters of the ramp. Call the init function to initialize the ramp.

To calculate the profile of the ramp, use the GFLIB_FlexSRampCalcIncr function. This function is called when you want to change the ramp output value. This function’s inputs are the target value and duration. The target value is the destination value that you want to get to. The duration is the time required to change the ramp output from the actual state to the target value. To calculate the ramp increment, fill the control structure with the sample time, that means the period of the loop where the GFLIB_FlexSRamp function is called. Set up the desirable acceleration derivative that is necessary for the acceleration and deceleration states. The structure also contains a variable that determines the maximum value of the increment (acceleration). It is necessary to set it up too. The equations for the ramp calculation are derived from the following figure:

![GFLIB_FlexSRamp profile](image)

Figure 56. GFLIB_FlexSRamp profile

For the ramp output change in each state, these equations apply:

\[ \Delta x_1 = x(T_2) - x(0) \]

Figure 57.

\[ \Delta x_2 = x(T_3) - x(T_1) \]

Figure 58.

\[ \Delta x_3 = \Delta x_1 \]

Figure 59.

where:
- \( x \) is the ramp output
- \( \Delta x_1 \) is the ramp change in state 0
• $Δx_2$ is the ramp change in state 1
• $Δx_3$ is the ramp change in state 2
• $T_1$ is the instant when the desired acceleration is reached and becomes constant
• $T_2$ is the instant when the desired acceleration starts to decrease

To get the full ramp change between the actual state value and the target value, this equation applies:

$$Δx = Δx_1 + Δx_2 + Δx_3 = 2Δx_1 - Δx_2$$

Figure 60.

The value of the desired acceleration that is reached by the integration of the acceleration derivative along the time within state 0 is:

$$a_{des} = a(T_2) = \int_{0}^{T_1} dA \cdot dt = dA \cdot T_1$$

Figure 61.

where:
• $a_{des}$ is the desired acceleration
• $dA$ is the derivative of the acceleration

Similarly, the $Δx_1$ and $Δx_2$ values are given by integrating the acceleration in time:

$$Δx_1 = \int_{0}^{T_1} dA \cdot t \cdot dt = \frac{1}{2}dA \cdot T_1^2$$

Figure 62.

$$Δx_2 = \int_{T_1}^{T_2} a_{des} \cdot dt = a_{des}(T_2 - T_1)$$

Figure 63.

Because the ramp is symmetrical, time $T_2$ is expressed as:

$$T_2 = T - T_1$$

Figure 64.

where:
• $T$ is the duration of the ramp

Using the equations for $a_{des}$ and $T_2$, Equation 7 is rewritten as:

$$Δx_2 = dA \cdot T_1(T - 2T_1)$$

Figure 65.

Putting Equation 9 and Equation 9 into Equation 4, the following equation is reached:
Having normalized the previous equation, a quadrature equation is reached:

\[ \Delta x = 2 \cdot \frac{1}{2} dA \cdot T_1^2 + dA \cdot T_1 (T - 2T_1) = -dA \cdot T_1^2 + dA \cdot T \cdot T_1 \]

Figure 66.

One root of this quadrature equation is \( T_1 \):

\[ T_1^2 - T \cdot T_1 + \frac{\Delta x}{dA} = 0 \]

Figure 67.

Using Equation 5, the desired acceleration is expressed as:

\[ a_{des} = \frac{dA \cdot T - \sqrt{dA^2 \cdot T^2 - 4 \cdot dA \cdot \Delta x}}{2} \]

Figure 68.

This equation has a solution within the range of real numbers only if the square root argument is not negative, so this condition must be met:

\[ dA^2 \cdot T^2 \geq 4 \cdot dA \cdot \Delta x \]

Figure 70.

If this condition is met and the desired acceleration is not greater than the maximum increment (set in the structure), the ramp is achievable within the defined duration and the function's output flag is TRUE. If the acceleration is greater than the maximum increment, the function uses the maximum increment value and then the ramp is not achieved on time, the output flag is FALSE.

If the condition given by Equation 5 is not met, the ramp is not achievable within the defined duration and the function returns the flag FALSE. In such case, the ramp skips state 1 (where the acceleration is constant) and goes directly from state 0 to state 2.

The following figure shows the ramp profile:
This ramp takes longer time than desirable duration. In this case, $\Delta x_j$ is exactly a half of the full ramp change output. The $T_1$ instant is derived from Equation 6 as:

$$T_1 = \sqrt{\frac{2 \cdot \Delta x}{dA}} = \sqrt{\frac{\Delta x}{dA}}$$

Similarly to the previous case (when the ramp is achievable within the desired time), the desired acceleration cannot be greater than the maximum increment, otherwise the function uses the maximum increment value. If the desired acceleration is trimmed, the ramp is in state 1 with a constant acceleration.

In both cases, the desired acceleration could have been reduced to the maximum increment value, therefore it is necessary to adjust the $T_1$ value using Equation 5:

$$T_1 = \frac{a_{des}}{dA}$$

where:

- $a_{des}$ can be changed to the maximum increment
By putting $T_1$ into Equation 6, the $\Delta x_1$ value is given as:

$$\Delta x_1 = \frac{1}{2} \frac{dA}{dA} \frac{\Delta \text{express}}{dA}^2 = \frac{1}{2} \frac{\Delta \text{express}}{dA}^2$$

Figure 75.

Because the ramp output profile is now symmetrical, the ramp output value in time $T_1$ is given by adding (or subtracting) the $\Delta x_1$ value to the state value. Similarly, the ramp output value in time $T_2$ is given by subtracting (or adding) the $\Delta x_1$ value from the target value. These two values are returned within the function structure together with the desired acceleration value.

Another parameter that must be calculated is the acceleration increment. The increment uses the derivative of acceleration $dA$ and the sample time of the application. This must apply:

$$dA = \frac{da}{dt} = \frac{d^2X}{dt^2} \approx \frac{A_{\text{incr}}}{T_s^2}$$

Figure 76.

where:

- $A_{\text{incr}}$ is the acceleration increment
- $T_s$ is the sample time

The acceleration increment needed for the algorithm is:

$$A_{\text{incr}} = T_s^2 \cdot dA$$

Figure 77.

As soon as the necessary parameters are calculated, call the GFLIB_FlexSRamp algorithm in the periodical control loop. The function works in these three states:

- State 0 - acceleration rises from 0 towards the desired acceleration
- State 1 - acceleration is constant
- State 2 - acceleration is falling from the desired acceleration towards zero

In state 0, the function adds the acceleration increment to the increment. In the first step, it only adds half of the acceleration increment (to form the trapezoidal integration). The resulting increment is added to or subtracted from the state value (from the previous step), which results in a new state. The new state is returned by the function. After the $X(T_1)$ value is reached, the function switches to state 1. At the same time, the function checks whether the condition $X(T_2)$ value is reached. In such case, the function goes directly to state 2.

In state 1, the function does not change the increment; it stays constant from the last value in state 0. The increment is added to or subtracted from the state value (from the previous step), which results in a new state. The new state is returned by the function. When the $X(T_2)$ value is reached, the function switches to state 2.

In state 2, the function subtracts the acceleration increment from the increment. The resulting increment is added to or subtracted from the state value (from the previous step), which results in a new state. The new state is returned by the function. If the new state trespasses the target value, it is trimmed to the target value. It can happen that the function output does not reach the target value before the increment returns to zero. If the increment is zero before reaching the target value, the output stops before the target value. This can happen because the function does not work with the continuous time. The incrementation depends on the sampling time and the arithmetic accuracy used. To ensure that the function always reaches the target value, the function checks if the increment is not lower than the half of the acceleration increment. If the resulting increment is lower than half of the acceleration increment, the increment is set to a half of the acceleration increment. Using this approach, the function always reaches the target value. As soon as the target value is reached, the reach flag is set.

The functionality of the implemented algorithm is shown in this figure:
2.21.1 Available versions

This function is available in the following versions:

- Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The input parameters are the fractional and accumulator types.

The available versions of the GFLIB_FlexSRampInit function are shown in the following table:

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Parameters</th>
<th>Result type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GFLIB_FlexSRampInit_F16</td>
<td>frac16_t</td>
<td>GFLIB_FLEXSRAMP_T_F32 *</td>
<td>void</td>
<td>The input argument is a 16-bit fractional value that represents the initialization value. The parameters' structure is pointed to by a pointer. The input data value is in the range &lt;-1 ; 1).</td>
</tr>
<tr>
<td>GFLIB_FlexSRampInitFLT</td>
<td>float_t</td>
<td>GFLIB_FLEXSRAMP_TFLT *</td>
<td>void</td>
<td>The input argument is a 32-bit single precision floating-point value that represents the initialization value. The parameters' structure is pointed to by a pointer. The input value is within the full 32-bit single-point floating-point range.</td>
</tr>
</tbody>
</table>
Table 31. Increment calculation function versions

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Parameters</th>
<th>Result type</th>
</tr>
</thead>
<tbody>
<tr>
<td>GFLIB_FlexSRampCalcIncr_F16</td>
<td>frac16_t</td>
<td>GFLIB_FLEXSRAMP_T_F32 *</td>
<td>bool_t</td>
</tr>
<tr>
<td></td>
<td>acc32_t</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GFLIB_FlexSRampCalcIncrFLT</td>
<td>float_t</td>
<td>GFLIB_FLEXSRAMP_T_FLT *</td>
<td>bool_t</td>
</tr>
<tr>
<td></td>
<td>float_t</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The input arguments are a 16-bit fractional value in the range <-1 ; 1) that represents the target output value and a 32-bit accumulator value in the range (0 ; 1/ f16DA) that represents the duration of the ramp (in seconds) to reach the target value. The parameters’ structure is pointed to by a pointer. The function returns TRUE if the ramp is achievable within the defined duration; if it is not achievable, it returns FALSE. The parameters are calculated, but the ramp takes longer.

Table 32. Function versions

<table>
<thead>
<tr>
<th>Function name</th>
<th>Parameters</th>
<th>Result type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GFLIB_FlexSRamp_F16</td>
<td>GFLIB_FLEXSRAMP_T_F32 *</td>
<td>frac16_t</td>
<td>The parameters’ structure is pointed to by a pointer. The function returns a 16-bit fractional value, which represents the actual ramp output value. The output data value is in the range &lt;-1 ; 1).</td>
</tr>
<tr>
<td>GFLIB_FlexSRamp_FLT</td>
<td>GFLIB_FLEXSRAMP_T_FLT *</td>
<td>float_t</td>
<td>The parameters’ structure is pointed to by a pointer. The function returns a 32-bit single precision floating-point value, which represents the actual ramp output value. The output value is within the full 32-bit single-point floating-point range.</td>
</tr>
</tbody>
</table>

2.21.2 GFLIB_FLEXSRAMP_T_F32

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>f32State</td>
<td>frac32_t</td>
<td>The actual value. Controlled by the GFLIB_FlexSRampInit_F16 and GFLIB_FlexSRamp_F16 algorithms.</td>
</tr>
<tr>
<td>f32Incr</td>
<td>frac32_t</td>
<td>The value of the flex s-ramp increment. Controlled by the GFLIB_FlexSRamp_F16 algorithm. It is reset to zero by the GFLIB_FlexSRampInit_F16 and GFLIB_FlexSRampCalcIncr_F16 algorithms.</td>
</tr>
<tr>
<td>f32AIncr</td>
<td>frac32_t</td>
<td>The value of the flex s-ramp acceleration increment. Controlled by the GFLIB_FlexSRampCalcIncr_F16 algorithm.</td>
</tr>
<tr>
<td>f32ADes</td>
<td>frac32_t</td>
<td>The value of the flex s-ramp desired acceleration. Controlled by the GFLIB_FlexSRampCalcIncr_F16 algorithm.</td>
</tr>
</tbody>
</table>

Table continues on the next page...
### Table continued from the previous page...

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>f32Target</td>
<td>frac32_t</td>
<td>The target value of the flex s-ramp algorithm. Controlled by the GFLIB_FlexSRampCalcIncr_F16 algorithm.</td>
</tr>
<tr>
<td>f32Ts</td>
<td>frac32_t</td>
<td>The sample time, that means the period of the loop where the GFLIB_FlexSRamp_F16 algorithms are periodically called. The data value (in seconds) is in the range (0 ; 1). Set by the user.</td>
</tr>
<tr>
<td>f32IncrMax</td>
<td>frac32_t</td>
<td>The maximum value of the flex s-ramp increment. The data value is in the range (0 ; 1). Set by the user.</td>
</tr>
<tr>
<td>f32XT1</td>
<td>frac32_t</td>
<td>The flex s-ramp value of the point where the increment must stop incrementing. Controlled by the GFLIB_FlexSRampCalcIncr_F16 algorithm.</td>
</tr>
<tr>
<td>f32XT2</td>
<td>frac32_t</td>
<td>The flex s-ramp value of the point where the increment must start decrementing. Controlled by the GFLIB_FlexSRampCalcIncr_F16 algorithm.</td>
</tr>
<tr>
<td>f16DA</td>
<td>frac16_t</td>
<td>The acceleration derivative. The data value (in acceleration change per second or ramp output value change per square second) is in the range &lt;0 ; 0.5). Set by the user.</td>
</tr>
<tr>
<td>u16AccState</td>
<td>uint_16_t</td>
<td>The acceleration state of the function: 0 - acceleration rises; 1 - acceleration is constant; 2 - acceleration falls. Controlled by the GFLIB_FlexSRamp_F16 algorithm. It is reset to zero by the GFLIB_FlexSRampInit_F16 and GFLIB_FlexSRampCalcIncr_F16 algorithms.</td>
</tr>
<tr>
<td>bReachFlag</td>
<td>bool_t</td>
<td>Reach flag. This flag is controlled by the GFLIB_FlexSRamp_F16 algorithm. It is cleared by the GFLIB_FlexSRampInit_F16 and GFLIB_FlexSRampCalcIncr_F16 algorithms.</td>
</tr>
</tbody>
</table>

#### 2.21.3 GFLIB_FLEXSRAMP_TFLT

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>fltState</td>
<td>float_t</td>
<td>The actual value. Controlled by the GFLIB_FlexSRampInitFLT and GFLIB_FlexSRamp_FLT algorithms.</td>
</tr>
<tr>
<td>fltIncr</td>
<td>float_t</td>
<td>The value of the flex s-ramp increment. Controlled by the GFLIB_FlexSRamp_FLT algorithm. It is reset to zero by the GFLIB_FlexSRampInitFLT and GFLIB_FlexSRampCalcIncrFLT algorithms.</td>
</tr>
<tr>
<td>fltIncr</td>
<td>float_t</td>
<td>The value of the flex s-ramp acceleration increment. Controlled by the GFLIB_FlexSRampCalcIncrFLT algorithm.</td>
</tr>
<tr>
<td>fltADes</td>
<td>float_t</td>
<td>The value of the flex s-ramp desired acceleration. Controlled by the GFLIB_FlexSRampCalcIncrFLT algorithm.</td>
</tr>
<tr>
<td>fltTarget</td>
<td>float_t</td>
<td>The target value of the flex s-ramp algorithm. Controlled by the GFLIB_FlexSRampCalcIncrFLT algorithm.</td>
</tr>
<tr>
<td>fltTs</td>
<td>float_t</td>
<td>The sample time, that means the period of the loop where the GFLIB_FlexSRamp_FLT algorithms are periodically called. The data value (in seconds, except zero value) is in the 32-bit single precision floating-point range. Set by the user.</td>
</tr>
<tr>
<td>fltIncrMax</td>
<td>float_t</td>
<td>The maximum value of the flex s-ramp increment. The data value is in the 32-bit single precision floating-point range. Set by the user.</td>
</tr>
</tbody>
</table>

*Table continues on the next page...*
### Table continued from the previous page...

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>fltXT1</td>
<td>float_t</td>
<td>The flex s-ramp value of the point where the increment must stop incrementing. Controlled by the GFLIB_FlexSRampCalcIncr_FLT algorithm.</td>
</tr>
<tr>
<td>fltXT2</td>
<td>float_t</td>
<td>The flex s-ramp value of the point where the increment must start decrementing. Controlled by the GFLIB_FlexSRampCalcIncr_FLT algorithm.</td>
</tr>
<tr>
<td>fltDA</td>
<td>float_t</td>
<td>The acceleration derivative. The data value (in acceleration change per second or ramp output value change per square second) is in the range &lt;0 ; 1). Set by the user.</td>
</tr>
<tr>
<td>u16AccState</td>
<td>uint_16_t</td>
<td>The acceleration state of the function: 0 - acceleration rises; 1 - acceleration is constant; 2 - acceleration falls. Controlled by the GFLIB_FlexSRamp_FLT algorithm. It is reset to zero by the GFLIB_FlexSRampInit_FLT and GFLIB_FlexSRampCalcIncr_FLT algorithms.</td>
</tr>
<tr>
<td>bReachFlag</td>
<td>bool_t</td>
<td>The reach flag. This flag is controlled by the GFLIB_FlexSRamp_FLT algorithm. It is cleared by the GFLIB_FlexSRampInit_FLT and GFLIB_FlexSRampCalcIncr_FLT algorithms.</td>
</tr>
</tbody>
</table>

#### 2.21.4 Declaration

The available GFLIB_FlexSRampInit functions have the following declarations:

```c
void GFLIB_FlexSRampInit_F16(frac16_t f16InitVal, GFLIB_FLEXSRAMP_T_F32 *psParam)
void GFLIB_FlexSRampInit_FLT(float_t fltInitVal, GFLIB_FLEXSRAMP_T_FLT *psParam)
```

The available GFLIB_FlexSRampCalcIncr functions have the following declarations:

```c
bool_t GFLIB_FlexSRampCalcIncr_F16(frac16_t f16Target, acc32_t a32Duration, GFLIB_FLEXSRAMP_T_F32 *psParam)
bool_t GFLIB_FlexSRampCalcIncr_FLT(float_t fltTarget, float_t fltDuration, GFLIB_FLEXSRAMP_T_FLT *psParam)
```

The available GFLIB_FlexSRamp functions have the following declarations:

```c
frac16_t GFLIB_FlexSRamp_F16(GFLIB_FLEXSRAMP_T_F32 *psParam)
float_t GFLIB_FlexSRamp_FLT(GFLIB_FLEXSRAMP_T_FLT *psParam)
```

#### 2.21.5 Function use

The use of the GFLIB_FlexSRampInit, GFLIB_FlexRampSCalcIncr, and GFLIB_FlexSRamp functions is shown in the following examples:

A ramp with a profile as in Figure 56 is generated. The ramp must change the speed from 100 RPM to 900 RPM in 20 s. The speed scale is 5000 RPM. The ramp must change the speed in 20 s. The acceleration derivative is 15 RPM / s\(^2\). The sample time is 0.1 s. The maximum acceleration is 50 RPM / s.

#### Fixed-point version:

```c
#include "gflib.h"

static frac16_t f16InitVal;
static GFLIB_FLEXSRAMP_T_F32 sFlexSRamp;
static frac16_t f16Target, f16RampResult;
```
static acc32_t a32RampDuration;
static bool_t bFlexSRampFlag;

void Isr(void);

void main(void)
{
    /* Control loop period is 0.1 s */
    sFlexSRamp.f32Ts = FRAC32(0.1);

    /* Maximum increment value is 50 RPM / s */
    sFlexSRamp.f32IncrMax = FRAC32(50.0 / 5000.0 * 0.1);

    /* Desired acceleration derivative 15 RPM / s ^ 2 */
    sFlexSRamp.f16DA = FRAC16(15.0 / 5000.0);

    /* Initial value to 100 RPM */
    f16InitVal = FRAC16(100.0 / 5000.0);

    /* Flex ramp initialization */
    GFLIB_FlexSRampInit_F16(f16InitVal, &sFlexSRamp);

    /* Target value is 900 RPM in duration of 20 s */
    f16Target = FRAC16(900.0 / 5000.0);
    a32RampDuration = ACC32(20.0);

    /* Flex s-ramp parameters calculation */
    bFlexSRampFlag = GFLIB_FlexSRampCalcIncr_F16(f16Target, a32RampDuration, &sFlexSRamp);
}

/* periodically called control loop with a period of 100 ms */
void Isr()
{
    f16RampResult = GFLIB_FlexSRamp_F16(&sFlexSRamp);
}

Floating-point version:

#include "gflib.h"

static float_t fltInitVal;
static GFLIB_FLEXSRAMP_T_FLT sFlexSRamp;
static float_t fltTarget, fltRampResult;
static float_t fltRampDuration;
static bool_t bFlexSRampFlag;

void Isr(void);

void main(void)
{
    /* Control loop period is 0.1 s */
    sFlexSRamp.fltTs = 0.1F;

    /* Maximum increment value is 50 RPM / s (50 * 0.1) */
    sFlexSRamp.fltIncrMax = 5.0f;

    /* Desired acceleration derivative 15 RPM / s ^ 2 */

2.22 GFLIB_Integrator

The GFLIB_Integrator function calculates a discrete implementation of the integrator (sum), discretized using a trapezoidal rule in Tustin’s method (bi-linear transformation).

The continuous time domain representation of the integrator is defined as follows:

\[
  u(t) = \int e(t) dt
\]

Figure 79.

In a continuous time domain, the transfer function for this integrator is described using the Laplace transformation as follows:

\[
  H(s) = \frac{U(s)}{E(s)} = \frac{1}{s}
\]

Figure 80.

Transforming the above equation into a digital time domain using the bi-linear transformation leads to the following transfer function:

\[
  Z\left\{H(s)\right\} = \frac{U(z)}{E(z)} = \frac{T_s + T_s z^{-1}}{2 - 2z^{-1}}
\]

Figure 81.

where \(T_s\) is the sampling period of the system. The discrete implementation of the digital transfer function in the above equation is expressed as follows:

\[
  u(k) = u(k - 1) + e(k) \frac{T_s}{2} + e(k - 1) \frac{T_s}{2}
\]

Figure 82.
Considering integrator gain $K_I$, the transfer function leads to the following equation:

$$u_I(k) = u_I(k-1) + e(k) \frac{K_I T_s}{2} + e(k-1) \frac{K_I T_s}{2}$$

Figure 83.

where:

- $u_I(k)$ is the integrator's output in the actual step
- $u_I(k-1)$ is the integrator's output from the previous step
- $e(k)$ is the integrator's input in the actual step
- $e(k-1)$ is the integrator's input from the previous step
- $K_I$ is the integrator's gain coefficient
- $T_s$ is the sampling period of the system

Equation 5 can be used in the fractional arithmetic as follows:

$$u_{Isc}(k) u_{max} = u_{Isc}(k-1) u_{max} + K_I T_s \frac{e_{sc}(k) + e_{sc}(k-1)}{2} e_{max}$$

Figure 84.

where:

- $u_{max}$ is the integrator output scale
- $u_{Isc}(k)$ is the scaled integrator output in the actual step
- $u_{Isc}(k-1)$ is the scaled integrator output from the previous step
- $e_{max}$ is the integrator input scale
- $e_{sc}(k)$ is the scaled integrator input in the actual step
- $e_{sc}(k-1)$ is the scaled integrator input in the previous step

For a proper use of this function, it is recommended to initialize the function's data by the GFLIB_IntegratorInit functions, before using the GFLIB_Integrator function. You must call the init function when you want the integrator to be initialized.

### 2.22.1 Available versions

This function is available in the following versions:

- Fractional output - the output is the fractional portion of the result, the result is within the range <-1 ; 1), and it may overflow from one limit to the other. The parameters use the accumulator types.
- Floating-point output - the output is the floating-point result within the type's full range, with defined upper and lower limits. The result can not overflow from one limit to the other.

The available versions of the GFLIB_IntegratorInit function are shown in the following table:

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Parameters</th>
<th>Result type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GFLIB_IntegratorInit_F16</td>
<td>frac16_t</td>
<td>GFLIB_INTEGRATOR_T_A32*</td>
<td>void</td>
<td>The inputs are a 16-bit fractional initial value and a pointer to the integrator parameters' structure.</td>
</tr>
</tbody>
</table>

Table continues on the next page...
### Table 33. Init function versions (continued)

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Parameters</th>
<th>Result type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GFLIB_IntegratorInit_FLT</td>
<td>float_t</td>
<td>GFLIB_INTEGRATOR_T_FLT*</td>
<td>void</td>
<td>The inputs are a 32-bit single precision floating-point initial value and a pointer to the integrator parameters' structure.</td>
</tr>
</tbody>
</table>

The available versions of the GFLIB_Integrator function are shown in the following table:

### Table 34. Function versions

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Parameters</th>
<th>Result type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GFLIB_Integrator_F16</td>
<td>frac16_t</td>
<td>GFLIB_INTEGRATOR_T_A32*</td>
<td>frac16_t</td>
<td>The inputs are a 16-bit fractional value to be integrated and a pointer to the integrator parameters' structure. The output is limited to range (-1 ; 1). When the integrator reaches the limit, it overflows to the other limit.</td>
</tr>
<tr>
<td>GFLIB_Integrator_FLT</td>
<td>float_t</td>
<td>GFLIB_INTEGRATOR_T_FLT*</td>
<td>float_t</td>
<td>The inputs are a 32-bit single precision floating-point value to be integrated and a pointer to the integrator parameters' structure. The output is limited to range (&lt;\text{fltLowerLim} ; \text{fltUpperLim}&gt;). The output can not overflow to the other limit.</td>
</tr>
</tbody>
</table>

#### 2.22.2 GFLIB_INTEGRATOR_T_A32

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Input type</th>
<th>Description</th>
</tr>
</thead>
</table>
| a32Gain | acc32_t | Integrator gain is set up according to Equation 6 as follows:  
\[ K_i T_s = \frac{c_{\text{max}}}{t_{\text{max}}} \]  
The parameter is a 32-bit accumulator type within the range \(-65536.0 ; 65536.0\). Set by the user. |
| f32IAccK_1 | frac32_t | Integral portion in the step k - 1. Controlled by the algorithm. |
| f16InValK_1 | frac16_t | Input value in the step k - 1. Controlled by the algorithm. |

#### 2.22.3 GFLIB_INTEGRATOR_T_FLT

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Input type</th>
<th>Description</th>
</tr>
</thead>
</table>
| fltGain | float_t | Integrator gain is set up according to Equation 5 as \( K_i T_s \).  
The parameter is a 32-bit single precision floating-point type within the full range. Set by the user. |

*Table continues on the next page...*
### Variable description

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Input type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>fltAccK_1</td>
<td>float_t</td>
<td>Integral portion in the step k - 1 without any limitation. Controlled by the algorithm.</td>
</tr>
<tr>
<td>fltInValK_1</td>
<td>float_t</td>
<td>Input value in the step k - 1. Controlled by the algorithm.</td>
</tr>
<tr>
<td>fltUpperLim</td>
<td>float_t</td>
<td>Upper limit. This parameter must be greater than fltLowerLim. Set by the user.</td>
</tr>
<tr>
<td>fltLowerLim</td>
<td>float_t</td>
<td>Lower limit. This parameter must be lower than fltUpperLim. Set by the user.</td>
</tr>
</tbody>
</table>

#### 2.22.4 Declaration

The available GFLIB_IntegratorInit functions have the following declarations:

```c
void GFLIB_IntegratorInit_F16(frac16_t f16InitVal, GFLIB_INTEGRATOR_T_A32 *psParam)
void GFLIB_IntegratorInit_FLT(float_t fltInitVal, GFLIB_INTEGRATOR_T_FLT *psParam)
```

The available GFLIB_Integrator functions have the following declarations:

```c
frac16_t GFLIB_Integrator_F16(frac16_t f16InVal, GFLIB_INTEGRATOR_T_A32 *psParam)
float_t GFLIB_Integrator_FLT(float_t fltInVal, GFLIB_INTEGRATOR_T_FLT *psParam)
```

#### 2.22.5 Function use

The use of the GFLIB_IntegratorInit and GFLIB_Integrator functions is shown in the following examples:

```c
#include "gflib.h"

static frac16_t f16Result, f16InVal, f16InitVal;
static GFLIB_INTEGRATOR_T_A32 sParam;

void Isr(void);

void main(void)
{
    f16InVal = FRAC16(-0.4);
    sParam.a32Gain = ACC32(0.1);
    f16InitVal = FRAC16(0.1);
    GFLIB_IntegratorInit_F16(f16InitVal, &sParam);
}

/* periodically called function */
void Isr()
{
    f16Result = GFLIB_Integrator_F16(f16InVal, &sParam);
}
```
Floating-point version:

```c
#include "gflib.h"

static float_t fltResult, fltInVal, fltInitVal;
static GFLIB_INTEGRATOR_T_FLT sParam;

void Isr(void);

void main(void)
{
    fltInVal = -0.4F;
    sParam.fltGain = 0.1F;
    fltInitVal = 0.1F;
    GFLIB_IntegratorInit_FLT(fltInitVal, &sParam);
}

/* periodically called function */
void Isr()
{
    fltResult = GFLIB_Integrator_FLT(fltInVal, &sParam);
}
```

### 2.23 GFLIB_CtrlBetaIPpAW

The GFLIB_CtrlBetaIPpAW function calculates the parallel form of the Beta-Integral-Proportional (Beta-IP) controller with an implemented integral anti-windup functionality. The Beta-IP controller is an extended PI controller, which enables to separate the responses from the setpoint change and the load change (if \( \beta = 1 \), the Beta-IP controller has the same response as the PI controller). Therefore the Beta-IP controller allows for reducing the overshoot caused by the change of the setpoint without affecting the load change response. The \( \beta \) parameter can be set in the range from zero to one, where zero means the maximal overshoot limitation and one means no limitation.

The Beta-IP controller attempts to correct the error between the measured process variable (feedback) and the desired set-point by calculating a corrective action that can adjust the process accordingly. The GFLIB_CtrlBetaIPpAW function calculates the Beta-IP algorithm according to the equations below. The Beta-IP algorithm is implemented in the parallel (non-interacting) form, enabling you to define the P, I, and \( \beta \) parameters independently and without interaction. The controller output is limited and the limit values (the upper limit and the lower limit) are defined by the user.

The Beta-IP controller algorithm also returns a limitation flag, which indicates that the controller’s output is at the limit. If the Beta-IP controller output reaches the upper or lower limits, the limit flag is set to one. Otherwise, it is zero (integer values).

An anti-windup strategy is implemented by limiting the integral portion. The integral state is limited by the controller limits in the same way as the controller output. The integration can be stopped by a flag that is pointed to by the function’s API.

The Beta-IP algorithm in the continuous time domain can be expressed as follows:

\[
    u(t) = K_P \cdot [\beta \cdot (w(t) - y(t))] + K_I \int [w(t) - y(t)] \, dt
\]

**Figure 85.**

where:

- \( u(t) \) is the controller output in the continuous time domain
- \( w(t) \) is the required value in the continuous time domain
• \( y(t) \) is the measured value (feedback) in the continuous time domain
• \( K_p \) is the proportional gain
• \( K_i \) is the integral gain
• \( \beta \) is the beta gain (overshoot reduction gain in the range from zero to one)

Equation 1 can be expressed using the Laplace transformation as follows:

\[
U(s) = K_p \cdot [\beta \cdot W(s) - Y(s)] + K_i \cdot \frac{W(s) \cdot Y(s)}{s}
\]

Figure 86.

The proportional part (\( u_P \)) of Equation 1 is transformed into the discrete time domain as follows:

\[
u_P(k) = K_P \cdot [\beta \cdot w(k) - y(k)]
\]

Figure 87.

where:
• \( u_P(k) \) is the proportional action in the actual step
• \( w(k) \) is the required value in the actual step
• \( y(k) \) is the measured value in the actual step
• \( K_P \) is the proportional gain coefficient
• \( \beta \) is the beta gain coefficient

Equation 3 can be used in the fractional arithmetic as follows:

\[
u_{P_{sc}}(k) \cdot u_{max} = K_P \cdot [\beta \cdot W_{sc}(k) - Y_{sc}(k)] \cdot e_{max}
\]

Figure 88.

where:
• \( u_{max} \) is the action output scale
• \( u_{P_{sc}}(k) \) is the scaled proportional action in the actual step
• \( e_{max} \) is the error input scale
• \( w_{sc}(k) \) is the scale required value in the actual step
• \( y_{sc}(k) \) is the scale measured value in the actual step

Transforming the integral part (\( u_I \)) of Equation 1 into a discrete time domain using the bi-linear method (also known as the trapezoidal approximation) is as follows:

\[
u_I(k) = u_I(k - 1) + [w(k) - y(k)] \cdot \frac{K_i T_s}{2} + e(k - 1) \cdot \frac{K_i T_s}{2}
\]

Figure 89.

where:
• \( u_I(k) \) is the integral action in the actual step
• \( u_I(k - 1) \) is the integral action from the previous step
• \( w(k) \) is the required value in the actual step
• \( y(k) \) is the measured value in the actual step
• $e(k - 1)$ is the error in the previous step
• $T_s$ is the sampling period of the system
• $K_I$ is the integral gain coefficient

Equation 5 can be used in the fractional arithmetic as follows:

$$u_{IsC} \cdot u_{\text{max}} = u_{IsC}(k - 1) \cdot u_{\text{max}} + K_I T_s \cdot \frac{e_{sc}(k) + e_{sc}(k - 1)}{2} \cdot e_{\text{max}}$$

Figure 90.

where:
• $u_{\text{max}}$ is the action output scale
• $u_{IsC}(k)$ is the scaled integral action in the actual step
• $u_{IsC}(k - 1)$ is the scaled integral action from the previous step
• $e_{\text{max}}$ is the error input scale
• $e_{sc}(k)$ is the scaled error in the actual step
• $e_{sc}(k - 1)$ is the scaled error in the previous step

The output signal limitation is implemented in this controller. The actual output $u(k)$ is bounded not to exceed the given limit values $\text{UpperLimit}$ and $\text{LowerLimit}$. This is either due to the bounded power of the actuator or due to the physical constraints of the plant.

$$u(k) = \begin{cases} \text{UpperLimit} & u(k) \geq \text{UpperLimit} \\ \text{LowerLimit} & u(k) \leq \text{LowerLimit} \\ u(k) & \text{else} \end{cases}$$

Figure 91.

The bounds are described by a limitation element, as shown in Equation 7. When the bounds are exceeded, the non-linear saturation characteristic takes effect and influences the dynamic behavior. The described limitation is implemented on the integral part accumulator (limitation during the calculation) and the overall controller output. Therefore, if the limitation occurs, the controller output is clipped to its bounds, and the wind-up occurrence of the accumulator portion is avoided by saturating the actual sum.

For a proper use of this function, it is recommended to initialize the function data by the GFLIB_CtrlBetaIPpAWInit function, before using the GFLIB_CtrlBetaIPpAW function.

2.23.1 Available versions

This function is available in the following versions:
• Fractional output - the output is the fractional portion of the result; the result is within the range $<-1 ; 1)$. The parameters use the accumulator types.
• Floating-point output - the output is the floating-point result within the type's full range.

The available versions of the GFLIB_CtrlBetaIPpAWInit function are shown in the following table:
Table 35. Init function versions

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Parameters</th>
<th>Result type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GFLIB_CtrlBetaIPpAWInit_F16</td>
<td>frac16_t</td>
<td>GFLIB_CTRL_BETA_IP_P_AW_T_A32*</td>
<td>void</td>
<td>The inputs are a 16-bit fractional initial value and a pointer to the controller's parameters structure.</td>
</tr>
<tr>
<td>GFLIB_CtrlBetaIPpAWInit_FLT</td>
<td>float_t</td>
<td>GFLIB_CTRL_BETA_IP_P_AW_T_FLT*</td>
<td>void</td>
<td>The inputs are a 32-bit single precision floating-point initial value and a pointer to the controller's parameters structure.</td>
</tr>
</tbody>
</table>

The available versions of the GFLIB_CtrlBetaIPpAW function are shown in the following table:

Table 36. Function versions

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Parameters</th>
<th>Result type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GFLIB_CtrlBetaIPpAW_F16</td>
<td>frac16_t</td>
<td>frac16_t</td>
<td>bool_t *</td>
<td>The required value input is a 16-bit fractional value within the range &lt;-1 ; 1). The measured value input is a 16-bit fractional value within the range &lt;-1 ; 1). The integration of the Beta-IP controller is suspended if the stop flag is set. When it is cleared, the integration continues. The parameters are pointed to by an input pointer. The function returns a 16-bit fractional value in the range &lt;f16LowerLim ; f16UpperLim&gt;.</td>
</tr>
<tr>
<td>GFLIB_CtrlBetaIPpAW_FLT</td>
<td>float_t</td>
<td>float_t</td>
<td>bool_t *</td>
<td>The required value input is a 32-bit single precision floating-point value within the full type's range. The measured value input is a 32-bit single precision floating-point value within the full type's range. The integration of the Beta-IP controller is suspended if the stop flag is set. When it is cleared, the integration continues. The parameters are pointed to by an input pointer. The function returns a 32-bit single precision floating-point value in the range &lt;fltLowerLim ; fltUpperLim&gt;.</td>
</tr>
</tbody>
</table>

2.23.2 GFLIB_CTRL_BETA_IP_P_AW_T_A32

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Input type</th>
<th>Description</th>
</tr>
</thead>
</table>
| a32PGain      | acc32_t    | The proportional gain is set up according to Equation 4 as follows:  

\[ K_p \frac{c_{max}}{H_{max}} \]

The parameter is a 32-bit accumulator type within the range <0 ; 65536.0). Set by the user. |
| a32IGain      | acc32_t    | The integral gain is set up according to Equation 6 as follows:  

\[ K_i T_s \frac{c_{max}}{H_{max}} \]

The parameter is a 32-bit accumulator type within the range <0 ; 65536.0). Set by the user. |
Table continued from the previous page...

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Input type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>f32IAccK_1</td>
<td>frac32_t</td>
<td>State variable of the internal accumulator (integrator). Controlled by the algorithm.</td>
</tr>
<tr>
<td>f16InErrK_1</td>
<td>frac16_t</td>
<td>Input error at the step k - 1. Controlled by the algorithm.</td>
</tr>
<tr>
<td>f16UpperLim</td>
<td>frac16_t</td>
<td>Upper limit of the controller's output and the internal accumulator (integrator). This parameter must be greater than f16LowerLim. Set by the user.</td>
</tr>
<tr>
<td>f16LowerLim</td>
<td>frac16_t</td>
<td>Lower limit of the controller's output and the internal accumulator (integrator). This parameter must be lower than f16UpperLim. Set by the user.</td>
</tr>
<tr>
<td>f16BetaGain</td>
<td>frac16_t</td>
<td>The beta gain is a fraction 16-bit type in the range [0 ; 1). The beta gain defines the reduction overshot when the required value is changed. Set by the user.</td>
</tr>
<tr>
<td>bLimFlag</td>
<td>bool_t</td>
<td>Limitation flag which identifies that the controller's output reached the limits. 1 - the limit is reached; 0 - the output is within the limits. Controlled by the application.</td>
</tr>
</tbody>
</table>

2.23.3  GFLIB_CTRL_BETA_IP_P_AW_T_FLT

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Input type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>fltPGain</td>
<td>float_t</td>
<td>The proportional gain is set up according to Equation 3 as $K_P$. The parameter is a 32-bit single precision floating-point type non-negative value. Set by the user.</td>
</tr>
<tr>
<td>fltIGain</td>
<td>float_t</td>
<td>The integral gain is set up according to Equation 5 as $K_I T_s$. The parameter is a 32-bit single precision floating-point type non-negative value. Set by the user.</td>
</tr>
<tr>
<td>fltIAccK_1</td>
<td>float_t</td>
<td>State variable of the internal accumulator (integrator). Controlled by the algorithm.</td>
</tr>
<tr>
<td>fltInErrK_1</td>
<td>float_t</td>
<td>Input error at the step k - 1. Controlled by the algorithm.</td>
</tr>
<tr>
<td>fltUpperLim</td>
<td>float_t</td>
<td>Upper limit of the controller's output and the internal accumulator (integrator). This parameter must be greater than fltLowerLim. Set by the user.</td>
</tr>
<tr>
<td>fltLowerLim</td>
<td>float_t</td>
<td>Lower limit of the controller's output and the internal accumulator (integrator). This parameter must be lower than fltUpperLim. Set by the user.</td>
</tr>
<tr>
<td>fltBetaGain</td>
<td>float_t</td>
<td>The beta gain is a 32-bit single precision floating-point type non-negative value. Set by the user. The beta gain defines the reduction overshot when the required value is changed. Set by the user.</td>
</tr>
<tr>
<td>bLimFlag</td>
<td>bool_t</td>
<td>Limitation flag which identifies that the controller's output reached the limits. 1 - the limit is reached; 0 - the output is within the limits. Controlled by the application.</td>
</tr>
</tbody>
</table>

2.23.4 Declaration

The available GFLIB_CtrlBetaIpAWInit functions have the following declarations:

```c
void GFLIB_CtrlBetaIpAWInit_F16(frac16_t f16InitVal, GFLIB_CTRL_BETA_IP_P_AW_T_A32 *psParam);
void GFLIB_CtrlBetaIpAWInit_FLT(float_t fltInitVal, GFLIB_CTRL_BETA_IP_P_AW_T_FLT *psParam);
```
The available **GFLIB_CtrlBetaIPpAW** functions have the following declarations:

```c
frac16_t GFLIB_CtrlBetaIPpAW_F16(frac16_t f16InReq, frac16_t f16In, const bool_t *pbStopIntegFlag, GFLIB_CTRL_BETA_IP_P_AW_T_A32 *psParam)
float_t GFLIB_CtrlBetaIPpAW_FLT(float_t fltInReq, float_t fltIn, const bool_t *pbStopIntegFlag, GFLIB_CTRL_BETA_IP_P_AW_T_FLT *psParam)
```

### 2.23.5 Function use

The use of the **GFLIB_CtrlBetaIPpAWInit** and **GFLIB_CtrlBetaIPpAW** functions is shown in the following examples:

#### Fixed-point version:

```c
#include "gflib.h"
static frac16_t f16Result, f16InitVal, f16InReq, f16In;
static bool_t bStopIntegFlag;
static GFLIB_CTRL_BETA_IP_P_AW_T_A32 sParam;

void Isr(void);

void main(void)
{
    f16InReq = FRAC16(-0.3);
    f16In = FRAC16(-0.4);
    sParam.a32PGain = ACC32(0.1);
    sParam.a32IGain = ACC32(0.2);
    sParam.f16UpperLim = FRAC16(0.9);
    sParam.f16LowerLim = FRAC16(-0.9);
    sParam.f16BetaGain = FRAC16(0.5);
    bStopIntegFlag = FALSE;

    f16InitVal = FRAC16(0.0);

    GFLIB_CtrlBetaIPpAWInit_F16(f16InitVal, &sParam);
}
/* periodically called function */
void Isr()
{
    f16Result = GFLIB_CtrlBetaIPpAW_F16(f16InReq, f16In, &bStopIntegFlag, &sParam);
}
```

#### Floating-point version:

```c
#include "gflib.h"
static float_t fltResult, fltInitVal, fltInReq, fltIn, fltInErrD;
static bool_t bStopIntegFlag;
static GFLIB_CTRL_BETA_IP_P_AW_T_FLT sParam;

void Isr(void);
```
2.24 **GFLIB_CtrlBetaIPDpAW**

The **GFLIB_CtrlBetaIPDpAW** function calculates the parallel form of the Beta-Integral-Proportional-Derivative (Beta-IPD) controller with the implemented integral anti-windup functionality. The Beta-IPD controller is an extended PID controller, which enables to separate the responses from the setpoint change and the load change (if $\beta = 1$ then the Beta-IPD controller has the same response as the PID controller). Therefore, the Beta-IPD controller enables to reduce the overshoot caused by a change of the setpoint without affecting the load change response. The $\beta$ parameter can be set in a range from zero to one, where zero means the maximal overshoot limitation and one means no limitation.

The Beta-IPD controller attempts to correct the error between the measured process variable and the desired set-point by calculating a corrective action that can adjust the process accordingly. The **GFLIB_CtrlBetaIPDpAW** function calculates the Beta-IPD algorithm according to the equations below. The Beta-IPD algorithm is implemented in the parallel (non-interacting) form, enabling you to define the $P$, $I$, $D$, and $\beta$ parameters independently and without interaction. The controller output is limited, and the limit values (upper limit and lower limit) are defined by the user.

The algorithm has an error input for the $D$ portion calculation. This enables you to apply different filters for the $D$ error input and for the required and measured value inputs.

The Beta-IPD controller algorithm also returns a limitation flag, which indicates that the controller's output is at the limit. If the Beta-IPD controller output reaches the upper or lower limit, then the limit flag is set to one. Otherwise, it is zero (integer values).

An anti-windup strategy is implemented by limiting the integral portion. The integral state is limited by the controller limits in the same way as the controller output. The integration can be stopped by a flag, which is pointed to by the function's API.

The Beta-IPD algorithm in the continuous time domain can be expressed as follows:

\[
    u(t) = K_P \cdot \left[ \beta \cdot (w(t) - y(t)) \right] + K_I \int \left[ (w(t) - y(t)) \right] \cdot dt + K_D \frac{d}{dt} e_D(t)
\]

Figure 92.

where:

- $u(t)$ is the controller output in the continuous time domain
- $w(t)$ is the required value in the continuous time domain
- $y(t)$ is the measured value (feedback) in the continuous time domain

```c
void main(void)
{
    fltInReq = -0.3F;
    fltIn = -0.4F;
    fltInErrD = -0.7F;
    sParam.fltPGain = 0.1F;
    sParam.fltIGain = 0.2F;
    sParam.fltUpperLim = 0.9F;
    sParam.fltLowerLim = -0.9F;
    sParam.fltBetaGain = 0.5F;
    bStopIntegFlag = FALSE;
    fltInitVal = 0.0F;
    GFLIB_CtrlBetaIPpAWInit_FLT(fltInitVal, &sParam);
}

/* periodically called function */
void Isr()
{
    fltResult = GFLIB_CtrlBetaIPpAW_FLT(fltInReq, fltIn, &bStopIntegFlag, &sParam);
}
```
• $e_0(t)$ is the input error for the derivative calculation in the continuous time domain
• $K_P$ is the proportional gain
• $K_I$ is the integral gain
• $K_D$ is the derivative gain
• $\beta$ is the beta gain (overshoot reduction gain in the range from zero to one)

Equation 1 can be expressed using the Laplace transformation as follows:

$$U(s) = K_P \cdot [\beta \cdot W(s) - Y(s)] + K_I \cdot \frac{W(s) - Y(s)}{s} + K_D \cdot e_0 \cdot s$$

Figure 93.

The proportional part ($u_P$) of Equation 1 is transformed into the discrete time domain as follows:

$$u_P(k) = K_P \cdot [\beta \cdot w(k) - y(k)]$$

Figure 94.

where:
• $u_P(k)$ is the proportional action in the actual step
• $w(k)$ is the required value in the actual step
• $y(k)$ is the measured value in the actual step
• $K_P$ is the proportional gain coefficient
• $\beta$ is the beta gain coefficient

Equation 3 can be used in the fractional arithmetic as follows:

$$u_{Psc}(k) \cdot u_{max} = K_P \cdot [\beta \cdot w_{sc}(k) - y_{sc}(k)] \cdot e_{max}$$

Figure 95.

where:
• $u_{max}$ is the action output scale
• $u_{Psc}(k)$ is the scaled proportional action in the actual step
• $e_{max}$ is the error input scale
• $w_{sc}(k)$ is the scale required value in the actual step
• $y_{sc}(k)$ is the scale measured value in the actual step

Transforming the integral part ($u_I$) of Equation 1 into a discrete time domain using the bi-linear method (also known as the trapezoidal approximation) is as follows:

$$u_I(k) = u_I(k - 1) + \left[ w(k) - y(k) \right] \cdot \frac{K_I T_s}{2} + e(k - 1) \cdot \frac{K_I T_s}{2}$$

Figure 96.

where:
• $u_I(k)$ is the integral action in the actual step
• $u_I(k - 1)$ is the integral action from the previous step
• $w(k)$ is the required value in the actual step
• \( y(k) \) is the measured value in the actual step
• \( e(k - 1) \) is the error in the previous step
• \( T_s \) is the sampling period of the system
• \( K_I \) is the integral gain coefficient

**Equation 5** can be used in the fractional arithmetic as follows:

\[
 u_{\text{isc}}(k) \cdot u_{\text{max}} = u_{\text{isc}}(k - 1) \cdot u_{\text{max}} + K_I T_s \frac{e_{\text{isc}}(k) + e_{\text{isc}}(k - 1)}{2} \cdot e_{\text{max}}
\]

Figure 97.

where:
• \( u_{\text{max}} \) is the action output scale
• \( u_{\text{isc}}(k) \) is the scaled integral action in the actual step
• \( u_{\text{isc}}(k - 1) \) is the scaled integral action from the previous step
• \( e_{\text{max}} \) is the error input scale
• \( e_{\text{isc}}(k) \) is the scaled error in the actual step
• \( e_{\text{isc}}(k - 1) \) is the scaled error in the previous step

The derivative part \( (u_D) \) of **Equation 1** is transformed into the discrete time domain as follows:

\[
 u_D(k) = K_D \frac{T_s}{\tau_s} [e_D(k) - e_D(k - 1)]
\]

Figure 98.

where:
• \( u_D(k) \) is the proportional action in the actual step
• \( e_D(k) \) is the error used for the derivative input in the actual step
• \( e_D(k - 1) \) is the error used for the derivative input in the previous step
• \( K_D \) is the proportional gain coefficient

**Equation 3** can be used in the fractional arithmetic as follows:

\[
 u_{\text{Dsc}}(k) \cdot u_{\text{max}} = K_D \frac{T_s}{\tau_s} [e_{\text{Dsc}}(k) - e_{\text{Dsc}}(k - 1)] \cdot e_{\text{max}}
\]

Figure 99.

where:
• \( u_{\text{max}} \) is the action output scale
• \( u_{\text{Dsc}}(k) \) is the scaled derivative action in the actual step
• \( e_{\text{max}} \) is the error input scale
• \( e_{\text{Dsc}}(k) \) is the scaled error for the derivative input in the actual step
• \( e_{\text{Dsc}}(k - 1) \) is the scaled error for the derivative input in the previous step

The output signal limitation is implemented in this controller. The actual output \( u(k) \) is bounded to not exceed the given limit values - UpperLimit and LowerLimit. This is either due to the bounded power of the actuator, or due to the physical constraints of the plant.
The bounds are described by a limitation element, as shown in Equation 7. When the bounds are exceeded, the non-linear saturation characteristic takes place and influences the dynamic behavior. The described limitation is implemented in the integral part accumulator (limitation during the calculation) and in the overall controller output. Therefore, if the limitation occurs, the controller output is clipped to its bounds, and the wind-up occurrence of the accumulator portion is avoided by saturating the actual sum.

For a proper use of this function, it is recommended to initialize the function data by the GFLIB_CtrlBetaIPDpAWInit functions, before using the GFLIB_CtrlBetaIPDpAW function.

### 2.24.1 Available versions

This function is available in the following versions:

- **Fractional output** - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The parameters use the accumulator types.

- **Floating-point output** - the output is the floating-point result within the type's full range.

The available versions of the GFLIB_CtrlBetaIPDpAWInit function are shown in the following table:

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Parameters</th>
<th>Result type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GFLIB_CtrlBetaIPDpAWInit_F16</td>
<td>frac16_t</td>
<td>GFLIB_CTRL_BETA_IPD_P_AW_T_A32*</td>
<td>void</td>
<td>The inputs are a 16-bit fractional initial value and a pointer to the controller's parameters structure.</td>
</tr>
<tr>
<td>GFLIB_CtrlBetaIPDpAWInitFLT</td>
<td>float_t</td>
<td>GFLIB_CTRL_BETA_IPD_P_AW_TFLT*</td>
<td>void</td>
<td>The inputs are a 32-bit single precision floating-point initial value and a pointer to the controller's parameters structure.</td>
</tr>
</tbody>
</table>

The available versions of the **GFLIB_CtrlBetaIPDpAW** function are shown in the following table:

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Parameters</th>
<th>Result type</th>
</tr>
</thead>
<tbody>
<tr>
<td>GFLIB_CtrlBetaIPDpAW_F16</td>
<td>frac16_t, frac16_t, frac16_t, bool_t*</td>
<td>GFLIB_CTRL_BETA_IPD_P_AW_T_A32*</td>
<td>frac16_t</td>
</tr>
</tbody>
</table>

The required value input is a 16-bit fractional value within the range <-1 ; 1). The measured value input is a 16-bit fractional value within the range <-1 ; 1). The D error input is a 16-bit fractional value within the range <-1 ; 1). The integration of the Beta-IPD controller is suspended if the stop flag is set. When it is cleared, the integration continues. The parameters are pointed to by an input pointer. The function returns a 16-bit fractional value in the range <f16LowerLim ; f16UpperLim>.

*Table continues on the next page...*
### Table 38. Function versions (continued)

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Parameters</th>
<th>Result type</th>
</tr>
</thead>
<tbody>
<tr>
<td>GFLIB_CtrlBetaIPDpAW_FLT</td>
<td>float_t</td>
<td>float_t, float_t</td>
<td>GFLIB_CTRL_BETA_IPD_P_AW_T_FLT*</td>
</tr>
</tbody>
</table>

The required value input is a 32-bit single precision floating-point value within the full type's range. The measured value input is a 32-bit single precision floating-point value within the full type's range. The error input is a 32-bit single precision floating-point value within the full type's range. The integration of the Beta-IPD controller is suspended if the stop flag is set. When it is cleared, the integration continues. The parameters are pointed to by an input pointer. The function returns a 32-bit single precision floating-point value in the range <fltLowerLim ; fltUpperLim>.

### 2.24.2 GFLIB_CTRL_BETA_IPD_P_AW_T_A32

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Input type</th>
<th>Description</th>
</tr>
</thead>
</table>
| a32PGain      | acc32_t    | The proportional gain is set up according to Equation 4 as follows:  

\[
K_P \frac{e_{\text{max}}}{u_{\text{max}}}
\]

The parameter is a 32-bit accumulator type within the range <0 ; 65536.0). Set by the user. |
| a32IGain      | acc32_t    | The integral gain is set up according to Equation 6 as follows:  

\[
K_I T_s \frac{e_{\text{max}}}{u_{\text{max}}}
\]

The parameter is a 32-bit accumulator type within the range <0 ; 65536.0). Set by the user. |
| a32DGain      | acc32_t    | The derivative gain is set up according to Equation 6 as follows:  

\[
\frac{K_D}{T_s} \frac{e_{\text{max}}}{u_{\text{max}}}
\]

The parameter is a 32-bit accumulator type within the range <0 ; 65536.0). Set by the user. |
| f32IAccK_1    | frac32_t   | State variable of the internal accumulator (integrator). Controlled by the algorithm. |
| f16InErrK_1   | frac16_t   | Input error in the step k - 1. Controlled by the algorithm. |
| f16UpperLim   | frac16_t   | Upper limit of the controller's output and the internal accumulator (integrator). This parameter must be greater than f16LowerLim. Set by the user. |
| f16LowerLim   | frac16_t   | Lower limit of the controller's output and the internal accumulator (integrator). This parameter must be lower than f16UpperLim. Set by the user. |
| f16InErrDK_1  | frac16_t   | Input error for the derivative calculation in the step k - 1. Controlled by the algorithm. |
| f16BetaGain   | frac16_t   | The beta gain is a fraction 16-bit type in the range [0 ; 1). The beta gain defines the reduction overshot when the required value is changed. Set by the user. |
| bLimFlag      | bool_t     | The limitation flag which identifies that the controller's output reached the limits. 1 - the limit is reached; 0 - the output is within the limits. Controlled by the application. |
### 2.24.3 GFLIB_CTRL_BETA_IPD_P_AW_TFLT

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Input type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>fltPGain</td>
<td>float_t</td>
<td>The proportional gain is set up according to Equation 3 as $K_P$. The parameter is a 32-bit single precision floating-point type non-negative value. Set by the user.</td>
</tr>
<tr>
<td>fltIGain</td>
<td>float_t</td>
<td>The integral gain is set up according to Equation 5 as $K_I T_s$. The parameter is a 32-bit single precision floating-point type non-negative value. Set by the user.</td>
</tr>
<tr>
<td>fltDGain</td>
<td>float_t</td>
<td>The derivative gain is set up according to Equation 5 as $K_D / T_s$. The parameter is a 32-bit single precision floating-point type non-negative value. Set by the user.</td>
</tr>
<tr>
<td>fltAccK_1</td>
<td>float_t</td>
<td>State variable of the internal accumulator (integrator). Controlled by the algorithm.</td>
</tr>
<tr>
<td>fltInErrK_1</td>
<td>float_t</td>
<td>Input error in the step $k - 1$. Controlled by the algorithm.</td>
</tr>
<tr>
<td>fltUpperLim</td>
<td>float_t</td>
<td>Upper limit of the controller's output and the internal accumulator (integrator). This parameter must be greater than fltLowerLim. Set by the user.</td>
</tr>
<tr>
<td>fltLowerLim</td>
<td>float_t</td>
<td>Lower limit of the controller's output and the internal accumulator (integrator). This parameter must be lower than fltUpperLim. Set by the user.</td>
</tr>
<tr>
<td>fltInErrDK_1</td>
<td>float_t</td>
<td>Input error for the derivative calculation in the step $k - 1$. Controlled by the algorithm.</td>
</tr>
<tr>
<td>fltBetaGain</td>
<td>float_t</td>
<td>The beta gain is a 32-bit single precision floating-point type non-negative value. Set by the user. The beta gain defines the reduction overshot when the required value is changed. Set by the user.</td>
</tr>
<tr>
<td>bLimFlag</td>
<td>bool_t</td>
<td>The limitation flag which identifies that the controller's output reached the limits. 1 - the limit is reached; 0 - the output is within the limits. Controlled by the application.</td>
</tr>
</tbody>
</table>

### 2.24.4 Declaration

The available GFLIB_CtrlBetaIPDpAWInit functions have the following declarations:

```c
void GFLIB_CtrlBetaIPDpAWInit_F16(frac16_t f16InitVal, GFLIB_CTRL_BETA_IPD_P_AW_T_A32 *psParam)

void GFLIB_CtrlBetaIPDpAWInitFLT(float_t fltInitVal, GFLIB_CTRL_BETA_IPD_P_AW_TFLT *psParam)
```

The available GFLIB_CtrlBetaIPDpAW functions have the following declarations:

```c
frac16_t GFLIB_CtrlBetaIPDpAW_F16(frac16_t f16InReq, frac16_t f16In, frac16_t f16InErrD, const bool_t *pbStopIntegFlag, GFLIB_CTRL_BETA_IPD_P_AW_T_A32 *psParam)

float_t GFLIB_CtrlBetaIPDpAW FLT(float_t fInReq, float_t fIn, float_t fInErrD, const bool_t *pbStopIntegFlag, GFLIB_CTRL_BETA_IPD_P_AW_TFLT *psParam)
```
2.24.5 Function use

The use of the GFLIB_CtrlBetaIPDPdAWInit and GFLIB_CtrlBetaIPDPdAW functions is shown in the following examples:

Fixed-point version:

```c
#include "gflib.h"

static frac16_t f16Result, f16InitVal, f16InReq, f16In, f16InErrD;
static bool_t bStopIntegFlag;
static GFLIB_CTRL_BETA_IPD_P_AW_T_A32 sParam;

void Isr(void);

void main(void)
{
    f16InReq = FRAC16(-0.3);
    f16In = FRAC16(-0.4);
    f16InErrD = FRAC16(-0.7);
    sParam.a32PGain = ACC32(0.1);
    sParam.a32IGain = ACC32(0.2);
    sParam.a32DGain = ACC32(0.001);
    sParam.f16UpperLim = FRAC16(0.9);
    sParam.f16LowerLim = FRAC16(-0.9);
    sParam.f16BetaGain = FRAC16(0.5);
    bStopIntegFlag = FALSE;
    f16InitVal = FRAC16(0.0);
    GFLIB_CtrlBetaIPDPdAWInit_F16(f16InitVal, &sParam);
}

/* periodically called function */
void Isr()
{
    f16Result = GFLIB_CtrlBetaIPDPdAW_F16(f16InReq, f16In, f16InErrD, &bStopIntegFlag, &sParam);
}
```

Floating-point version:

```c
#include "gflib.h"

static float_t fltResult, fltInitVal, fltInReq, fltIn, fltInErrD;
static boot_t bStopIntegFlag;
static GFLIB_CTRL_BETA_IPD_P_AW_T_FLT sParam;

void Isr(void);

void main(void)
{
    fltInReq = -0.3F;
    fltIn = -0.4F;
    fltInErrD = -0.7F;
    sParam.fltPGain = 0.1F;
    sParam.fltIGain = 0.2F;
    sParam.fltDGain = 0.001F;
    fltInitVal = 0.0F;
    GFLIB_CtrlBetaIPDPdAWInit_F32(fltInitVal, &sParam);
}
```
2.25 GFLIB_CtrlPIpAW

The GFLIB_CtrlPIpAW function calculates the parallel form of the Proportional-Integral (PI) controller with implemented integral anti-windup functionality.

The PI controller attempts to correct the error between the measured process variable and the desired set-point by calculating a corrective action that can adjust the process accordingly. The GFLIB_CtrlPIpAW function calculates the PI algorithm according to the equations below. The PI algorithm is implemented in the parallel (non-interacting) form, allowing the user to define the P and I parameters independently and without interaction. The controller output is limited and the limit values (upper limit and lower limit) are defined by the user.

The PI controller algorithm also returns a limitation flag, which indicates that the controller’s output is at the limit. If the PI controller output reaches the upper or lower limit, then the limit flag is set to 1, otherwise it is 0 (integer values).

An anti-windup strategy is implemented by limiting the integral portion. The integral state is limited by the controller limits in the same way as the controller output. The integration can be stopped by a flag that is pointed to by the function’s API.

The PI algorithm in the continuous time domain can be expressed as follows:

\[ u(t) = e(t) \cdot K_P + K_I \int_0^t e(t) \, dt \]

Figure 101.

where:

- \( u(t) \) is the controller output in the continuous time domain
- \( e(t) \) is the input error in the continuous time domain
- \( K_P \) is the proportional gain
- \( K_I \) is the integral gain

Equation 1 can be expressed using the Laplace transformation as follows:

\[ \frac{H(s)}{\frac{U(s)}{E(s)}} = K_P + \frac{K_I}{s} \]

Figure 102.

The proportional part (\( u_P \)) of Equation 1 is transformed into the discrete time domain as follows:
where:
- $u_P(k)$ is the proportional action in the actual step
- $e(k)$ is the error in the actual step
- $K_P$ is the proportional gain coefficient

Equation 3 can be used in the fractional arithmetic as follows:

$$u_{Psc}(k) \cdot u_{max} = K_P \cdot e_{sc}(k) \cdot e_{max}$$

where:
- $u_{max}$ is the action output scale
- $u_{Psc}(k)$ is the scaled proportional action in the actual step
- $e_{max}$ is the error input scale
- $e_{sc}(k)$ is the scale error in the actual step

Transforming the integral part ($u_I$) of Equation 1 into a discrete time domain using the bi-linear method, also known as the trapezoidal approximation, is as follows:

$$u_I(k) = u_I(k - 1) + e(k) \cdot \frac{K_I T_s}{2} + e(k - 1) \cdot \frac{K_I T_s}{2}$$

where:
- $u_I(k)$ is the integral action in the actual step
- $u_I(k - 1)$ is the integral action from the previous step
- $e(k)$ is the error in the actual step
- $e(k - 1)$ is the error in the previous step
- $T_s$ is the sampling period of the system
- $K_I$ is the integral gain coefficient

Equation 5 can be used in the fractional arithmetic as follows:

$$u_{Isc}(k) \cdot u_{max} = u_{Isc}(k - 1) \cdot u_{max} + K_I T_s \cdot \frac{e_{sc}(k) + e_{sc}(k - 1)}{2} \cdot e_{max}$$

where:
- $u_{max}$ is the action output scale
- $u_{Isc}(k)$ is the scaled integral action in the actual step
- $u_{Isc}(k - 1)$ is the scaled integral action from the previous step
- $e_{max}$ is the error input scale
- $e_{sc}(k)$ is the scaled error in the actual step
- $e_{sc}(k - 1)$ is the scaled error in the previous step.

The output signal limitation is implemented in this controller. The actual output $u(k)$ is bounded not to exceed the given limit values UpperLimit and LowerLimit. This is due to either the bounded power of the actuator or due to the physical constraints of the plant.

$$
\begin{align*}
    u(k) = \begin{cases} 
    U p e r L i m i t & u(k) \geq U p e r L i m i t \\
    L o w e r L i m i t & u(k) \leq L o w e r L i m i t \\
    u(k) & \text{else}
    \end{cases}
\end{align*}
$$

Figure 107.

The bounds are described by a limitation element, as shown in Equation 7. When the bounds are exceeded, the nonlinear saturation characteristic will take effect and influence the dynamic behavior. The described limitation is implemented on the integral part accumulator (limitation during the calculation) and on the overall controller output. Therefore, if the limitation occurs, the controller output is clipped to its bounds, and the wind-up occurrence of the accumulator portion is avoided by saturating the actual sum.

For a proper use of this function, it is recommended to initialize the function data by the GFLIB_CtrlPIpAWInit functions, before using the GFLIB_CtrlPIpAW function. You must call this function when you want the PI controller to be initialized.

### 2.25.1 Available versions

This function is available in the following versions:

- Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The parameters use the accumulator types.

- Floating-point output - the output is the floating-point result within the type's full range.

The available versions of the GFLIB_CtrlPIpAWInit function are shown in the following table:

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Parameters</th>
<th>Result type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GFLIB_CtrlPIpAWInit_F16</td>
<td>frac16_t</td>
<td>GFLIB_CTRL_PI_P_AW_T_A32*</td>
<td>void</td>
<td>The inputs are a 16-bit fractional initial value and a pointer to the controller's parameters structure.</td>
</tr>
<tr>
<td>GFLIB_CtrlPIpAWInitFLT</td>
<td>float_t</td>
<td>GFLIB_CTRL_PI_P_AW_TFLT*</td>
<td>void</td>
<td>The inputs are a 32-bit single precision floating-point initial value and a pointer to the controller's parameters structure.</td>
</tr>
</tbody>
</table>

The available versions of the GFLIB_CtrlPIpAW function are shown in the following table:

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Parameters</th>
<th>Result type</th>
</tr>
</thead>
<tbody>
<tr>
<td>GFLIB_CtrlPIpAW_F16</td>
<td>frac16_t</td>
<td>bool_t*</td>
<td>frac16_t</td>
</tr>
</tbody>
</table>

The error input is a 16-bit fractional value within the range <-1 ; 1). The integration of the PI controller is suspended if the stop flag is set. When it is cleared, the integration continues. The parameters are pointed to by an input pointer. The function returns a 16-bit fractional value in the range <f16LowerLim ; f16UpperLim>.

*Table continues on the next page...*
Table 40. Function versions (continued)

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Parameters</th>
<th>Result type</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Error</td>
<td>Stop flag</td>
<td></td>
</tr>
<tr>
<td>GFLIB_CtrlPIpAW_FLT</td>
<td>float_t</td>
<td>bool_t *</td>
<td>GFLIB_CTRL_PI_P_AW_T_FLT*</td>
</tr>
</tbody>
</table>

The error input is a 32-bit single precision floating-point value within the full type's range. The integration of the PI controller is suspended if the stop flag is set. When it is cleared, the integration continues. The parameters are pointed to by an input pointer. The function returns a 32-bit single precision floating-point value in the range <fltLowerLim ; fltUpperLim>.

2.25.2 GFLIB_CTRL_PI_P_AW_T_A32

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Input type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>a32PGain</td>
<td>acc32_t</td>
<td>Proportional gain is set up according to Equation 4 as follows: $K_P \frac{e_{\max}}{u_{\max}}$. The parameter is a 32-bit accumulator type within the range $&lt;0 ; 65536.0)$. Set by the user.</td>
</tr>
<tr>
<td>a32IGain</td>
<td>acc32_t</td>
<td>Integral gain is set up according to Equation 6 as follows: $K_i T_s \frac{e_{\max}}{u_{\max}}$. The parameter is a 32-bit accumulator type within the range $&lt;0 ; 65536.0)$. Set by the user.</td>
</tr>
<tr>
<td>f32IAccK_1</td>
<td>frac32_t</td>
<td>State variable of the internal accumulator (integrator). Controlled by the algorithm.</td>
</tr>
<tr>
<td>f16InErrK_1</td>
<td>frac16_t</td>
<td>Input error at the step k - 1. Controlled by the algorithm.</td>
</tr>
<tr>
<td>f16UpperLim</td>
<td>frac16_t</td>
<td>Upper limit of the controller's output and the internal accumulator (integrator). This parameter must be greater than f16LowerLim. Set by the user.</td>
</tr>
<tr>
<td>f16LowerLim</td>
<td>frac16_t</td>
<td>Lower limit of the controller's output and the internal accumulator (integrator). This parameter must be lower than f16UpperLim. Set by the user.</td>
</tr>
<tr>
<td>bLimFlag</td>
<td>bool_t</td>
<td>Limitation flag, which identifies that the controller's output reached the limits. 1 - the limit is reached; 0 - the output is within the limits. Controlled by the application.</td>
</tr>
</tbody>
</table>

2.25.3 GFLIB_CTRL_PI_P_AW_T_FLT

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Input type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>fltPGain</td>
<td>float_t</td>
<td>Proportional gain is set up according to Equation 3 as $K_p$. The parameter is a 32-bit single precision floating-point type non-negative value. Set by the user.</td>
</tr>
<tr>
<td>fltIGain</td>
<td>float_t</td>
<td>Integral gain is set up according to Equation 5 as $K_i T_s$. The parameter is a 32-bit single precision floating-point type non-negative value. Set by the user.</td>
</tr>
</tbody>
</table>

Table continues on the next page...
### Table continued from the previous page...

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Input type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>fltIAccK_1</td>
<td>float_t</td>
<td>State variable of the internal accumulator (integrator). Controlled by the algorithm.</td>
</tr>
<tr>
<td>fltInErrK_1</td>
<td>float_t</td>
<td>Input error at the step k - 1. Controlled by the algorithm.</td>
</tr>
<tr>
<td>fltUpperLim</td>
<td>float_t</td>
<td>Upper limit of the controller's output and the internal accumulator (integrator). This parameter must be greater than fltLowerLim. Set by the user.</td>
</tr>
<tr>
<td>fltLowerLim</td>
<td>float_t</td>
<td>Lower limit of the controller's output and the internal accumulator (integrator). This parameter must be lower than fltUpperLim. Set by the user.</td>
</tr>
<tr>
<td>bLimFlag</td>
<td>bool_t</td>
<td>Limitation flag, which identifies that the controller's output reached the limits. 1 - the limit is reached; 0 - the output is within the limits. Controlled by the application.</td>
</tr>
</tbody>
</table>

#### 2.25.4 Declaration

The available `GFLIB_CtrlPIpAWInit` functions have the following declarations:

```c
void GFLIB_CtrlPIpAWInit_F16(frac16_t f16InitVal, GFLIB_CTRL_PI_P_AW_T_A32 *psParam)
void GFLIB_CtrlPIpAWInit_FLT(float_t fltInitVal, GFLIB_CTRL_PI_P_AW_T_FLT *psParam)
```

The available `GFLIB_CtrlPIpAW` functions have the following declarations:

```c
frac16_t GFLIB_CtrlPIpAW_F16(frac16_t f16InErr, const bool_t *pbStopIntegFlag, GFLIB_CTRL_PI_P_AW_T_A32 *psParam)
float_t GFLIB_CtrlPIpAW_FLT(float_t fltInErr, const bool_t *pbStopIntegFlag, GFLIB_CTRL_PI_P_AW_T_FLT *psParam)
```

#### 2.25.5 Function use

The use of the `GFLIB_CtrlPIpAWInit` and `GFLIB_CtrlPIpAW` functions is shown in the following examples:

```c
#include "gflib.h"

static frac16_t f16Result, f16InitVal, f16InErr;
static bool_t bStopIntegFlag;
static GFLIB_CTRL_PI_P_AW_T_A32 sParam;

void Isr(void);

void main(void)
{
    f16InErr = FRAC16(-0.4);
    sParam.a32PGain = ACC32(0.1);
    sParam.a32IGain = ACC32(0.2);
    sParam.f16UpperLim = FRAC16(0.9);
    Isr();
    printf("f16Result = %f\n", f16Result);
```

---

*Note: The code examples are placeholders and may not be complete or correct.*
2.26 GFLIB_CtrlPIDpAW

The GFLIB_CtrlPIDpAW function calculates the parallel form of the Proportional-Integral-Derivative (PID) controller with implemented integral anti-windup functionality.

The PID controller attempts to correct the error between the measured process variable and the desired set-point by calculating a corrective action that can adjust the process accordingly. The GFLIB_CtrlPIDpAW function calculates the PID algorithm according to the equations below. The PID algorithm is implemented in the parallel (non-interacting) form, allowing the user to define the P, I, and D parameters independently and without interaction. The controller output is limited, and the limit values (upper limit and lower limit) are defined by the user.
The algorithm has two error inputs: one for the P and I calculation, and the other for the D calculation. This allows the user to apply different filters on both inputs.

The PID controller algorithm also returns a limitation flag, which indicates that the controller's output is at the limit. If the PID controller output reaches the upper or lower limit, then the limit flag is set to 1, otherwise it is 0 (integer values).

An anti-windup strategy is implemented by limiting the integral portion. The integral state is limited by the controller limits in the same way as the controller output. The integration can be stopped by a flag, which is pointed to by the function's API.

The PID algorithm in the continuous time domain can be expressed as follows:

\[
u(t) = e(t) \cdot K_P + K_I \int e(t) dt + K_D \frac{d}{dt} e_D(t)\]

Figure 108.

where
- \( u(t) \) is the controller output in the continuous time domain
- \( e(t) \) is the input error for the proportional and integral calculation in the continuous time domain
- \( e_D(t) \) is the input error for the derivative calculation in the continuous time domain
- \( K_P \) is the proportional gain
- \( K_I \) is the integral gain
- \( K_D \) is the derivative gain

**Equation 1** can be expressed using the Laplace transformation as follows:

\[
H(s) = \frac{U(s)}{E(s)} = K_P + \frac{K_I}{s} + K_D \cdot s
\]

Figure 109.

The proportional part \( u_P \) of **Equation 1** is transformed into the discrete time domain as follows:

\[
u_P(k) = K_P \cdot e(k)
\]

Figure 110.

where:
- \( u_P(k) \) is the proportional action in the actual step
- \( e(k) \) is the error in the actual step
- \( K_P \) is the proportional gain coefficient

**Equation 3** can be used in the fractional arithmetic as follows:

\[
u_{P_{sc}}(k) \cdot u_{max} = K_P \cdot e_{sc}(k) \cdot e_{max}
\]

Figure 111.

where:
- \( u_{max} \) is the action output scale
- \( u_{P_{sc}}(k) \) is the scaled proportional action in the actual step
- \( e_{max} \) is the error input scale
- \( e_{sc}(k) \) is the scale error in the actual step
Transforming the integral part \((u_I)\) of Equation 1 into a discrete time domain using the bi-linear method, also known as the trapezoidal approximation, is as follows:

\[
u_I(k) = u_I(k - 1) + e(k) \frac{K_I T_s}{2} + e(k - 1) \frac{K_I T_s}{2}
\]

Figure 112.

where:

- \(u_I(k)\) is the integral action in the actual step
- \(u_I(k - 1)\) is the integral action from the previous step
- \(e(k)\) is the error in the actual step
- \(e(k - 1)\) is the error in the previous step
- \(T_s\) is the sampling period of the system
- \(K_I\) is the integral gain coefficient

Equation 5 can be used in the fractional arithmetic as follows:

\[
u_{Isc}(k) \cdot u_{\text{max}} = u_{Isc}(k - 1) \cdot u_{\text{max}} + K_I T_s \frac{e_{sc}(k) + e_{sc}(k - 1)}{2} \cdot e_{\text{max}}
\]

Figure 113.

where:

- \(u_{\text{max}}\) is the action output scale
- \(u_{Isc}(k)\) is the scaled integral action in the actual step
- \(u_{Isc}(k - 1)\) is the scaled integral action from the previous step
- \(e_{\text{max}}\) is the error input scale
- \(e_{sc}(k)\) is the scaled error in the actual step
- \(e_{sc}(k - 1)\) is the scaled error in the previous step

The derivative part \((u_D)\) of Equation 1 is transformed into the discrete time domain as follows:

\[
u_D(k) = \frac{K_D}{T_s} [e_D(k) \cdot e_D(k - 1)]
\]

Figure 114.

where:

- \(u_D(k)\) is the proportional action in the actual step
- \(e_D(k)\) is the error used for the derivative input in the actual step
- \(e_D(k - 1)\) is the error used for the derivative input in the previous step
- \(K_D\) is the proportional gain coefficient

Equation 3 can be used in the fractional arithmetic as follows:

\[
u_{Dsc}(k) \cdot u_{\text{max}} = \frac{K_D}{T_s} [e_{Dsc}(k) \cdot e_{Dsc}(k - 1)] \cdot e_{\text{max}}
\]

Figure 115.

where:
• $u_{\text{max}}$ is the action output scale
• $u_{\text{Dsc}}(k)$ is the scaled derivative action in the actual step
• $e_{\text{max}}$ is the error input scale
• $e_{\text{Dsc}}(k)$ is the scaled error for the derivative input in the actual step
• $e_{\text{Dsc}}(k - 1)$ is the scaled error for the derivative input in the previous step

The output signal limitation is implemented in this controller. The actual output $u(k)$ is bounded to not exceed the given limit values - UpperLimit and LowerLimit. This is due to either the bounded power of the actuator, or due to the physical constraints of the plant.

The bounds are described by a limitation element, as shown in Equation 7. When the bounds are exceeded, the non-linear saturation characteristic will take effect, and influence the dynamic behavior. The described limitation is implemented in the integral part accumulator (limitation during the calculation) and in the overall controller output. Therefore, if the limitation occurs, the controller output is clipped to its bounds, and the wind-up occurrence of the accumulator portion is avoided by saturating the actual sum.

For a proper use of this function, it is recommended to initialize the function data by the GFLIB_CtrlPIDpAWInit functions, before using the GFLIB_CtrlPIDpAW function. You must call this function, when you want the PID controller to be initialized.

### 2.26.1 Available versions

This function is available in the following versions:

- Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The parameters use the accumulator types.
- Floating-point output - the output is the floating-point result within the type's full range.

The available versions of the GFLIB_CtrlPIDpAWInit function are shown in the following table:

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Parameters</th>
<th>Result type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GFLIB_CtrlPIDpAWInit_F16</td>
<td>frac16_t</td>
<td>GFLIB_CTRL_PID_P_AW_T_A32*</td>
<td>void</td>
<td>The inputs are a 16-bit fractional initial value and a pointer to the controller's parameters structure.</td>
</tr>
<tr>
<td>GFLIB_CtrlPIDpAWInitFLT</td>
<td>float_t</td>
<td>GFLIB_CTRL_PID_P_AW_TFLT*</td>
<td>void</td>
<td>The inputs are a 32-bit single precision floating-point initial value and a pointer to the controller's parameters structure.</td>
</tr>
</tbody>
</table>
Table 42. Function versions

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Parameters</th>
<th>Result type</th>
</tr>
</thead>
<tbody>
<tr>
<td>GFLIB_CtrlPIDpAW_F16</td>
<td>frac16_t frac16_t bool_t *</td>
<td>GFLIB_CTRL_PID_P_AW_T_A32*</td>
<td>frac16_t</td>
</tr>
<tr>
<td>GFLIB_CtrlPIDpAW_FLT</td>
<td>float_t float_t bool_t *</td>
<td>GFLIB_CTRL_PID_P_AW_T_FLT*</td>
<td>float_t</td>
</tr>
</tbody>
</table>

The error inputs are 16-bit fractional values within the range <-1 ; 1). The integration of the PID controller is suspended if the stop flag is set. When it is cleared, the integration continues. The parameters are pointed to by an input pointer. The function returns a 16-bit fractional value in the range <f16LowerLim ; f16UpperLim>.

The error inputs are 32-bit single precision floating-point values within the full type's range. The integration of the PID controller is suspended if the stop flag is set. When it is cleared, the integration continues. The parameters are pointed to by an input pointer. The function returns a 32-bit single precision floating-point value in the range <fltLowerLim ; fltUpperLim>.

2.26.2 GFLIB_CTRL_PID_P_AW_T_A32

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Input type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>a32PGain</td>
<td>acc32_t</td>
<td>Proportional gain is set up according to Equation 4 as follows: ( K_P \frac{e_{max}}{u_{max}} ). The parameter is a 32-bit accumulator type within the range &lt;0 ; 65536.0). Set by the user.</td>
</tr>
<tr>
<td>a32IGain</td>
<td>acc32_t</td>
<td>Integral gain is set up according to Equation 6 as follows: ( K_I T_s \frac{e_{max}}{u_{max}} ). The parameter is a 32-bit accumulator type within the range &lt;0 ; 65536.0). Set by the user.</td>
</tr>
<tr>
<td>a32DGain</td>
<td>acc32_t</td>
<td>Derivative gain is set up according to Equation 6 as follows: ( K_D \frac{e_{max}}{u_{max}} ). The parameter is a 32-bit accumulator type within the range &lt;0 ; 65536.0). Set by the user.</td>
</tr>
<tr>
<td>f32IAccK_1</td>
<td>frac32_t</td>
<td>State variable of the internal accumulator (integrator). Controlled by the algorithm.</td>
</tr>
<tr>
<td>f16InErrK_1</td>
<td>frac16_t</td>
<td>Input error in the step k - 1. Controlled by the algorithm.</td>
</tr>
<tr>
<td>f16UpperLim</td>
<td>frac16_t</td>
<td>Upper limit of the controller's output and the internal accumulator (integrator). This parameter must be greater than f16LowerLim. Set by the user.</td>
</tr>
<tr>
<td>f16LowerLim</td>
<td>frac16_t</td>
<td>Lower limit of the controller's output and the internal accumulator (integrator). This parameter must be lower than f16UpperLim. Set by the user.</td>
</tr>
<tr>
<td>f16InErrDK_1</td>
<td>frac16_t</td>
<td>Input error for the derivative calculation in the step k - 1. Controlled by the algorithm.</td>
</tr>
<tr>
<td>bLimFlag</td>
<td>bool_t</td>
<td>Limitation flag, which identifies that the controller's output reached the limits. 1 - the limit is reached; 0 - the output is within the limits. Controlled by the application.</td>
</tr>
</tbody>
</table>
2.26.3 GFLIB_CTRL_PID_P_AW_T_FLT

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Input type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>fltPGain</td>
<td>float_t</td>
<td>Proportional gain is set up according to Equation 3 as $K_P$. The parameter is a 32-bit single precision floating-point type non-negative value. Set by the user.</td>
</tr>
<tr>
<td>fltIGain</td>
<td>float_t</td>
<td>Integral gain is set up according to Equation 5 as $K_I T_s$. The parameter is a 32-bit single precision floating-point type non-negative value. Set by the user.</td>
</tr>
<tr>
<td>fltDGain</td>
<td>float_t</td>
<td>Derivative gain is set up according to Equation 5 as $K_D / T_s$. The parameter is a 32-bit single precision floating-point type non-negative value. Set by the user.</td>
</tr>
<tr>
<td>fltAccK_1</td>
<td>float_t</td>
<td>State variable of the internal accumulator (integrator). Controlled by the algorithm.</td>
</tr>
<tr>
<td>fltInErrK_1</td>
<td>float_t</td>
<td>Input error in the step k - 1. Controlled by the algorithm.</td>
</tr>
<tr>
<td>fltUpperLim</td>
<td>float_t</td>
<td>Upper limit of the controller's output and the internal accumulator (integrator). This parameter must be greater than fltLowerLim. Set by the user.</td>
</tr>
<tr>
<td>fltLowerLim</td>
<td>float_t</td>
<td>Lower limit of the controller's output and the internal accumulator (integrator). This parameter must be lower than fltUpperLim. Set by the user.</td>
</tr>
<tr>
<td>fltInErrDK_1</td>
<td>float_t</td>
<td>Input error for the derivative calculation in the step k - 1. Controlled by the algorithm.</td>
</tr>
<tr>
<td>bLimFlag</td>
<td>bool_t</td>
<td>Limitation flag, which identifies that the controller's output reached the limits. 1 - the limit is reached; 0 - the output is within the limits. Controlled by the application.</td>
</tr>
</tbody>
</table>

2.26.4 Declaration

The available GFLIB_CtrlPIDpAWInit functions have the following declarations:

```c
void GFLIB_CtrlPIDpAWInit_F16(frac16_t f16InitVal, GFLIB_CTRL_PID_P_AW_T_A32 *psParam)
void GFLIB_CtrlPIDpAWInit_FLT(float_t fltInitVal, GFLIB_CTRL_PID_P_AW_T_FLT *psParam)
```

The available GFLIB_CtrlPIDpAW functions have the following declarations:

```c
frac16_t GFLIB_CtrlPIDpAW_F16(frac16_t f16InErr, frac16_t f16InErrD, const bool_t *pbStopIntegFlag, GFLIB_CTRL_PID_P_AW_T_A32 *psParam)
float_t GFLIB_CtrlPIDpAW_FLT(float_t fltInErr, float_t fltInErrD, const bool_t *pbStopIntegFlag, GFLIB_CTRL_PID_P_AW_T_FLT *psParam)
```

2.26.5 Function use

The use of the GFLIB_CtrlPIDpAWInit and GFLIB_CtrlPIDpAW functions is shown in the following examples:
Fixed-point version:

```c
#include "gflib.h"

static frac16_t f16Result, f16InitVal, f16InErr, f16InErrD;
static bool_t bStopIntegFlag;
static GFLIB_CTRL_PID_P_AW_T_A32 sParam;

void Isr(void);

void main(void)
{
    f16InErr = FRAC16(-0.4);
    f16InErr = f16InErrD;
    sParam.a32PGain = ACC32(0.1);
    sParam.a32IGain = ACC32(0.2);
    sParam.a32DGain = ACC32(0.001);
    sParam.f16UpperLim = FRAC16(0.9);
    sParam.f16LowerLim = FRAC16(-0.9);
    bStopIntegFlag = FALSE;
    f16InitVal = FRAC16(0.0);

    GFLIB_CtrlPIDpAWInit_F16(f16InitVal, &sParam);
}

/* periodically called function */
void Isr()
{
    f16Result = GFLIB_CtrlPIDpAW_F16(f16InErr, f16InErrD, &bStopIntegFlag, &sParam);
}
```

Floating-point version:

```c
#include "gflib.h"

static float_t fltResult, fltInitVal, fltInErr, fltInErrD;
static bool_t bStopIntegFlag;
static GFLIB_CTRL_PID_P_AW_T_FLT sParam;

void Isr(void);

void main(void)
{
    fltInErr = -0.4F;
    fltInErr = fltInErrD;
    sParam.fltPGain = 0.1F;
    sParam.fltIGain = 0.2F;
    sParam.fltDGain = 0.001F;
    sParam.fltUpperLim = 0.9F;
    sParam.fltLowerLim = -0.9F;
    bStopIntegFlag = FALSE;
    fltInitVal = 0.0F;

    GFLIB_CtrlPIDpAWInit_FLT(fltInitVal, &sParam);
```
/* periodically called function */
void Isr()
{
    fltResult = GFLIB_CtrlPIDpAWFLT(fltInErr, fltInErrD, &bStopIntegFlag, &sParam);
}
Appendix A
Library types

A.1 bool_t

The bool_t type is a logical 16-bit type. It is able to store the boolean variables with two states: TRUE (1) or FALSE (0). Its definition is as follows:

```c
typedef unsigned short bool_t;
```

The following figure shows the way in which the data is stored by this type:

Table 43. Data storage

<table>
<thead>
<tr>
<th>Value</th>
<th>Unused</th>
<th>Logical</th>
</tr>
</thead>
<tbody>
<tr>
<td>TRUE</td>
<td>0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 1</td>
<td></td>
</tr>
<tr>
<td>FALSE</td>
<td>0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0</td>
<td></td>
</tr>
</tbody>
</table>

To store a logical value as bool_t, use the FALSE or TRUE macros.

A.2 uint8_t

The uint8_t type is an unsigned 8-bit integer type. It is able to store the variables within the range <0 ; 255>. Its definition is as follows:

```c
typedef unsigned char uint8_t;
```

The following figure shows the way in which the data is stored by this type:

Table 44. Data storage

<table>
<thead>
<tr>
<th>Value</th>
<th>Integer</th>
</tr>
</thead>
<tbody>
<tr>
<td>255</td>
<td>1 1 1 1 1 1 1 1</td>
</tr>
<tr>
<td></td>
<td>F F</td>
</tr>
</tbody>
</table>

Table continues on the next page...
Table 44. Data storage (continued)

<table>
<thead>
<tr>
<th>Value</th>
<th>Integer</th>
</tr>
</thead>
<tbody>
<tr>
<td>65535</td>
<td>1 1 1 1 1 1 1 1 1 1 1 1 1 1 1</td>
</tr>
<tr>
<td>5</td>
<td>0 0 0 0 0 0 0 0 0 0 1 0 1</td>
</tr>
<tr>
<td>15518</td>
<td>0 0 1 1 1 1 0 0 1 0 0 1 1 1 0</td>
</tr>
<tr>
<td>40768</td>
<td>1 0 0 1 1 1 1 0 1 0 0 0 0 0 0</td>
</tr>
</tbody>
</table>

A.3 `uint16_t`

The `uint16_t` type is an unsigned 16-bit integer type. It is able to store the variables within the range `<0 ; 65535>`. Its definition is as follows:

```c
typedef unsigned short uint16_t;
```

The following figure shows the way in which the data is stored by this type:

Table 45. Data storage

<table>
<thead>
<tr>
<th>Value</th>
<th>Integer</th>
</tr>
</thead>
<tbody>
<tr>
<td>15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0</td>
<td></td>
</tr>
<tr>
<td>65535</td>
<td>F F F F F F F F F F F F F F F F</td>
</tr>
<tr>
<td>5</td>
<td>0 0 0 0 0 0 0 0 0 0 1 0 1</td>
</tr>
<tr>
<td>15518</td>
<td>0 0 1 1 1 1 0 0 1 0 0 1 1 1 0</td>
</tr>
<tr>
<td>40768</td>
<td>9 4 0 0 0 0 0 0 0 0 0 0 0 0 0</td>
</tr>
</tbody>
</table>
A.4 uint32_t

The uint32_t type is an unsigned 32-bit integer type. It is able to store the variables within the range <0 ; 4294967295>. Its definition is as follows:

typedef unsigned long uint32_t;

The following figure shows the way in which the data is stored by this type:

Table 46. Data storage

<table>
<thead>
<tr>
<th>Value</th>
<th>Integer</th>
</tr>
</thead>
<tbody>
<tr>
<td>4294967295</td>
<td>F F F F F F F</td>
</tr>
<tr>
<td>2147483648</td>
<td>8 0 0 0 0 0 0</td>
</tr>
<tr>
<td>55977296</td>
<td>0 3 5 6 2 5 5</td>
</tr>
<tr>
<td>3451051828</td>
<td>C D B 2 D F 3 4</td>
</tr>
</tbody>
</table>

A.5 int8_t

The int8_t type is a signed 8-bit integer type. It is able to store the variables within the range <-128 ; 127>. Its definition is as follows:

typedef char int8_t;

The following figure shows the way in which the data is stored by this type:

Table 47. Data storage

<table>
<thead>
<tr>
<th>Value</th>
<th>Sign</th>
<th>Integer</th>
</tr>
</thead>
<tbody>
<tr>
<td>127</td>
<td>0 1 1 1 1 1 1 1 1 1</td>
<td></td>
</tr>
<tr>
<td>-128</td>
<td>1 0 0 0 0 0 0 0 0 0</td>
<td></td>
</tr>
<tr>
<td>60</td>
<td>0 0 1 1 1 1 0 0 0</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>C</td>
</tr>
</tbody>
</table>

Table continues on the next page...
A.6 int16_t

The int16_t type is a signed 16-bit integer type. It is able to store the variables within the range <-32768 ; 32767>. Its definition is as follows:

```
typedef short int16_t;
```

The following figure shows the way in which the data is stored by this type:

```
<table>
<thead>
<tr>
<th>Value</th>
<th>Sign</th>
<th>Integer</th>
</tr>
</thead>
<tbody>
<tr>
<td>32767</td>
<td>0 1 1 1 1 1 1 1 1 1 1 1 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>7</td>
<td>F</td>
</tr>
<tr>
<td>-32768</td>
<td>1 0 0 0 0 0 0 0 0 0 0 0 0</td>
<td></td>
</tr>
<tr>
<td></td>
<td>8</td>
<td>0</td>
</tr>
<tr>
<td>15518</td>
<td>0 0 1 1 1 1 0 0 1 0 1 1 1 0</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>C</td>
</tr>
<tr>
<td>-24768</td>
<td>1 0 0 1 1 1 1 0 1 0 0 0 0 0 0</td>
<td></td>
</tr>
<tr>
<td></td>
<td>9</td>
<td>F</td>
</tr>
</tbody>
</table>
```

A.7 int32_t

The int32_t type is a signed 32-bit integer type. It is able to store the variables within the range <-2147483648 ; 2147483647>. Its definition is as follows:

```
typedef long int32_t;
```

The following figure shows the way in which the data is stored by this type:

```
<table>
<thead>
<tr>
<th>Value</th>
<th>Sign</th>
<th>Integer</th>
</tr>
</thead>
<tbody>
<tr>
<td>32767</td>
<td>0 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>7</td>
<td>F</td>
</tr>
<tr>
<td>-32768</td>
<td>1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0</td>
<td></td>
</tr>
<tr>
<td></td>
<td>8</td>
<td>0</td>
</tr>
<tr>
<td>15518</td>
<td>0 0 1 1 1 1 0 0 1 0 1 1 1 1 1 0</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>C</td>
</tr>
<tr>
<td>-24768</td>
<td>1 0 0 1 1 1 1 0 1 0 0 0 0 0 0 0</td>
<td></td>
</tr>
<tr>
<td></td>
<td>9</td>
<td>F</td>
</tr>
</tbody>
</table>
```

---

*Table continues on the next page...*
A.8 frac8_t

The **frac8_t** type is a signed 8-bit fractional type. It is able to store the variables within the range <-1 ; 1). Its definition is as follows:

```
typedef char frac8_t;
```

The following figure shows the way in which the data is stored by this type:

To store a real number as **frac8_t**, use the **FRAC8** macro.
A.9  frac16_t

The `frac16_t` type is a signed 16-bit fractional type. It is able to store the variables within the range <-1 ; 1). Its definition is as follows:

```c
typedef short frac16_t;
```

The following figure shows the way in which the data is stored by this type:

<table>
<thead>
<tr>
<th>Table 51. Data storage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
</tr>
<tr>
<td>0.99997</td>
</tr>
<tr>
<td>-1.0</td>
</tr>
<tr>
<td>0.47357</td>
</tr>
<tr>
<td>-0.75586</td>
</tr>
</tbody>
</table>

To store a real number as `frac16_t`, use the `FRAC16` macro.

A.10  frac32_t

The `frac32_t` type is a signed 32-bit fractional type. It is able to store the variables within the range <-1 ; 1). Its definition is as follows:

```c
typedef long frac32_t;
```

The following figure shows the way in which the data is stored by this type:

<table>
<thead>
<tr>
<th>Table 52. Data storage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
</tr>
<tr>
<td>0.9999999995</td>
</tr>
</tbody>
</table>
Table 52. Data storage (continued)

<table>
<thead>
<tr>
<th>Value</th>
<th>8</th>
<th>0</th>
<th>0</th>
<th>0</th>
<th>0</th>
<th>0</th>
<th>0</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>-1.0</td>
<td>0</td>
<td>3</td>
<td>5</td>
<td>6</td>
<td>2</td>
<td>5</td>
<td>5</td>
<td>0</td>
</tr>
<tr>
<td>0.02606645970</td>
<td>C</td>
<td>D</td>
<td>B</td>
<td>2</td>
<td>D</td>
<td>F</td>
<td>3</td>
<td>4</td>
</tr>
<tr>
<td>-0.3929787632</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

To store a real number as `frac32_t`, use the `FRAC32` macro.

A.11 `acc16_t`

The `acc16_t` type is a signed 16-bit fractional type. It is able to store the variables within the range <-256 ; 256). Its definition is as follows:

```plaintext
typedef short acc16_t;
```

The following figure shows the way in which the data is stored by this type:

Table 53. Data storage

<table>
<thead>
<tr>
<th>Value</th>
<th>15</th>
<th>14</th>
<th>13</th>
<th>12</th>
<th>11</th>
<th>10</th>
<th>9</th>
<th>8</th>
<th>7</th>
<th>6</th>
<th>5</th>
<th>4</th>
<th>3</th>
<th>2</th>
<th>1</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sign</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Integer</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Fractional</td>
<td>7</td>
<td>F</td>
<td>F</td>
<td>F</td>
<td>F</td>
<td>F</td>
<td>F</td>
<td>F</td>
<td>F</td>
<td>F</td>
<td>F</td>
<td>F</td>
<td>F</td>
<td>F</td>
<td>F</td>
<td>F</td>
</tr>
<tr>
<td>255.9921875</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>8</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>0</td>
<td>3</td>
<td>2</td>
<td>4</td>
<td>3</td>
<td>2</td>
<td>4</td>
<td>3</td>
<td>2</td>
<td>4</td>
<td>3</td>
<td>2</td>
<td>4</td>
<td>3</td>
<td>2</td>
<td>4</td>
</tr>
<tr>
<td>-256.0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>8</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>0</td>
<td>6</td>
<td>E</td>
<td>5</td>
<td>D</td>
<td>3</td>
<td>2</td>
<td>4</td>
<td>3</td>
<td>2</td>
<td>4</td>
<td>3</td>
<td>2</td>
<td>4</td>
<td>3</td>
<td>2</td>
</tr>
<tr>
<td>1.0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>-1.0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>13.7890625</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>2</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>-89.71875</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>
To store a real number as acc16_t, use the ACC16 macro.

A.12 acc32_t

The acc32_t type is a signed 32-bit accumulator type. It is able to store the variables within the range $<-65536 ; 65536)$. Its definition is as follows:

```c
typedef long acc32_t;
```

The following figure shows the way in which the data is stored by this type:

Table 54. Data storage

<table>
<thead>
<tr>
<th>Value</th>
<th>31</th>
<th>24</th>
<th>23</th>
<th>16</th>
<th>15</th>
<th>8</th>
<th>7</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>65535.999969</td>
<td>S</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-65536.0</td>
<td>8</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1.0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>8</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>-1.0</td>
<td>F</td>
<td>F</td>
<td>F</td>
<td>F</td>
<td>8</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>23.789734</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>B</td>
<td>E</td>
<td>5</td>
<td>1</td>
<td>6</td>
</tr>
<tr>
<td>-1171.306793</td>
<td>F</td>
<td>D</td>
<td>B</td>
<td>6</td>
<td>5</td>
<td>8</td>
<td>B</td>
<td>C</td>
</tr>
</tbody>
</table>

To store a real number as acc32_t, use the ACC32 macro.

A.13 float_t

The float_t type is a signed 32-bit single precision floating-point type, defined by IEEE 754. It is able to store the full precision (normalized) finite variables within the range $<-3.40282 \cdot 10^{38} ; 3.40282 \cdot 10^{38})$ with the minimum resolution of $2^{-23}$. The smallest normalized number is $\pm 1.17549 \cdot 10^{-38}$. Nevertheless, the denormalized numbers (with reduced precision) reach yet lower values, from $\pm 1.40130 \cdot 10^{-45}$ to $\pm 1.17549 \cdot 10^{-38}$. The standard also defines the additional values:

- Negative zero
- Infinity
- Negative infinity
- Not a number

The 32-bit type is composed of:

- Sign (bit 31)
- Exponent (bits 23 to 30)
- Mantissa (bits 0 to 22)

The conversion of the number is straightforward. The sign of the number is stored in bit 31. The binary exponent is decoded as an integer from bits 23 to 30 by subtracting 127. The mantissa (fraction) is stored in bits 0 to 22. An invisible leading bit (it is not
actually stored) with value 1.0 is placed in front; therefore, bit 23 has a value of 0.5, bit 22 has a value 0.25, and so on. As a result, the mantissa has a value between 1.0 and 2. If the exponent reaches -127 (binary 00000000), the leading 1.0 is no longer used to enable the gradual underflow.

The `float_t` type definition is as follows:

```c
typedef float float_t;
```

The following figure shows the way in which the data is stored by this type:

Table 55. Data storage - normalized values

<table>
<thead>
<tr>
<th>Value</th>
<th>31</th>
<th>24</th>
<th>23</th>
<th>16</th>
<th>15</th>
<th>8</th>
<th>7</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>(2.0 - 2^{-23}) · 2^{127}</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>≈ 3.40282 · 10^{38}</td>
<td>7</td>
<td>F</td>
<td>7</td>
<td>F</td>
<td>F</td>
<td>F</td>
<td>F</td>
<td>F</td>
</tr>
<tr>
<td>(2.0 - 2^{-23}) · 2^{-127}</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>≈ -3.40282 · 10^{38}</td>
<td>F</td>
<td>F</td>
<td>7</td>
<td>F</td>
<td>F</td>
<td>F</td>
<td>F</td>
<td>F</td>
</tr>
<tr>
<td>2^{-126}</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>≈ 1.17549 · 10^{-38}</td>
<td>8</td>
<td>0</td>
<td>8</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>-2^{-126}</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>≈ -1.17549 · 10^{-38}</td>
<td>8</td>
<td>0</td>
<td>8</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1.0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>F</td>
<td>8</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>-1.0</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>B</td>
<td>F</td>
<td>8</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>π</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>≈ 3.1415927</td>
<td>4</td>
<td>0</td>
<td>4</td>
<td>9</td>
<td>0</td>
<td>F</td>
<td>D</td>
<td>B</td>
</tr>
<tr>
<td>-20810.086</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>C</td>
<td>6</td>
<td>A</td>
<td>2</td>
<td>9</td>
<td>4</td>
<td>2</td>
<td>C</td>
</tr>
</tbody>
</table>

Table continues on the next page...
### Table 55. Data storage - normalized values (continued)

<table>
<thead>
<tr>
<th>Value</th>
<th>S</th>
<th>Exponent</th>
<th>Mantissa</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.0</td>
<td>0</td>
<td>0 0 0 0 0 0 0 0</td>
<td>0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0</td>
</tr>
<tr>
<td>-0.0</td>
<td>1</td>
<td>0 0 0 0 0 0 0 0</td>
<td>0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0</td>
</tr>
<tr>
<td>(1.0 - 2^-23) · 2^126</td>
<td>0</td>
<td>0 0 0 0 0 0 0</td>
<td>0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0</td>
</tr>
<tr>
<td>≈ 1.17549 · 10^38</td>
<td>0</td>
<td>0</td>
<td>7 F F F F</td>
</tr>
<tr>
<td>-(1.0 - 2^-23) · 2^126</td>
<td>1</td>
<td>0 0 0 0 0 0 0</td>
<td>0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0</td>
</tr>
<tr>
<td>≈ -1.17549 · 10^38</td>
<td>8</td>
<td>0</td>
<td>7 F F F F</td>
</tr>
<tr>
<td>2^-1 · 2^126</td>
<td>0</td>
<td>0 0 0 0 0 0 0</td>
<td>0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0</td>
</tr>
<tr>
<td>≈ 5.87747 · 10^39</td>
<td>0</td>
<td>0</td>
<td>4 0 0 0 0 0 0</td>
</tr>
<tr>
<td>-2^-1 · 2^126</td>
<td>1</td>
<td>0 0 0 0 0 0 0</td>
<td>0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0</td>
</tr>
<tr>
<td>≈ -5.87747 · 10^39</td>
<td>8</td>
<td>0</td>
<td>4 0 0 0 0 0 0</td>
</tr>
<tr>
<td>2^-23 · 2^126</td>
<td>0</td>
<td>0 0 0 0 0 0 0</td>
<td>0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0</td>
</tr>
<tr>
<td>≈ 1.40130 · 10^45</td>
<td>0</td>
<td>0</td>
<td>0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0</td>
</tr>
<tr>
<td>-2^-23 · 2^126</td>
<td>1</td>
<td>0 0 0 0 0 0 0</td>
<td>0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0</td>
</tr>
<tr>
<td>≈ -1.40130 · 10^45</td>
<td>8</td>
<td>0</td>
<td>0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0</td>
</tr>
</tbody>
</table>

### Table 56. Data storage - denormalized values

<table>
<thead>
<tr>
<th>Value</th>
<th>S</th>
<th>Exponent</th>
<th>Mantissa</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.0</td>
<td>0</td>
<td>0 0 0 0 0 0 0</td>
<td>0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0</td>
</tr>
<tr>
<td>-0.0</td>
<td>1</td>
<td>0 0 0 0 0 0 0</td>
<td>0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0</td>
</tr>
<tr>
<td>(1.0 - 2^-23) · 2^126</td>
<td>0</td>
<td>0 0 0 0 0 0 0</td>
<td>0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0</td>
</tr>
<tr>
<td>≈ 1.17549 · 10^38</td>
<td>0</td>
<td>0</td>
<td>7 F F F F</td>
</tr>
<tr>
<td>-(1.0 - 2^-23) · 2^126</td>
<td>1</td>
<td>0 0 0 0 0 0 0</td>
<td>0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0</td>
</tr>
<tr>
<td>≈ -1.17549 · 10^38</td>
<td>8</td>
<td>0</td>
<td>7 F F F F</td>
</tr>
<tr>
<td>2^-1 · 2^126</td>
<td>0</td>
<td>0 0 0 0 0 0 0</td>
<td>0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0</td>
</tr>
<tr>
<td>≈ 5.87747 · 10^39</td>
<td>0</td>
<td>0</td>
<td>4 0 0 0 0 0 0</td>
</tr>
<tr>
<td>-2^-1 · 2^126</td>
<td>1</td>
<td>0 0 0 0 0 0 0</td>
<td>0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0</td>
</tr>
<tr>
<td>≈ -5.87747 · 10^39</td>
<td>8</td>
<td>0</td>
<td>4 0 0 0 0 0 0</td>
</tr>
<tr>
<td>2^-23 · 2^126</td>
<td>0</td>
<td>0 0 0 0 0 0 0</td>
<td>0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0</td>
</tr>
<tr>
<td>≈ 1.40130 · 10^45</td>
<td>0</td>
<td>0</td>
<td>0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 1</td>
</tr>
<tr>
<td>-2^-23 · 2^126</td>
<td>1</td>
<td>0 0 0 0 0 0 0</td>
<td>0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 1</td>
</tr>
<tr>
<td>≈ -1.40130 · 10^45</td>
<td>8</td>
<td>0</td>
<td>0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 1</td>
</tr>
</tbody>
</table>
Table 57. Data storage - special values

<table>
<thead>
<tr>
<th>Value</th>
<th>Exponent</th>
<th>Mantissa</th>
</tr>
</thead>
<tbody>
<tr>
<td>∞</td>
<td>0 1 1 1 1 1 1</td>
<td>0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0</td>
</tr>
<tr>
<td></td>
<td>7 F</td>
<td>8 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0</td>
</tr>
<tr>
<td>−∞</td>
<td>1 1 1 1 1 1 1</td>
<td>0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0</td>
</tr>
<tr>
<td></td>
<td>F F</td>
<td>8 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0</td>
</tr>
<tr>
<td>Not a number</td>
<td>* 1 1 1 1 1 1 1</td>
<td>non zero</td>
</tr>
<tr>
<td></td>
<td>7/F</td>
<td>800001 to FFFFFFF</td>
</tr>
</tbody>
</table>

A.14 FALSE

The FALSE macro serves to write a correct value standing for the logical FALSE value of the bool_t type. Its definition is as follows:

```c
#define FALSE    ((bool_t)0)
```

```c
#include "mlib.h"
static bool_t bVal;
void main(void)
{
    bVal = FALSE;               /* bVal = FALSE */
}
```

A.15 TRUE

The TRUE macro serves to write a correct value standing for the logical TRUE value of the bool_t type. Its definition is as follows:

```c
#define TRUE     ((bool_t)1)
```

```c
#include "mlib.h"
static bool_t bVal;
void main(void)
{
    /* bVal = TRUE */
}```
A.16  FRAC8

The FRAC8 macro serves to convert a real number to the frac8_t type. Its definition is as follows:

```c
#define FRAC8(x) ((frac8_t)((x) < 0.9921875 ? ((x) >= -1 ? (x)*0x80 : 0x80) : 0x7F))
```

The input is multiplied by 128 ($2^7$). The output is limited to the range $<0x80; 0x7F>$, which corresponds to $<-1.0; 1.0-2^7>$. 

```c
#include "mlib.h"
static frac8_t f8Val;
void main(void) {
    f8Val = FRAC8(0.187);               /* f8Val = 0.187 */
}
```

A.17  FRAC16

The FRAC16 macro serves to convert a real number to the frac16_t type. Its definition is as follows:

```c
#define FRAC16(x) ((frac16_t)((x) < 0.999969482421875 ? ((x) >= -1 ? (x)*0x8000 : 0x8000) : 0x7FFF))
```

The input is multiplied by 32768 ($2^{15}$). The output is limited to the range $<0x8000; 0x7FFF>$, which corresponds to $<-1.0; 1.0-2^{15}>$. 

```c
#include "mlib.h"
static frac16_t f16Val;
void main(void) {
    f16Val = FRAC16(0.736);               /* f16Val = 0.736 */
}
```

A.18  FRAC32

The FRAC32 macro serves to convert a real number to the frac32_t type. Its definition is as follows:

```c
#define FRAC32(x) ((frac32_t)((x) < 1 ? ((x) >= -1 ? (x)*0x80000000 : 0x80000000) : 0x7FFFFFFF))
```

The input is multiplied by 2147483648 ($2^{31}$). The output is limited to the range $<0x80000000; 0x7FFFFFFF>$, which corresponds to $<-1.0; 1.0-2^{31}>$. 

```c
#include "mlib.h"
```
static frac32_t f32Val;

void main(void)
{
    f32Val = FRAC32(-0.1735667); /* f32Val = -0.1735667 */
}

A.19 ACC16

The ACC16 macro serves to convert a real number to the acc16_t type. Its definition is as follows:

```
#define ACC16(x) ((acc16_t)((x) < 255.9921875 ? ((x) >= -256 ? (x)*0x80 : 0x8000) : 0x7FFF))
```

The input is multiplied by 128 (2^7). The output is limited to the range <0x8000 ; 0x7FFF> that corresponds to <-256.0 ; 255.9921875>.

```
#include "mlib.h"
static acc16_t a16Val;
void main(void)
{
    a16Val = ACC16(19.45627); /* a16Val = 19.45627 */
}
```

A.20 ACC32

The ACC32 macro serves to convert a real number to the acc32_t type. Its definition is as follows:

```
#define ACC32(x) ((acc32_t)((x) < 65535.999969482421875 ? ((x) >= -65536 ? (x)*0x8000 : 0x80000000) : 0x7FFFFFFF))
```

The input is multiplied by 32768 (2^{15}). The output is limited to the range <0x80000000 ; 0x7FFFFFFF>, which corresponds to <-65536.0 ; 65536.0-2^{-15}>.

```
#include "mlib.h"
static acc32_t a32Val;
void main(void)
{
    a32Val = ACC32(-13.654437); /* a32Val = -13.654437 */
}```
Limited warranty and liability — Information in this document is provided solely to enable system and software implementers to use NXP products. There are no express or implied copyright licenses granted hereunder to design or fabricate any integrated circuits based on the information in this document. NXP reserves the right to make changes without further notice to any products herein.

NXP makes no warranty, representation, or guarantee regarding the suitability of its products for any particular purpose, nor does NXP assume any liability arising out of the application or use of any product or circuit, and specifically disclaims any and all liability, including without limitation consequential or incidental damages. “Typical” parameters that may be provided in NXP data sheets and/or specifications can and do vary in different applications, and actual performance may vary over time. All operating parameters, including “typicals,” must be validated for each customer application by customer’s technical experts. NXP does not convey any license under its patent rights nor the rights of others. NXP sells products pursuant to standard terms and conditions of sale, which can be found at the following address: nxp.com/SalesTermsandConditions.

Right to make changes - NXP Semiconductors reserves the right to make changes to information published in this document, including without limitation specifications and product descriptions, at any time and without notice. This document supersedes and replaces all information supplied prior to the publication hereof.

Security — Customer understands that all NXP products may be subject to unidentified or documented vulnerabilities. Customer is responsible for the design and operation of its applications and products throughout their lifecycles to reduce the effect of these vulnerabilities on customer’s applications and products. Customer’s responsibility also extends to other open and/or proprietary technologies supported by NXP products for use in customer’s applications. NXP accepts no liability for any vulnerability. Customer should regularly check security updates from NXP and follow up appropriately. Customer shall select products with security features that best meet rules, regulations, and standards of the intended application and make the ultimate design decisions regarding its products, regardless of any information or support that may be provided by NXP. NXP has a Product Security Incident Response Team (PSIRT) (reachable at PSIRT@nxp.com) that manages the investigation, reporting, and solution release to security vulnerabilities of NXP products.

NXP, the NXP logo, NXP SECURE CONNECTIONS FOR A SMARTER WORLD, COOLFLUX, EMBRACE, GREENCHIP, HITAG, ICODE, JCOP, LIFE, VIBES, MIFARE, MIFARE CLASSIC, MIFARE DESFire, MIFARE PLUS, MIFARE FLEX, MANTIS, MIFARE ULTRALIGHT, MIFARE4MOBILE, MIGLO, NTAG, ROADLINK, SMARTLX, SMARTMX, STARPLUG, TOPFET, TRENCHMOS, UCODE, Freescale, the Freescale logo, AltVec, CodeWarrior, ColdFire, ColdFire+, the Energy Efficient Solutions logo, Kinetis, Layerscape, Magniv, mobileGT, PEG, PowerQUICC, Processor Expert, QorIQ, QorIQ Qonverge, SafeAssure, the SafeAssure logo, StarCore, Symphony, VortiQa, Vybrid, Airfast, BeeKit, BeeStack, CoreNet, Flexis, MXC, Platform in a Package, QUICC Engine, Tower, TurboLink, EdgeScale, EdgeLock, eIQ, and Immersive3D are trademarks of NXP B.V. All other product or service names are the property of their respective owners. AMBA, Arm, Arm7, Arm7TDMI, Arm9, Arm11, Artisan, big.LITTLE, Cordio, CoreLink, CoreSight, Cortex, DesignStart, DynamIQ, Jazelle, Keil, Mali, Mbed, Mbed Enabled, NEON, POP, RealView, SecurCore, Socrates, Thumb, TrustZone, ULINK, ULINK2, ULINK-ME, ULINK-PLUS, ULINKpro, µVision, Versatile are trademarks or registered trademarks of Arm Limited (or its subsidiaries) in the US and/or elsewhere. The related technology may be protected by any or all of patents, copyrights, designs and trade secrets. All rights reserved. Oracle and Java are registered trademarks of Oracle and/or its affiliates. The Power Architecture and Power.org word marks and the Power and Power.org logos and related marks are trademarks and service marks licensed by Power.org. M, M Mobileye and other Mobileye trademarks or logos appearing herein are trademarks of Mobileye Vision Technologies Ltd. in the United States, the EU and/or other jurisdictions.